
This chapter explains how to unpack and set up the LaserWriter 12/640 PS.

Main features of the LaserWriter 12/640 PS

m Print quality The printer has a resolution of 600 dots per inch. Its FinePrint
feature smoothes text, and its PhotoGrade feature (available with
additional printer memory) improves graphic images.

m Speed The printer prints up to 12 pages per minute.

m Multiplatform support You can connect the printer to Mac OS-based
computers, Windows-based computers, and UNIX-based computers.

m Connectivity The printer offers LocalTalk, Ethernet, and parallel
connections.

m Automatic traffic control The printer can be connected to many computers
and networks using the printer’s LocalTalk, Ethernet, and parallel ports.
The printer prints only one user’s job at a time, but it manages incoming
print jobs from all ports so that no printing conflicts or problems occur.
The printer also automatically senses which printer language—PostScript™

or PCL5—the job requires.

m Fonts The printer supports both TrueType and PostScript fonts. The printer
has 35 built-in PostScript fonts.

m Energy savings The printer can automatically lower its power consumption
when it’s not being used.
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m Flexible paper handling In the standard configuration, you can print up to 330
sheets (250 in the standard paper cassette plus 80 in the multipurpose tray)
without changing paper. You can easily add a 500-sheet cassette and feeder
or a 50-envelope cassette. The printer also supports duplex printing
(printing on both sides of the paper) when the optional duplex printing
unit is attached.

Choosing a place for the printer

Choose a flat, stable area with adequate room around the printer. The area
should be well ventilated and away from direct sunlight or sources of heat,
cold, or humidity. Keep the printer’s vents free from obstruction to allow for
proper operation and cooling of the printer. Don’t use ammonia-based
cleaners, which can react chemically with the toner, on or around the printer.

See Appendix D, “Technical Information,” for more information about the
physical requirements of the printer.

IMPORTANT Keep the printer’s
vents unobstructed for proper operation
and cooling.

Allow enough space
to open the door.

Make sure you have
enough space to open
the paper cassette.

Allow space to open the top cover.
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Important safety instructions

Before you plug in your LaserWriter 12/640 PS, read these important safety
instructions.

For your own safety and that of your equipment, always take the following
precautions.

Disconnect the power plug (by pulling the plug, not the cord) if any of the
following conditions exists:

m the power cord or plug becomes frayed or otherwise damaged

m you spill something into the case

m your printer is exposed to rain or any other excess moisture

m your printer has been dropped or the case has been otherwise damaged

m you suspect that your printer needs service or repair

m you want to clean the case (use only the recommended procedure
described in Chapter 1)

WARNING This equipment is intended to be electrically grounded. Your
printer is equipped with a three-wire grounding plug—a plug that has a
third (grounding) pin. This plug will fit only a grounded AC outlet. This
is a safety feature. If you are unable to insert the plug into the outlet,
contact a licensed electrician to replace the outlet with a properly
grounded outlet. Do not defeat the purpose of the grounding plug!
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Be sure that you always do the following:

m Keep the printer’s vents free from obstruction.

m Keep your printer away from sources of liquids, such as wash basins,
bathtubs, shower stalls, and so on.

m Protect your printer from dampness or wet weather, such as rain, snow, and
so on.

m Read all the installation instructions carefully before you plug your printer
into a wall socket.

m Keep these instructions handy for reference by you and others.

m Follow all instructions and warnings dealing with your system.

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.
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Unpacking the printer

IMPORTANT The printer weighs approximately 30 pounds (approximately
14 kilograms).

1 Remove the Styrofoam packing material located on either side of the printer.

` 2 Lift the printer out of the box and remove the printer from the plastic bag.

3 Make sure you have everything shown here:

Power cordToner cartridge

LaserWriter 12/640 PS printer

CD-ROM disc 
(Some printers come
with floppy disks instead.)



4 You also need to obtain whatever cables your networks require.

5 Pull the packing tape from the printer’s top cover.

6 Pull open the printer’s top cover.

Lift this latch to open the top cover.

LocalTalk connecting kitParallel interface cable

Ethernet transceivers
and cables
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7 Remove the plastic foam block from inside the printer. 

Save all the packing materials. They provide the best protection for the printer
if you ever need to move it.

Remove the packing material.



8 Chapter  1

Installing the first toner cartridge

The toner cartridge contains the dry plastic powder that the printer uses
instead of ink. The first time you install a toner cartridge, follow the steps
given here. After that, each time you install a cartridge, follow the instructions
in Chapter 10.

Each cartridge lasts approximately 6,000 pages, depending on the kind of
printing you do. If you use the printer to produce more graphic images than
text, you may need to change cartridges more often.

1 Slide the yellow plastic square back and forth to remove any dust.

2 Take the cartridge out of its packaging.

Slide the square back and forth.

WARNING Use only cartridges designed for use with your LaserWriter
12/640 PS printer. Other cartridges may not fit and may damage
the printer.



3 Distribute the toner powder by gently rocking the cartridge back and forth.

4 Firmly pull the tab directly away from the cartridge to remove the sealing tape.

WARNING Pull the tab straight out of the cartridge. Don’t pull too quickly
or at an angle—either might damage the seals on the cartridge.
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5 Align the arrow on the left side of the toner cartridge with the arrow on the left side of the
printer, then slide the cartridge downward into the printer. Make sure the toner cartridge
is inserted all the way and properly seated inside the printer.

Make sure the toner cartridge is
inserted all the way and properly
seated inside the printer.
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6 Close the printer. 

The top cover clicks into place.

Wait to install the LaserWriter 12/640 PS options

If you purchased any of the following options, wait to install them until
you’ve connected the printer to your network:

m duplex printing unit

m paper and envelope cassettes

m face-up output tray

m memory

By waiting, you can ensure the printer is working correctly (thus simplifying
troubleshooting).
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Loading paper into the cassette

You can load paper into the paper cassette or the multipurpose tray, or both.
For instructions on using the multipurpose tray, see Chapter 9, “Loading
Paper.”

The multipurpose tray can hold up to 80 sheets of paper—U.S. letter-size,
U.S. legal-size, A4, A5, B5, executive, Comm10 envelopes, Monarch
envelopes, DL envelopes, C5 envelopes, EuroPostcards, transparencies,
and sheets of labels. The exact number of sheets the multipurpose tray
can hold depends on the weight of the paper. You can also use the tray for
manual feed jobs.

The paper cassette can hold up to 250 sheets of paper—U.S. letter-size, U.S.
legal-size, executive, A4, or B5.

You can expect excellent printing results from photocopier paper. Use paper
labeled “laser-quality” for best results.

1 Slide the paper cassette out of the printer.
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2 Prepare a stack of paper.

You can load up to 250 sheets of 20-pound photocopier paper. Make sure the
edges are even on all sides before inserting the stack of paper.

3 Set the length guide to match your paper’s length. Move the width guide by pinching and
sliding it into place.

4 Push down gently on the paper tray until it locks into place.

5 Slide the stack of paper into the cassette.

6 Slide the paper under the bracket at the front of the cassette.

Push the paper down if necessary, but don’t overload the cassette, or the paper
may jam when you print.

Slide paper under
the retainers.

Make sure the paper fits
under this corner bracket.
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Load three-hole punched paper face down, with the holes toward the left side
of the cassette. Load letterhead paper face down, with the tops of the pages at
the front of the cassette (the handle end).

7 Adjust the length and width guides so that they fit snugly against the paper.

Adjust the length and width guides
to fit the size paper you’re using.

Align letterhead and three-hole
punched paper as shown.
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8 Slide the cassette into the printer.

Push the cassette in all the way.
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Connecting the printer

You can connect the printer to many computers and networks using the
printer’s LocalTalk, Ethernet, and parallel ports. The printer prints only one
user’s job at a time, but it manages incoming print jobs from all ports so that
no printing conflicts or problems occur. Unless you specify otherwise, it 
also automatically senses which printer language—PostScript or PCL5—the
job requires.

Note: If you are connecting the printer to a network with routers that
combine LocalTalk and EtherTalk into one logical zone, only one printer port
should be connected to the network. Apple recommends Ethernet.

Port Network protocols Computer

LocalTalk AppleTalk Mac OS 

Ethernet AppleTalk (EtherTalk) Mac OS 

Novell NetWare Windows

Novell ATPS Mac OS 

TCP/IP UNIX

Parallel — Windows and DOS

Communication switch

Parallel port

LocalTalk
port

Ethernet port
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Connecting to a LocalTalk network

If you have an existing LocalTalk network, here’s how to add the LaserWriter
12/640 PS to it.

1 Obtain a LocalTalk connecting kit.

LocalTalk connecting kits come in many varieties. Yours may look different.

2 Plug the connector box into the LocalTalk port (ˆ) on the printer.

3 Connect the printer to the network in one of these two ways:

m To connect the printer to the end of a LocalTalk network, use the LocalTalk
cable to connect the empty socket of the nearest device’s connector box to
the printer’s connector box.

Connector box

LocalTalk cable

17Set t ing Up the LaserWr i ter  12/640 PS



m To connect the printer between two devices on a LocalTalk network,
disconnect one LocalTalk cable from the connector box of the device
immediately to the left or right of the printer and plug it into the new
printer’s connector box. Then use the new LocalTalk cable to connect the
free socket on the printer’s connector box to the socket you freed on the
other device’s connector box.

What to do after connecting to a LocalTalk network

m If you wish to connect the printer to other networks, or to connect the
printer directly to an IBM PC or compatible computer, see the appropriate
sections later in this chapter.

m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.

See Chapter 2 for more information about setting up the printer on a
LocalTalk network, or Appendix B for information about setting up the
printer on a NetWare network running ATPS.
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Connecting directly to a single Mac OS–based computer

Use this method to connect a single Mac OS–based computer to the printer.
However, since that single computer takes up the printer’s LocalTalk port,
you cannot also connect the printer to a LocalTalk network.

1 Obtain two LocalTalk Kits.

2 Plug one LocalTalk connector into the computer’s printer ([) port.

3 Plug one end of the cable into the LocalTalk connector on the computer.

4 Plug the second LocalTalk connector into the printer’s LocalTalk (ˆ) port.

LocalTalk
port

Printer
port

ˆ
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What to do after connecting to a single Mac OS computer

m If you wish to connect the printer to other networks, or to connect the
printer directly to a Windows or DOS computer, see the appropriate
sections later in this chapter.

m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.

See Chapter 2 for more information about setting up the printer on a
LocalTalk network, or Appendix B for information about setting up the
printer on a NetWare network running ATPS.

Connecting to an Ethernet network

A single Ethernet cable can carry a number of network protocols, including
AppleTalk (called EtherTalk when it’s on an Ethernet network), Novell
NetWare, and TCP/IP (Transmission Control Protocol/Internet Protocol). To
connect the printer to an Ethernet network running any combination of these
protocols, follow these steps:

1 Obtain an Ethernet transceiver and a length of Ethernet cable appropriate for your
network’s media type—thin, thick, or twisted pair.

2 Plug the short cable from the transceiver into the Ethernet port (G) on the printer.

Apple Ethernet 
thin coaxial transceiver

Apple Ethernet
AUI adapter

Apple Ethernet
twisted-pair transceiver

20 Chapter  1



3 Connect the printer to the Ethernet network in one of these three ways:

m To connect the printer to the end of an Ethernet network, use the Ethernet
cable to connect the empty socket of the nearest device’s transceiver to the
printer’s transceiver, as shown here.

m To connect the printer between two devices on an Ethernet network,
disconnect one Ethernet cable from the transceiver of the device
immediately to the left or right of the printer and plug it into the new
printer’s transceiver. Then use the new Ethernet cable to connect the free
socket on the printer’s transceiver to the socket you freed on the other
device’s transceiver.

m To connect the printer to an Ethernet hub, see the documentation that came
with the Ethernet hub.
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What to do after connecting to an Ethernet network
m If you wish to connect the printer directly to a Windows or DOS computer,

see the next section.

m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.

See Chapters 2, 3, and 4 for more information about setting up the printer for
different network interfaces.

Connecting to a Windows or DOS computer with a parallel cable

1 Obtain a parallel interface cable like this one.

25-pin
connector

36-pin
Centronics
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2 Use the parallel cable to connect the computer to the printer:

What to do after connecting directly to a Windows or DOS computer

m Read the rest of this chapter.

See Chapter 3 for more information about setting up the printer.

Attach the cable’s smaller connector
to the parallel port on the printer.

Attach the cable to the parallel port on
your computer. (Your computer’s parallel
port may be in a different location.)

Secure the clips.

Parallel interface cable
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Connecting the power and turning on the printer

Once you’ve connected the printer to your networks, you’re ready to start up
the printer. Follow these steps to make sure everything is working correctly.

1 Make sure the printer is turned off.

2 Plug in the printer.

Insert the socket end of the power cord into the recessed receptacle on the
back of the printer. Plug the other end into a grounded (three-hole) AC outlet.

Off position

On position
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3 Press the “|” on the power switch to turn the printer on.

4 Save the startup page. It contains information you may need to complete your 
network setup.

The printer takes a minute or two to warm up, and then it automatically prints
a startup page. It prints the startup page every time you restart unless you
turn the startup page off using either the Apple Printer Utility for the Mac OS
or the Apple LaserWriter Utility for Windows. See Appendix A for details on
these utilities.

The startup page shows how the printer is set up, including the network
connection types and what options are attached to the printer.

The startup page should look clean and sharp. If it is spotty, too light or too
dark, or otherwise unclear, switch the printer off and on to print a second
page. Try this two or three times if necessary. If the output doesn’t improve, or
if the printer won’t print the startup page, refer to Part III, “Troubleshooting.”

On position
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5 Check the status lights.

After the startup page is printed, the Ready/In Use light glows steadily. All
other lights should be off. If any other lights are on, see Chapter 11.

Saving energy

When you save energy, you save our natural resources and reduce pollution.
If you’re concerned about energy consumption, you can take advantage of the
printer’s built-in energy-saving feature. The printer enters an energy-saving
mode 10 seconds after finishing printing.

You can also save energy on the LaserWriter 12/640 PS, as well as on all 
other printers (including those without energy-saving features), by taking
these steps:

m If you know you won’t be using the printer for a while—say, overnight—
turn it off.

m Use the page preview feature provided in many programs to check page
layout rather than printing a draft.

Ready/In Use light
Paper Out light

Paper Jam light

U
»

‘
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Adjusting communication settings

Though you can adjust many of the LaserWriter 12/640 PS printer’s
communication settings, the normal settings work for most environments.
To make sure the printer is set up to use the normal settings, check the
communication switch on the left side of the printer to make sure it’s in
the Normal (in) position. The settings are listed in Appendix D.

Why customize communication settings?

Though the standard communication settings work well for most
environments, you might want to customize communication settings to turn
off network interfaces you don’t need. For example, if you know the printer
will never receive a NetWare message over the network, you can turn off the
interface and stop the printer from sending out unnecessary NetWare packets.

Communication
switch
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How to customize communication settings

To customize communication settings, use either of the following two
programs:

m Apple Printer Utility for the Mac OS

m Apple LaserWriter Utility for Windows

See Appendix A for details on using these utilities.

What to do next

Finish preparing the printer and completing the network connections by
reading one or more of the following chapters:

m Chapter 2 explains how to set up the printer on an AppleTalk network.

m Chapter 3 explains how to set up the printer on a Novell NetWare network. It
also explains how to set up a direct connection to an IBM PC or compatible
computer.

m Chapter 4 explains how to set up the printer on a TCP/IP network.
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2 Setting Up the Printer for Mac OS Users

This chapter explains how to prepare the printer for use on an AppleTalk
network, and prepare Macintosh Operating System (Mac OS)–based
computers to print on the printer.

Note: For instructions on setting up the printer for access by Mac OS client
computers on a NetWare network, see Appendix B.



Before you begin

This chapter presents instructions for installing the Mac OS printer software
and configuring the printer with it. Before you begin, make sure you have

m set up the printer as described in Chapter 1

m connected the printer to your network

m made backup copies of the printer disks (if your printer software was
shipped on a CD-ROM disc, you can skip this step)

Be sure to complete these tasks before continuing with the procedures in
this chapter.

System requirements

To use the printer software, your Mac OS–based computer must have system
software version 7.1 or later and at least 4 megabytes (MB) of memory (8 MB
recommended). If your system software is an earlier version, you need to
obtain a system software upgrade from your computer or software dealer.

Installing all the printer software and fonts requires approximately 9 MB of
free space on your hard disk.

Initial AppleTalk setup

The printer comes with software and fonts for use with Mac OS–based
computers. Before Mac OS users can print, the printer administrator must
connect the printer to the network, install the printer software and fonts, and
configure the printer.
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Step 1: Installing the printer software

IMPORTANT Do not “drag install” the printer software. If you do, the files
won’t be properly decompressed and won’t work.

Installing from the CD-ROM disc

1 Quit any programs you are running.

2 Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)

3 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.

Note: Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.

4 Double-click the disc icon to open the disk, if necessary.

5 Double-click the MAC_OS folder, if necessary.

6 Double-click the SOFTWARE folder, if necessary.

7 Double-click the INSTALL folder, if necessary.

8 Read the Before You Install file to check for late-breaking news.

9 Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.

10 Click Continue.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to allow you to perform an Easy Install.

Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, and the Apple Printer Utility.

Custom Install lets you specify what portions of the software you would like
to install.
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IMPORTANT The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.

11 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.

12 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

13 Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back
on now.

After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer.

You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Apple Printer Utility and Read Me files.

Creating installation disks from the CD-ROM disc

You can create installation floppy disks from the CD-ROM disc. You’ll need
seven blank floppy disks. To create installation disks, follow these steps:

1 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.

Note: Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.

2 Double-click the disc icon to open the disc, if necessary.

3 Double-click the MAC_OS folder, if necessary.

4 Double-click the SOFTWARE folder, if necessary.

5 Copy the DISKS folder to your hard disk.
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6 Double-click the DISKS folder on your hard disk.

7 Double-click the Floppy Disk Maker application.

8 Click Full Set.

A dialog box appears that gives you some information, such as the
approximate time it will take to copy the images to floppy disks.

9 Click Start to start the copy process.

10 Follow the instructions on the screen until all disk images have been copied.

Be sure to label the disks.

Installing from the floppy disks

To install the printer software on a Mac OS–based computer, follow these
steps:

1 Quit any programs you are running.

2 Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation
is complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual
that came with the program, or telephone the manufacturer of the program.)

3 Make sure the disks are locked.

4 Insert LaserWriter Disk 1 for Mac OS into a disk drive.

The disk’s icon appears on the desktop.

Note: If you are installing from floppy disks made from the CD-ROM disc,
the floppy disk label may be different.

5 Double-click the disk icon to open the disk, if necessary.

6 Read the Before You Install file to check for late-breaking news.
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7 Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.

8 Click Continue.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to allow you to perform an Easy Install.

Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, the Apple Printer Utility, and the Control
Strip module (if the Control Strip is installed).

Custom Install lets you specify what portions of the software you would like
to install.

IMPORTANT The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.

9 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.

10 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

11 Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back
on now.
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After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer.

You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Apple Printer Utility and Read Me files.

More information about the Installer program

In the procedure just described, the Installer places all the software you need
onto your hard disk. In rare circumstances, you may want to install only a
subset. For example, you may not want to install the Apple Printer Utility on
users’ systems because this utility changes the settings in the printer for all
users. In that case, choose Custom Install from the pop-up menu in the
Installer. A list of choices appears. To install something from the list, click to
select it, then click the Install button. (There is also a Custom Remove
feature.)

Step 2: Choosing the printer

Before you use your printer for the first time, you must use the Chooser to
select the LaserWriter 12/640 PS and set up the printer software.

Once you select the printer in the Chooser, you won’t need to repeat this step
unless you change printers or change the way your printer is connected.

1 Choose the Chooser from the Apple (K) menu.

The Chooser window appears.

2 Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.
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3 Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.

The name of your LaserWriter 12/640 PS printer appears in the right half of
the Chooser (along with the names of any other available LaserWriter
printers). (Your Chooser may not look exactly like the illustration.)

4 Click the name of your LaserWriter 12/640 PS.

You’ve now selected the LaserWriter 12/640 PS printer for printing.

If this is the first time you’re using the printer, you must set up the printer
software. When the printer software has been set up, a small printer icon
appears beside the printer name. If your printer software has already been set
up and an icon appears beside the printer name, skip to step 6. To set up the
software, continue with step 5.

5 Set up the printer.

m To let the Chooser identify the type of printer and automatically set up the printer
software, click Create.

By the way: Double-clicking the printer name is a shortcut for clicking the
name and clicking Create.

m To manually set up the printer software, press the Option key and click Create.
Click the name of the PostScript Printer Description file to be used with
the printer and click Select.

A small printer icon appears beside the printer name.
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6 If you want, you can repeat steps 4 and 5 to create desktop printer icons for other
printers.

7 Close the Chooser.

After you click Create, the new desktop printer icon for the LaserWriter
12/640 PS appears on the desktop.

You can drag this icon to any position you want on your desktop or place it
into a folder.

The last desktop printer created becomes the default printer. Your documents
will automatically be printed on the default printer. For more information
about selecting among available printers, see “Switching Between Printers” in
Chapter 6.

If this is your only desktop printer, you can’t get rid of the icon by dragging it
to the Trash. (The icon will reappear if you do.) To get rid of the LaserWriter
12/640 PS desktop printer icon, you must first select a different desktop
printer as the default printer and then drag the LaserWriter 12/640 PS printer
icon to the Trash. If you don’t want to use desktop printer icons, see “Turning
Off or Removing the Desktop Printing Software,” in Chapter 6, for more
information.
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Making changes to the printer setup

If you change options on your printer, you must set up the printer again.

1 Select the desktop printer icon for the printer you want to set up.

2 Choose Change Setup from the Printing menu.

3 Click Auto Setup.

Printer options are displayed in the Setup dialog box. (Your screen may not
look exactly like the illustration.)

4 To change any options (for example, to change 500-sheet cassette and feeder to
“Installed and Preferred”), select the option from the Change pop-up menu and select its
new value from the To pop-up menu.

5 When you’re done, click OK.

Step 3: Naming the printer and setting its zone

Once connected to an AppleTalk network, the printer will appear on the
network with the name LaserWriter 12/640 PS. You can change this name, if
you wish. You can use the Apple Printer Utility, installed in the Apple
LaserWriter Software folder, to name the printer.

When a printer is connected to an EtherTalk network with multiple logical
zones, you can also set which zone the printer will be in. You can set the
printer’s zone with the Apple Printer Utility.

See Appendix A for more information on using the Apple Printer Utility.
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Step 4: Making sure everything is working

The best way to make sure everything is set up correctly is to print something.
As a simple print test, open and print one of the Read Me files that is in the
Apple LaserWriter Software folder.

1 Locate the Apple Printer Software Read Me file in the Apple LaserWriter Software folder.

2 Open the Apple Printer Software Read Me file and choose Print from the File menu
(or drag the Read Me file to the desktop printer icon and drop it on the printer).

The Print dialog box appears. If the LaserWriter 12/640 PS printer’s name
does not appear in the dialog box, see “Step 2:  Choosing the Printer.”

3 Click Print.

If the document doesn’t print, check the steps you followed in Chapter 1 for
connecting and turning on the printer. Also check that you have followed all
the software installation steps presented in this chapter. Make sure that you
have installed the toner cartridge and loaded paper into the paper cassette.
Check that no packing material or paper has caused a jam in the printer.

If the printer still will not print, turn to the troubleshooting chapters.
Indicator lights on the front of the printer blink to signal different errors and
printing conditions, such as out of paper or a paper jam. You can also double-
click the desktop printer icon to check the status messages that appear in the
Desktop PrintMonitor.

Configuring the printer

You may change some of the printer’s default settings using the Apple Printer
Utility. For more information on the Apple Printer Utility, see Appendix A. If
you want to install any options, see Chapter 5. Then you can install the
printer software on Mac OS–based computers on your network as explained
in “Installing the Software From a Server,” next.
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Installing the software from a server

You can get Mac OS users started with the printer and the new printer
software in whatever way you’re used to. If you’d prefer not to pass around the
software disks, you can place the software on a server, as explained in the next
section. If you prefer, you can of course install the software on each user’s
computer yourself. If you have the users install their own software, make sure
you give them:

m the printer software and instructions for installing it

m the name of the AppleTalk zone on which the printer is located

m the name you gave the printer if you renamed it with the Apple
Printer Utility

Installing onto a server

If you prefer that users install their software from a network server rather
than pass around the original floppy disks or CD-ROM disc, you must copy
the LaserWriter installation software to a server as follows.

Preparing a server using the CD-ROM disc

The CD-ROM disc shipped with the printer contains a network installation
folder. To prepare a server:

1 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

2 Double-click the disc icon, if necessary.

3 Double-click the MAC_OS folder, if necessary.

4 Double-click the SOFTWARE folder, if necessary.

5 Drag the INSTALL folder from the CD to your server.

Preparing a server using the floppy disks

1 Create a new folder on the server and rename it (for example, Network Install).

2 Insert LaserWriter Disk 1 for Mac OS.
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3 Drag the LaserWriter Disk 1 icon onto the icon of the folder.

IMPORTANT You must drag the disk icon rather than copy the contents of the
disk directly.

4 Repeat steps 2 and 3 for each printer disk.

5 Open the folder you created in step 1.

The contents of each disk are contained in a folder named for that disk.

6 Open the LaserWriter Disk 1 folder.

7 Select the Installer and Installer Script icons and drag the icons from the LaserWriter
Disk 1 folder to the folder you created in step 1.

The Installer and the Installer Script need to be in the same window as the
folders for the disks you copied.

IMPORTANT Be sure to tell the users in your group where to find the software
and the name of the folder to look for on the server.
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Installing the printer software from the server

After you’ve copied the software to the server as described earlier in
“Preparing a Server Using the CD-ROM Disc,” users can install the software
on their own computers by following these steps:

1 Turn off any automatic virus-detection programs on your computer before installing the
software.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)

2 Log on to the server from the computer where you want to install the software.

3 Open the folder that contains the printer software.

4 Double-click the Installer icon.

A dialog box opens to describe the installation.

5 Click the Continue button to close the dialog box.

6 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.

7 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

8 Click the Restart button.

The software is now installed and the printer is ready for use. If you turned
off any automatic virus-detection programs on your computer, turn them back
on now.
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What to do next

The printer is now set up on your AppleTalk network. The table below can
help you decide which chapter to go to next.

If you want to See

Set up the printer for Windows, DOS, or NetWare users Chapter 3

Set up the printer for UNIX users Chapter 4

Install options Chapter 5

Print from a Mac OS–based computer Chapter 6

Print from a Windows 3.1 or DOS computer Chapter 7

Print from a Windows 95 computer Chapter 8

IMPORTANT See the oncreen user’s manual for information on how to use
your Apple LaserWriter 12/640 PS printer. The file is in Adobe Portable
Document Format (PDF). To read or print the documentation, you use the
Acrobat Reader software on the CD-ROM disc. The PDF file is located at
MAC_OS:Monochrome LaserWriter:LW12/640UM.pdf and
WIN_OS\MONO_LSR\LW12/640U.pdf on the CD-ROM disc.
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This chapter describes how to set up the printer for use with IBM PC or
compatible computers running Windows 3.1, Windows 95, Windows NT, or
DOS. It also provides detailed procedures for setting up the printer for use on
a Novell NetWare network.

System requirements for Windows 95

To use the printer, your computer system must meet these requirements:

m IBM PC or compatible, with an 80486 or higher CPU

m hard disk drive

m at least 8 MB of RAM

m Microsoft Windows 95

m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks

m If you’re using the printer on a network, you must set up your network
client software. You may use Client Software for NetWare Network from
Microsoft as your network client software.

Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.
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System requirements for Windows 3.1

To use the printer, your computer system must meet these requirements:

m IBM PC or compatible, with an 80386 or higher CPU

m hard disk drive

m at least 4 megabytes (MB) of random-access memory (RAM)

m Microsoft Windows 3.1 or higher or Windows for Workgroups 3.11
or higher

m MS-DOS version 3.3 or higher (5.0 or higher recommended)

m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks

m NetWare requires an 80386 CPU with NetWare version 3.12 or higher

Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.

Before you begin

Set up the printer as described in Chapter 1, remembering to

m unpack and prepare the printer

m connect the printer to your NetWare network using Ethernet cables or
through a direct parallel connection to a PC

m plug in and turn on the printer (Keep the startup page that automatically
prints out. It provides the default printer name you need for setup.)

Setting up for DOS-based printing

If you will be printing from DOS applications only, you do not need to install
any of the software that came with the printer. However, to print from a DOS
application, you must first install the DOS PostScript driver if one exists for
your DOS application. The DOS PostScript driver is usually supplied with the
DOS application. Follow your application’s instructions for installation and
printing. See also “DOS Notes” in Chapter 7.
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Setting up for parallel port printing

Your LaserWriter 12/640 PS printer uses a standard parallel port. By default,
your printer’s parallel port is ready to receive data, and you should not need
to make any changes to either your computer’s or the printer’s parallel
port setting.

Installing the printer software for Windows 95 and Windows 3.1

You must install the printer software on each computer that will print to the
printer. You can do so by using the installation program that comes on the
software disks included with the printer.

Note: Be sure you have Windows on your computer, before installing the
printer software.

To install the Windows printer software, follow these steps. These instructions
assume that you have a mouse or similar pointing device. If you do not, see
the instructions that came with Windows to find out how to perform these
steps using a keyboard.

Installing from the CD-ROM disc

Installing onto a Windows 95 computer

1 Start Windows 95.

Before installing the software, make sure the Control Panel and Printers
folder are closed.

2 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

3 Open the directory on the CD called WIN_OS\WIN95\DISK1.

4 Double-click the setup.exe file.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.
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5 Click Next if you have no other open applications.

If you have open applications, click Cancel to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

6 Click Yes to view the ReadMe file.

7 When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome dialog box is displayed that allows you to select Express
Installation, Custom Installation, or Printer Driver Only.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file
and the Apple LaserWriter Utility for Windows, which you use to name the
printer and perform various printer administrative functions.

Custom Installation lets you specify what portions of the software you would
like to install.

Printer Driver Only installs only the PostScript printer driver and printer
description files.

8 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.

9 Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program onto your
hard disk.

10 Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.

11 Enter a new directory for the setup program or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).
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12 Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.

13 Select the drive that holds your CD from the Drives list box.

14 Select Disk 3 from the Directories list.

15 Select LaserWriter 12/640 PS from the PostScript Printer Descriptions Available list and
click Next.

16 Select LPT1 if the printer is connected to your local computer.

17 Click Next.

The Add Printer dialog box appears.

18 Name your computer and select other options as necessary.

19 Click Next.

The printer Properties dialog box appears.

20 Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.

21 Click Add Another to install another Apple LaserWriter printer. 

Repeat for each printer you want to install.

22 When you’re done, click Exit.

Installation is complete.

23 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.

For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.

To configure your printer software with NetWare, see “Initial Novell
NetWare 4.1 Setup,” later in this chapter.
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Installing onto a Windows 3.1 computer

1 Start Windows.

Before installing the software, make sure the Windows Control Panel and
Printers control panel are closed.

2 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

3 Using the File Manager, open the directory on the CD called WIN_OS\WIN31_NT\DISK1.

4 Double-click the setup.exe file.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.

5 Click Continue if you have no other open applications.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

6 Click Yes to view the ReadMe file.

7 When you have finished reading the ReadMe file, choose Exit from the File menu in the
Notepad application.

A Welcome dialog box is displayed that allows you to select Express
Installation, Custom Installation, Print Driver Only, or De-Install.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file
and the Apple LaserWriter Utility for Windows, which you use to name the
printer and perform various printer administrative functions.

Print Driver Only installs the minimum software needed for printing only.

Custom Installation lets you specify what portions of the software you would
like to install.

De-Install lets you remove previously installed LaserWriter software.

8 Click Express Install.

A window appears that keeps you informed as file decompression proceeds.
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9 Click Restart Windows.

After Windows restarts, the Adobe™ PostScript Printers control panel
appears.

10 Select the drive that holds your CD from the Drives list box (or select
WIN_OS\WIN31_NT\DISK2).

11 Select LaserWriter 12/640 PS from the PostScript Printer Descriptions Available list and
click Install.

The PostScript printer driver files are installed on the hard disk. A message
appears telling you that the driver software was successfully installed.

12 Click OK to dismiss the message.

13 Select another Apple LaserWriter printer, if you want, and click Install to install. 

Repeat for each printer you want to install.

` 14 When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you’ve installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.

Installation is complete.

15 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.

For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.

To configure your printer software with NetWare, see “Initial Novell
NetWare 4.1 Setup,” later in this chapter.
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Installing onto a server

You can install the software on a server for users who share the server’s copy
of Windows. Follow the steps given in “Installing From the CD-ROM Disc”
and specify the appropriate server volumes and paths. Be sure that the client
workstations have access to the server volumes and paths.

If you install Apple LaserWriter Utility for Windows 3.1 or Windows for
Workgroups 3.11 and a network drive and plan to let other people share the
same directory, make the following changes to the SYSTEM.INI file on all
PC workstations that will be running the utility.

1 Open the SYSTEM.INI file.

2 Locate the [386Enh] section and add the following line:

DEVICE=VECPD.386

3 Disable the following DEVICE entries by prefixing the line with a semicolon (;). Your
changes should look like this:

;DEVICE=*VPD

;DEVICE=LPT.386

You can also copy the software folders from the CD-ROM disc to a hard disk.
Your users can install the software from the server as described in “Installing
From the CD-ROM Disc,” earlier in this chapter.

Creating floppy disks from the CD-ROM disc

From a Windows 95 computer

You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 95.

1 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

2 Double-click the My Computer icon.

3 Double-click the drive that holds your CD.

A window appears that displays the contents of the CD.

4 Insert a blank floppy disk into the a: drive (or b: drive).
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5 Double-click the drive that holds your floppy disk.

A window appears that displays the contents of the floppy disk.

6 Open the WIN_OS directory.

7 Drag the WIN95\DISK1 from the CD window to the floppy disk window.

8 Repeat steps 4 through 6 using the WIN95\DISK2 and WIN95\DISK3 directories.

From a Windows 3.1 computer

You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 3.1.

1 Open the File Manager.

2 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

3 Insert a blank floppy disk into the a: drive (or b: drive).

4 From the File Manager, open the WIN_OS\WIN31_NT\DISK1 directory on the CD.

5 Select Copy from the File menu.

6 Type *.* in the Source field and a: (or b:) in the Destination field.

The files are copied to the floppy disk.

7 Repeat steps 3 through 6 using the WIN31_NT\DISK2 directory.

Installing from the floppy disks

Installing on a Windows 95 computer

1 Find the Windows disks containing the printer software and make sure they’re write-
protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.

2 Start Windows 95.

Before installing the software, make sure the Windows Control Panel and
Printer folder are closed.
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3 Insert LaserWriter Disk 1 for Windows 95 into a floppy disk drive.

Note: If you are installing from disks made from the CD, the floppy disk
labels may be different.

4 Click the Start Icon on the Task-Bar and select Run.

5 Type a:\setup or b:\setup (depending on which drive holds your installation
disk) in the command line field and click OK. 

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.

6 Click Next if you have no other open applications.

If you have open applications, click Cancel to stop this installation. Close
all other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

7 Click Yes to view the ReadMe file.

8 When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome message is displayed that allows you to select Express
Installation, Custom Installation, or Printer Driver Only.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file
and the Apple LaserWriter Utility for Windows, which you use to name the
printer and perform various printer administrative functions.

Custom Installation lets you specify what portions of the software you would
like to install.

Printer Driver Only installs only the PostScript printer driver and printer
description files.

9 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.

Insert other printer disks (and click OK) as the program asks for them.
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10 Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program onto your
hard disk.

11 Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.

12 Enter a new directory for the printer drivers or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).

13 Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.

14 Eject LaserWriter Disk 2 for Windows 95 and insert LaserWriter Disk 3 for Windows 95.

The PostScript PPD files are located on LaserWriter Disk 3 for Windows 95.

15 Choose a: or b: (depending on which drive holds your installation disk) from the Drives
list box.

16 Select LW 12/640 PS from the PostScript Printer Drivers Available list and 
click Next.

17 Select LPT1 if the LaserWriter 12/640 PS is connected to your local computer.

18 Click Next.

The Add Printer dialog box appears.

19 Name your printer and select other options as necessary.

20 Click Next.

The printer Properties dialog box appears.

21 Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.
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22 Click Add Another to install another Apple LaserWriter printer. Repeat for each printer
you want to install.

You can install other Apple LaserWriter printers supported by the software.

23 When you’re done, click Exit.

Installation is complete.

24 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.

For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.

To configure your printer software with NetWare, see “Initial Novell
NetWare 4.1 Setup,” later in this chapter.

Installing on a Windows 3.1 computer

1 Find the Windows disks containing the printer software and make sure they’re 
write-protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.

2 Start Windows.

Before installing the software, make sure the Windows Control Panel and
Printers control panel are closed.

3 Insert LaserWriter Disk 1 for Windows 3.1 into a floppy disk drive.

4 From the Windows Program Manager, choose Run from the File menu.

5 Type a:\setup or b:\setup (depending on which drive holds your installation
disk) in the command line field and click OK. 

After a few moments, a message appears telling you to close all other
applications before continuing with this installation.
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6 Click Continue if you have no other open applications.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

7 Click Yes to view the ReadMe file.

8 When you have finished reading the ReadMe file, choose Exit from the File menu in the
Microsoft Write application.

A dialog box appears that allows you to select Express Installation, Custom
Installation, Printer Driver Only, or De-Install.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the Read Me file,
the Apple Print Monitor for Windows, and the Apple LaserWriter Utility for
Windows which you use to name the printer and perform various printer
administrative functions.

Custom Installation lets you specify what portions of the software you would
like to install.

Printer Driver Only installs only the PostScript printer driver and printer
description files.

De-Install lets you remove previously installed LaserWriter software.

9 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.

Next, the Installer asks you to press a button to restart Windows.

10 Click Restart Windows.

After Windows restarts, the Adobe PostScript Printers control panel appears.

11 Remove LaserWriter Disk 1 for Windows 3.1 and insert LaserWriter Disk 2 for 
Windows 3.1.

12 Select a: or b: (depending on which drive holds your installation disk) from the Drives
list box.
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13 Select the LaserWriter 12/640 PS and click Install. 

The PostScript printer driver files and other software are installed on the hard
disk. A message appears telling you that the driver software was successfully
installed.

14 Click OK to dismiss the message.

15 Select another Apple LaserWriter printer, if you want, and click Install to install. Repeat
for each printer you want to install.

You can install other Apple LaserWriter printers supported by the software.

16 When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you’ve installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.

17 Click OK to dismiss the message.

Installation is complete.

18 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.

For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.

To configure your printer software with NetWare, see “Initial Novell
NetWare 4.1 Setup,” later in this chapter.
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Installing the printer software for Windows NT

Installing onto a Windows NT 3.5x–based computer

These instructions install the printer on an Intel architecture Windows NT
3.5x Workstation. If you have a Windows NT 3.5x Server or other computer
architecture, see the section “Installing Onto a Windows NT 3.5x–Based
Server or Non-Intel Computer” below.

1 Start Windows NT 3.5.

2 Insert the Apple LaserWriter CD-ROM disc into the CD-ROM drive.

3 Using File Manager, open the directory on the CD called WIN_OS\WIN_31_NT\DISK1.

4 Double-click the setup.exe file.

The Welcome screen appears.

5 Select Custom Install and click Windows NT Printer Software. Make sure all other
checkboxes are not checked.

6 Click Install. 

Instructions for installing the Windows NT software appear.

7 Click Continue.

the Print Manager dialog box appears.

8 Select Create Printer from the Print Manager’s Printer menu.

The Create Printer dialog box appears.

9 Select Other in the Driver Combo box.

10 Type D:\WIN_OS\WIN31_NT\DISK2 when prompted by the Install Driver 
dialog box.

Replace d: with the letter of your CD-ROM drive.

11 Make sure the correct drive is listed in the Install Driver dialog box and click OK.

A list of printer drivers appears.
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12 Select the printer driver that corresponds to your printer and click OK.

13 Follow the instructions on the screen.

14 Click Continue and OK to complete the installation.

Installing onto a Windows NT 4.0–based computer

You can use the Windows NT 4.0 Add Printer Wizard to install the PostScript
printer driver.

1 Start Windows NT 4.0.

2 Insert the Apple LaserWriter CD into the CD-ROM drive.

3 Using File Manager, open the directory on the CD called WIN_OS\WIN31_NT\DISK2.

4 Copy the APLWNT40.INF file and printer PPD file to your hard drive.

5 Click the Start Icon on the Task-Bar; select Settings and then Printers.

6 Double-click the Add Printer icon.

7 Follow the instructions on the screen until the list of known printers appears in the Add
Printer Wizard window.

8 Click Have Disk.

9 In the dialog box that appears, select the driver and directory where the APLWNT40.INF
file and printer PPD file are located.

You copied these files to your hard drive in step 4.

A list of printer models appears.

10 Select the LaserWriter 12/640 PS printer and click Next.

11 Follow the instructions on the screen to select the port.

The Add Printer Wizard prompts for the PostScript printer driver
source directory.

12 Insert the Windows NT 4.0 CD-ROM disc into the the CD-ROM drive.

13 Follow the instructions on the screen to complete the installation.

60 Chapter  3



Installing onto a Windows NT 3.5x–based server or non-Intel
computer

Follow these steps to install the software on a Windows NT 3.5x server or
non-Intel computer.

1 Copy the PRINTER.INF file located in the D:\WIN_OS\WIN31_NT\DISK2 directory of your
CD-ROM disc to a temporary directory on your hard disk drive.

This example uses c:\TEMP as the temporary directory.

2 If you are installing onto a Windows NT 3.5x Server:

m Open the PRINTER.INF file with Notepad.

m Search for the [Source Media Description] session.

m Comment out the line for the NT Workstation.

m Uncomment the line for the NT Server.

m Save the file and exit Notepad.

3 Place your Windows NT CD-ROM disc into the CD-ROM drive.

This example uses d: as the CD-ROM drive. Be sure to use the letter that
corresponds to your CD-ROM drive.

4 Double-click the “MS-DOS command prompt” icon in the Main program group.

5 Change to the appropriate directory by typing:

D:

CD \i386

The i386 directory is for Intel computers. You will need to change this
directory according to your system. For example, \PPC is for a PowerPC™
computer.

6 Expand the PostScript driver components to your temporary directory. The following
command expands the files to the C:\TEMP directory.

EXPAND -R PSCR*.* C:\TEMP

Five files are expanded to your temporary directory: PSCRIPT.CNT,
PSCRIPT.DLL, PSCRIPT.HLP, PSCRIPT.SEP, and PSCRIPTUI.DLL.

7 Double-click the Print Manager icon located in the Main program group.
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8 Select Create Printer from the Print Manager’s Printer menu.

The Create Printer dialog box appears.

9 Select Other in the Driver Combo box.

10 Type the location of your PRINTER.INF file when prompted by the Install Driver 
dialog box.

A list of printer drivers appears.

11 Select the printer driver that corresponds to your printer and click OK.

12 Follow the instructions on the screen.

13 Click Continue and OK to complete the installation.

Initial Novell NetWare 4.1 setup

NetWare 4.1 introduces the concept of a hierarchical tree database, called
NetWare Directory Services (NDS). NDS is different from the flat file
database called the bindery used in earlier versions of NetWare. The printer
does not support NDS. A NetWare command, SET BINDERY CONTEXT,
allows a single level of the NDS directory tree to be specified as a virtual
bindery location. Each time you use the NetWare 4.1 file server, set the file
server’s bindery context by typing SET BINDERY CONTEXT at the
console prompt.

The superuser account name also changes with NetWare 4.xx to Admin from
NetWare 3.xx’s name of Supervisor. The Supervisor account still exists in
NetWare 4.xx for backward compatibility, but it can’t actually be seen in the
NDS directory tree. The Admin account gives you full access to the entire
NetWare Directory Services tree. The Supervisor account only lets you see
objects that are in its bindery context location in the tree. When following the
steps below for setting up your printer on NetWare 4.1 as PSERVER, always
use the NetWare Admin account.

Make sure that the NetWare network is set up and operating according to the
instructions in the Novell NetWare documentation.

You should have access to the NetWare Printer Console utility, PCONSOLE,
on the computer from which you will be setting up the printer and have the
administrative privileges necessary to make changes to the network.
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Step 1: Choosing an operating mode

When setting up your printer for a NetWare network, you have a choice of
three operating modes:

m PSERVER mode, in which the printer emulates NetWare’s PSERVER
software and functions as a dedicated print server

m RPRINTER mode, in which the printer functions as a remote printer

m ATPS (AppleTalk Print Spooler) mode, in which the printer functions as a
remote AppleTalk printer

In PSERVER mode, the factory default, print jobs are stored in a queue on a
specified file server and retrieved by the printer.

In RPRINTER mode, the printer depends on the NetWare print server
software—either a NetWare Loadable Module (NLM), an RPRINTER.EXE
executable file, or a value-added process (VAP) running on top of the
operating system—to manage printing. Print jobs are stored in a queue on a
specified file server. When the printer is ready to print the job, the NetWare
print server software copies the job to the printer.

In ATPS mode, the printer uses its AppleTalk protocol support to
communicate with the Novell ATPS NetWare Loadable Module (NLM). The
NLM (included in the NetWare for Macintosh package from Novell) extends
full queue and spooling services to Mac OS clients from a server-based
software process.

There are advantages to each type of operating mode. Your choice will
depend on your networking environment and the types of jobs you will be
printing. Regardless of your choice, you can locate the printer anywhere on
the network.

What to do next

Once you decide how you want to set up the printer, proceed as follows:

m PSERVER To set up the printer as a print server, read about how to use
PCONSOLE in the next section, then

m if you want a simple setup, read “Step 2, Option A: Setting Up the
Printer as a Print Server (Using PCONSOLE),” later in this chapter.

m if you want to assign a password, read “Step 3: Assigning a Password for
the Print Server (Optional),” later in this chapter.
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m RPRINTER To set up the printer as a remote printer, read about how to use
PCONSOLE in the next section, then skip to “Step 2, Option B: Setting Up
the Printer as a Remote Printer (RPRINTER Mode),” later in this chapter.

For both PSERVER and RPRINTER, you must also follow the instructions
in “Step 4: Setting Up the PostScript Printer Driver for NetWare,” later in
this chapter.

For more information about using the Apple LaserWriter Utility, see
Appendix A.

Using PCONSOLE

PCONSOLE is a DOS-based utility for configuring printers on a NetWare
network. This chapter provides information on the set of basic PCONSOLE
operations required to set up the LaserWriter 12/640 PS. PCONSOLE is not
provided with the printer. It comes with your NetWare software. Detailed
information about PCONSOLE can be found in your NetWare
documentation.

The descriptions of PCONSOLE in this guide assume the use of keyboard
commands to navigate through the program and perform operations. With the
installation of a DOS mouse driver, you can also use a mouse to make
selections and choose options.

The table below lists some basic PCONSOLE key commands.

Command key Description

Esc (Escape) Returns to the previous level

Del (Delete) Deletes a selected item

F7 Cancels changes

Alt-F10 Exits the program

Ins (Insert) Inserts a new item for a list

F1 Displays online help

Arrow keys Cycle through menu selections or entry fields
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Step 2, option A: Setting up the printer as a print server
(using PCONSOLE)

There are five parts to setting up the LaserWriter 12/640 PS for
PSERVER mode:

m Create a print server.

m Create a printer.

m Create a print queue.

m Set your printer to PSERVER mode.

m Turn the printer off and then back on to have the changes take effect.

Creating a print server

1 Restart the printer to print a startup page; then obtain the NetWare Printer Name. 

This NetWare Printer Name is the name of the printer on a NetWare network.
It is also the default print server name.

2 Type SET BINDERY CONTEXT at the NetWare file server’s console prompt to
ensure that the context has been set. 

Be sure to write the context down, as it will be needed later.

3 Log in to the NetWare file server from a DOS client using the Admin account.

4 At the DOS prompt, type PCONSOLE and press Enter.

5 Use the arrow keys to highlight Change Context in the menu, and press Enter.

6 Change the PCONSOLE utility’s context to match the context set on the server (what you
wrote down earlier), by pressing the Ins key, and selecting the correct context.

7 Use the arrow keys to highlight Print Servers in the menu, and press Enter.

8 Press the Ins key, then type the NetWare Printer Name (provided on the printer’s startup
page), and press Enter. 

The print server is created.
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Creating a printer

1 Select the name of the print server you specified in the previous procedure and 
press Enter.

2 Use the arrow keys to highlight Printers in the Print Server Information menu, and 
press Enter.

This will let you configure the new print server.

3 Press the Ins key to display printers in your current context in the NetWare Directory
Services tree. 

Note: You may have created a printer earlier. This example assumes that the
printer has not yet been created.

4 Press the Ins key to create a new printer in the NetWare Directory Services tree. 

Make sure that the context listed at the top of the screen still lists the server’s
bindery context that was set earlier. If not, change to the correct context
before creating the printer.

5 At the prompt, type the new printer name and press Enter. 

This name will be used for reference, so use a name that will be meaningful
to the NetWare administrator or to other users who may wish to check on the
printer’s status. This step creates the printer object in the NDS tree.

6 Select the name of the printer you specified and press Enter. 

This adds the printer to the Serviced Printers list of the print server.

7 From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure, and press Enter. 

This brings up the Printer Configuration menu.

8 From the Printer Configuration menu, use the arrow keys to highlight Printer type, and
press Enter.

9 From the Printer Type menu, use the arrow keys to highlight Other/Unknown, and 
press Enter. 

This makes your selection active, and brings you back to the Printer
Configuration menu.
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10 From the Printer Configuration menu, use the arrow keys to highlight Banner type, and
change the banner type from Text to PostScript. 

Creating a print queue

1 From the Printer Configuration menu, use the arrow keys to highlight Print queues
assigned, and press Enter. 

This displays the Print Queue menu list.

2 Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree. 

For this example, you will create a new queue.

3 Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context before
creating the print queue.

4 At the prompt, type the new queue name and press Enter. 

You are then asked for the NetWare volume to store your NetWare print queue
jobs on. With NetWare 4 the NetWare queue does not have to exist on the
SYS volume. You can place the queue on any volume you choose. Use the Ins
key to select the volume from the directory tree (you may need to navigate to
a different context to select the volume desired).

5 Select the name of the queue you specified above and press Enter. 

This adds the queue to the Print Queue list of the printer.

6 Press the Esc key until you are prompted to save your changes.
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Completing the PSERVER configuration

1 Start Windows, if it’s not already running.

2 In the Program Manager window, open the Apple LaserWriter Software program group
and double-click the Apple LaserWriter Utility icon.

3 Select your printer.

4 Select Print Server Configuration from the Network menu.

5 Select the printer you want to configure.

You can identify the printer from the NetWare printer name that is printed on
the printer’s startup page.

IMPORTANT After the printer is turned on, it advertises itself on the NetWare
network for 5 minutes only to reduce network traffic. If you don’t see your
printer’s name in the list of printers, turn the printer off and back on. Make
sure the NetWare file server is running, and verify that the NetWare file
server and the printer are using the same Ethernet frame type. If the Ethernet
frame types do not match, see “Connecting to a Network Printer Manually”
in Appendix A. See also “Novell NetWare Troubleshooting” in Chapter 12.

6 Select the LaserWriter 12/640 PS printer you want, then click Configure.

7 Enter the PSERVER name.

Use the same printer name you used in PCONSOLE (if you are not using the
default name).

8 Enter the same NetWare password that you entered with PCONSOLE.

9 Enter the names of file servers that the printer will service.

10 Click Add.

11 Click OK.

12 Enter the queue scan time.

The queue scan time is the number of milliseconds that the printer will wait
before checking each file server that it can access.

13 Click Send.
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Restarting the printer

1 Turn the printer off and then back on again.

2 Submit a print job to the printer to ensure it is working.

What to do next: The next section covers setting up the printer as a remote
printer. If you want to assign a password on the server, see “Step 3: Assigning
a Password for the Print Server (Optional).” Otherwise, see “Step 4: Setting
Up the PostScript Printer Driver for NetWare.”

Step 2, option B: Setting up the printer as a remote printer
(RPRINTER mode)

There are six parts to setting up the printer for RPRINTER mode:

m Create a print server.

m Create a printer.

m Create a print queue.

m Set your printer to RPRINTER mode.

m Start PSERVER on your NetWare 4.1 file server.

m Turn the printer off and then back on to have the changes take effect.

Creating a print server

1 Turn the printer off and back on; then retrieve the printer’s startup page.

2 Type SET BINDERY CONTEXT at the server’s console prompt to ensure that the
context has been set. 

Write the context down, as it will be needed later when creating the printer in
the NetWare Directory Services tree.

3 Log in to a NetWare file server from a DOS client using the Admin account.

4 At the DOS prompt, type PCONSOLE, and press Enter.

5 Use the arrow keys to highlight Change Context in the menu, and press Enter.

6 Change the PCONSOLE utility’s context to match the context set on the server (what you
wrote down in step 2) by pressing the Ins key and selecting the correct context.

7 Use the arrow keys to highlight Printer Servers in the menu, and press Enter.
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8 Press the Ins key, then type a descriptive name for your printer server. 

This can be any name, but in general you should be able to glance at the
object and know what its purpose is (for example “12_640_Server”).

Creating a printer

1 Select the name of the print server you specified in “Step 2, Option A: Setting Up the
Printer as a Print Server (Using PCONSOLE)”; then press Enter.

2 Use the arrow keys to highlight Printers in the Print Server Information menu, and 
press Enter. 

This lets you configure the new print server.

3 Press the Ins key to display printers in your current context in the NetWare Directory
Services tree.

4 Press the Ins key to create a new printer in the NetWare Directory Services tree. 

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If this is not the case, change the context to the
correct context before creating the printer.

5 At the prompt, type the new printer name and press Enter.

6 Select the name of the printer you specified in the previous procedure and press Enter. 

This adds the printer to the Serviced Printers list of the print server.

Creating a print queue

1 From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure, and press Enter. 

A Printer Configuration menu appears.

2 From the Printer Configuration menu, use the arrow keys to highlight Printer type, and
press Enter.

3 From the Printer Type menu, use the arrow keys to highlight Other/Unknown, and 
press Enter. 

This makes your selection active, and brings you back to the Printer
Configuration menu.
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4 From the Printer Configuration menu, use the arrow keys to highlight Banner type, and
change the banner type from Text to PostScript. 

5 From the Printer Configuration menu, use the arrow keys to highlight Print queues
assigned, and press Enter. 

The Print Queue list appears.

6 Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree. 

For this example, you will create a new queue.

7 Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context first
before creating the print queue.

8 At the prompt, type the new queue name and press Enter. 

Next you will be asked for the NetWare volume on which to store your
NetWare print queue jobs on. With NetWare 4.xx, the NetWare queue does
not have to exist on the SYS volume. You can place the queue on any volume
you choose. Use the Ins key to select the volume from the directory tree. You
may need to navigate to a different context to select the volume desired.

9 Select the name of the queue you specified in the previous step and press Enter. 

This adds the queue to the Print Queue list of Printers.

10 Press the Esc key until you are prompted to save your changes.

Completing the RPRINTER configuration

1 Start Windows, if it’s not already running.

2 Open the Apple LaserWriter Software program group and double-click the Apple
LaserWriter Utility icon.

3 Select the printer to configure and click OK.

4 Choose Print Server Configuration from the Network menu.
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5 Click the LaserWriter 12/640 PS printer you want, then click Configure.

Use the printer’s NetWare printer name to identify the printer to configure.

6 Click Remote Printer.

7 Enter the name of the print server NLM in the Remote Printer Name field.

8 Enter the same printer number used by PCONSOLE for this printer.

9 Click Send.

Starting PSERVER on your 4.1 file server
m Start PSERVER on your 4.1 file server by typing LOAD PSERVER

<Print_Server_Name>.

Restarting the printer

1 Turn the printer off and then back on again.

2 Submit a print job to the printer to ensure it is working.

What to do next: If you want to assign a password on the server, see “Step 3:
Assigning a Password for the Print Server (Optional)” next. Otherwise, see
“Step 4: Setting Up the PostScript Printer Driver for NetWare.”

Step 3: Assigning a password for the print server (optional)

You can use PCONSOLE to assign a password for printing privileges.
However, if you assign a password in PCONSOLE, you must also use the
Apple LaserWriter Utility for Windows to specify the same password, as
described in “Completing the PSERVER Configuration” earlier in this
chapter. (The password specified in PCONSOLE tells the file server what to
expect; the password specified with the Apple LaserWriter Utility tells the
printer what to send.)

1 Select Print Servers from the Available Options menu in PCONSOLE and press Enter.

The list of print servers appears.
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2 Select the name of the print server for which you want to assign a password and 
press Enter.

The Print Server Information menu appears.

Printers

Information and Status

Users

Operators

Serviced Netware Servers

Description

Password

Audit

3 Select Password and press Enter.

4 At the prompt, type the password and press Enter.

PCONSOLE asks you to retype the password. (The characters are not
displayed as you type.)

5 Retype the password and press Enter.

IMPORTANT Record the password for later use. If multiple file servers will be
served by the same printer, the same password must be used on each server.

6 Press Esc once; then to save the change, press Enter.

7 To return to the Available Options menu, press Esc three times. 

Step 4: Setting up the PostScript printer driver for NetWare

For Windows 95

1 Click the Start icon on the Task-Bar and select Printer Settings.

2 Select the printer you want to use.

3 Select Properties from the File menu.

4 Click the Detail Property tab.

5 Click Add Port.

6 Click Browse to view the available print queues that have been defined with PCONSOLE.
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7 Select the print queue you want to use and click OK.

8 Click OK again.

9 Click OK to close the Property dialog box.

For Windows 3.1

1 In Windows, double-click Control Panel.

2 Double-click Printers.

3 Select the printer you want to use.

4 Click Connect. 

The Connect dialog box opens.

5 Click Network. The NetWare Printer Connections dialog box opens.

6 Select the queue and the port the printer is assigned to.

7 Click Capture, then click Close to close the dialog box. 

8 Select the queue and port combination you specified in step 6 and click OK.

9 In the Printer control panel, select the LaserWriter 12/640 PS as the default printer and
click Close.

Step 5: Making sure everything is working

When you have finished configuring your printer as a dedicated print
server or a remote printer, you can print, from a Windows application, a
document such as the ReadMe file to verify that you can print to the
LaserWriter 12/640 PS.
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Installing Type 1 fonts and Adobe Type Manager

You can install Type 1 fonts and Adobe Type Manager for use with your
computer and the LaserWriter 12/640 PS printer. See the documentation
accompanying Adobe Type Manager for information on installing and using
the software.

What to do next

The printer is now set up on your network. The table below can help you
decide which chapter to go to next.

If you want to See

Set up the printer for UNIX users Chapter 4

Install options Chapter 5

Print from a Mac OS–based computer Chapter 6

Print from a Windows 3.1 or DOS computer Chapter 7

Print from a Windows 95 computer Chapter 8

IMPORTANT See the oncreen user’s manual for information on how to use
your Apple LaserWriter 12/640 PS printer. The file is in Adobe Portable
Document Format (PDF). To read or print the documentation, you use the
Acrobat Reader software on the CD-ROM disc. The PDF file is located
at MAC_OS:Monochrome LaserWriter:LW12/640UM.pdf and
WIN_OS\MONO_LSR\LW12/640U.pdf on the CD-ROM disc.
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This chapter explains how to prepare the printer for UNIX users. Users’
computers must be connected to the printer by an Ethernet network using
TCP/IP (Transmission Control Protocol/Internet Protocol).

Before you begin

Set up the printer as described in Chapter 1, remembering to

m unpack and prepare the printer

m connect the printer to your TCP/IP network using Ethernet cables

m plug in and turn on the printer (Keep the startup page that automatically
prints out. It contains information you’ll need.)
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Initial TCP/IP setup

Before UNIX users can use the printer, the printer administrator must assign
an IP address for the printer, as described in the following sections.

Background information

TCP/IP is a protocol commonly used to connect UNIX systems over Ethernet
networks. Every TCP/IP device must have a unique IP address. Much of the
initial work the printer administrator must do is related to assigning an IP
address (and other associated information) to the printer.

Step 1: Installing the printer software

You don’t need to install any special UNIX software to administer the printer.
You can control many features of the printer’s TCP/IP interface by using the
Apple Printer Utility program on a Mac OS–based computer or LaserWriter
Utility for Windows on a Windows-based computer (see Appendix A).

Step 2: Obtaining an IP address for the printer

To be recognized on your TCP/IP network, your printer must be assigned an
IP address. Part of the address identifies your site; the other part uniquely
identifies the device. Most sites have a network administrator who dispenses
IP addresses for all new network devices. Contact your network administrator
for an IP address for the printer.

WARNING If your TCP/IP network contains devices with duplicate or
incorrect IP addresses, you may experience unpredictable network
behavior, or your network may cease to function. Make sure you obtain
a valid and unique IP address for the printer.
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Step 3: Assigning an IP address to the printer

When you unpack the printer, it has a unique permanent factory-assigned
Ethernet address, but no IP address. To assign an IP address to the printer,
you can use any one of the following methods, which are described more
fully in the sections that follow:

m ping assignment Any printer administrator with superuser privileges can
use this method, which is sometimes called gleaning. If your network has
neither RARP nor BOOTP services, and you have no access to Windows or
Mac OS–based computers, you must use this method.

m Apple Printer Utility for Mac OS and LaserWriter Utility for Windows If your
network includes a Mac OS–based computer or Windows computer, you
can use one of these utility programs to set the printer’s IP address.

m RARP (Remote Address Resolution Protocol) If your network has a RARP
server, you can use this method.

m BOOTP (Bootstrap Protocol) If your network has a BOOTP server, you can
use this method.

These methods are described below. Choose which section applies to you,
and skip the others.

How the printer obtains an IP address during normal operation

When the printer is initially installed, it has no IP address. The address is
shown as 0.0.0.0. When the printer is turned on, it attempts to obtain an
IP address through RARP and BOOTP. If successful, the printer retains this
address in nonvolatile memory and continues to use it unless it receives a
different address from RARP or BOOTP when it is restarted.

When the IP address is set through the Apple Printer Utility for the Mac OS,
the Apple Printer Utility for Windows, or telnet, the printer no longer
makes a RARP or BOOTP request when restarted. An IP address set in this
manner is called a permanent address. For more information on using these
utilities, see Appendix A.
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If the IP address is set through ping assignment (described below), the
printer attempts to obtain an address through RARP and BOOTP when
turned on. If unsuccessful, the printer continues to use the IP address set
through the ping assignment. To disable RARP and BOOTP requests
completely, set the IP address permanently through telnet or one of the
other utilities.

The ping command sends an ICMP Echo Request packet to the printer.
The destination fields in this packet contain the printer’s Ethernet address and
its IP address. The printer accepts the ICMP packet because it recognizes its
own Ethernet address. It then sets it own IP address to the address contained
in the packet’s IP destination address field.

Note: Setting the IP address works only with ICMP packets that specify the
printer’s Ethernet address in their destination field. Multicast or broadcast
packets will not be accepted.

Printer IP address assignment, option A: Using ping assignment

Any printer administrator with superuser privileges can use the ping

assignment method to assign the printer’s IP address and store it in the
printer’s nonvolatile memory (so it remembers the address even when the
printer is turned off).

Note: This method works only when the printer has no IP address. If 
you’ve already set the printer’s IP address, you cannot change it by using
this method.

1 Turn on the printer and save the startup page that prints out.

2 Log in as root to any UNIX workstation on the same subnet as the printer.

3 Add the following line to the /etc/hosts table on your workstation:

printer_IP_address     printer_IP_name

You obtain the printer IP address from your network administrator. You
choose the printer IP name yourself (if it was not assigned by the network
administrator). It must follow the naming convention of your system, which
generally means it must contain fewer than 32 characters and no special
characters.

Example

80.20.4.78     LaserWriterFloor2 



4 Type the following command to force an entry into your system’s arp table:

arp -s printer_IP_name     printer_Ethernet_address

The printer IP name is the same name you used in step 3. You obtain the
Ethernet address from the startup page that prints automatically when you
turn on the printer. The address appears next to the top icon on the page.

Example

If your startup page showed that your Ethernet address was
08:00:07:2b:48:fb, you would type

arp -s LaserWriterFloor2     08:00:07:2b:48:fb

5 Type the following ping command to store the printer IP address in the printer’s
memory:

ping printer_IP_name

The printer IP name is the same name you used in steps 3 and 4.

Example

ping LaserWriterFloor2

Normally, the ping command would result in a message telling you the
device received the ping command; however, the printer will not respond
this first time, though it will respond normally in the future.

The address is now stored in the printer’s memory, and you’re ready to test
whether the printer is working.

6 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.
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7 Skip to “Step 4: Configuring Users’ Workstations,” later in this chapter.

Printer IP address assignment, option B: Using Mac OS or Windows utilities

If you have a Mac OS–based computer connected to the printer, you can use
the Apple Printer Utility to assign the printer’s IP address, as described in
Appendix A.

If you have a Windows-based computer connected to the printer, you can use
the Apple LaserWriter Utility for Windows to assign the printer’s IP address,
as described in Appendix A.

After you have assigned the printer’s IP address, skip to “Step 4:  Configuring
Users’ Workstations,” later in this chapter.

Printer IP address assignment, option C:  Using a RARP or BOOTP server

If your network has a RARP or BOOTP server on the same subnet as the
printer, you can use it to assign the IP address to the printer. Each time the
printer is turned on, it will automatically broadcast a request to RARP and
BOOTP servers, which will search a configuration file that maps the printer’s
built-in Ethernet address to the IP address that you assign.

Your network documentation explains how to add the printer’s information to
the RARP or BOOTP configuration file.

For troubleshooting information about RARP and BOOTP, see Chapter 12.

Step 4: Configuring users’ workstations

You can now set up users’ workstations.

m If you’re using Sun Solaris, see “Configuring Sun Solaris,” next.

m If you’re using Sun OS version 4.1, see “Configuring Sun OS Version 4.1,
Ultrix, A/UX, or Other BSD Systems,” later in this chapter.

m If you’re using HP-UX, see “Configuring HP-UX Version 8.07” or
“Configuring HP-UX Version 9.x,” later in this chapter.

m If you’re using SCO UNIX, see “Configuring SCO UNIX,” later in this
chapter.
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m If you’re using IBM AIX, see “Configuring IBM AIX Version 3.x,” later in
this chapter.

m If you’re using a Silicon Graphics workstation, see “Configuring Silicon
Graphics IRIX,” later in this chapter.

Configuring Sun Solaris

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter.

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run admintool.

admintool &

5 Select Print Manager.

6 From the Browse menu, choose Printers.

7 From the Edit menu, choose Add and then Access to Printer.

8 Enter the queue name that you want to use in the Printer Name field.

9 Enter the printer’s IP name in the Print Server field.

10 Click Add.

11 In a command shell window, type the following command

lpadmin -p <queuename> -s<printer’sIP_name>!postscript

12 Exit admintool and test the installation by printing a file.
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Configuring Sun OS version 4.1, Ultrix, A/UX, or other BSD systems

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and address are entered in the /etc/hosts file.

If you’re using Network Information Service (NIS), see the NIS manual for
instructions on setting up an IP name and address.

4 Make sure the lpd daemon is running on the Sun-OS or Ultrix system by typing the
following command at the UNIX prompt:

ps aux | grep lpd

If the lpd daemon is running, you should see output similar to

root 135 0.0 0.0  52  0 ? IW Oct 17 0:01 /usr/lib/lpd

If the lpd daemon is not running, you will not see any output, and you
should start the daemon by logging in as root and typing this command at
the UNIX prompt:

/usr/lib/lpd

You can verify that the daemon is running by using the ps command
described in this step.

Note: To start the lpd daemon automatically when the system boots, add
the lpd command to the /etc/rc file. The following is an example
/etc/rc file (syntax varies across operating systems):

if [ -f /usr/lib/lpd ] ; then

rm -f /dev/printer /var/spool/lpd.lock

/usr/lib/lpd;echo -n ' printer'

fi
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5 Add the following entry to the /etc/printcap file:

printer_queue_name|[description_of_printer]:\

:lp=:mx#0:rm=printer_IP_name:\

:rp=printer_queue_name:\

:sd=path_to_this_queue’s_spool_directory:\

:lf=path_to_this_queue’s_log_ file:

Fill in the parameters in italics as follows:

m Replace printer_queue_name with the name the user should use to
reference the printer.

m Replace description_of_printer with a comment describing the printer.

m Replace printer_IP_name with the IP name you assigned to the printer in
“Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Replace path_to_this_queue’s_spool_directory with the pathname of the
unique directory created for this queue.

m Optionally replace path_to_this_queue’s_log_ file with the unique
pathname of the file where error information from the lpd command will
be logged.

Here’s an example of a printcap entry:

Example

GarysLW|[LaserWriter_12_640_PS]:\

:lp=:mx#0:rm=LaserWriterFloor2:\

:rp=GarysLW:\

:sd=/usr/spool/lpd/GarysLW:\

:lf=/usr/spool/lpd/printerlog

6 Create and set the privileges for the spool directory specified in step 5:

mkdir path_to_this_queue’s_spool_directory

Example

mkdir /usr/spool/lpd/GarysLW

chown daemon /usr/spool/lpd/GarysLW

chgrp daemon /usr/spool/lpd/GarysLW

chmod 775 /usr/spool/lpd/GarysLW
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7 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.

8 Try printing by using this command:

lpr -Pqueue_name     filename

Note that there’s no space between -P and queue_name.

Example

lpr -PGarysLW file.postscript

If everything is working, the pages will print. If there’s a problem, see the
troubleshooting suggestions in Chapter 12.

Configuring HP-UX version 8.07

1 Log in to the system console as root.

The System Administration Manager (SAM) uses a screen-oriented interface
that works best at the console.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run the SAM utility by typing sam at the UNIX prompt.
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5 Select the following options, in order, from the SAM menu:

Peripheral devices

Printers and Plotters

Actions

Add a Remote Printer (Do not select “Add a Network Printer.”)

A form appears for you to define a remote printer.

6 Enter information into the remote printer form, as follows:

m Printer name Type the local queue name users will use as the name for
the printer.

m Remote system name Type the IP name assigned to the printer as described
in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Remote printer name Type raw

m Remote cancel model Used for remote printer job removal; type rcmodel

m Remote status model Used for remote printer queue status; type rsmodel

m Make this the system default printer? (y or n) Type y to make this printer the
default printer for all workstations on this segment of the network.

m Printer class Optional

m Restrict cancel Optional

m Remote printer on a BSD system? (y or n) Because this printer is a Berkeley-
style remote printer, type y

7 Choose Perform Task from the SAM menu.

8 To enable the print queue you just created, choose the following items from the SAM
menu, in order:

Peripheral Devices

Printers and Plotters

Enable a Printer

9 When SAM asks for the printer name, type the IP name assigned to the printer as
described in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

10 Leave SAM.
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11 Start the LP request scheduler by typing

/usr/lib/lpsched

12 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.

13 Test printing with the following command:

lp -d queue_name     filename

If the test print doesn’t work

If the test document doesn’t print, follow these steps:

1 Check whether the rlp daemon is running. At the UNIX prompt, type

ps -e | grep rlp

If the process is running, you will see one or more lines of text; if it is not
running, you will see no response.

2 If rlp is running—that is, you saw one or more lines of text in step 1—kill the process
by typing

kill -15 process_number_ from_step_1

3 Make sure the following entry is in the /etc/inetd.conf file:

printer stream tcp nowait root

/usr/lib/rlpdaemon rlpdaemon -i

This line tells inetd to start the rlp daemon automatically when a print
request is made (if it’s not already running).
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4 Make sure the following entry is in the /etc/services file:

printer 515/tcp spooler

5 Start inetd by typing the following command at the UNIX prompt:

/etc/inetd -c

6 Repeat the steps in “Configuring HP-UX Version 8.07.”

Configuring HP-UX version 9.x

You must configure the printer as a remote printer, not as a network printer.

1 Log in to the system console as root.

The System Administration Manager (SAM) uses a screen-oriented interface
that works best at the console.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run the SAM utility by typing sam at the UNIX prompt.

5 Select the following options, in order, from the SAM menu:

Printers and Plotters

Printers/Plotters

Actions

Add a Remote Printer/Plotter (Do not select “Add a Network
Printer.”)

A form appears for you to define a remote printer.

6 Enter information into the remote printer form as follows:

m Printer name Type the local queue name users will use as the name for
the printer.

m Remote system name Type the IP name assigned to the printer as described
in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Remote printer name Type raw



m Remote cancel model Used for remote printer job removal; type rcmodel

m Remote status model Used for remote printer queue status; type rsmodel

m Printer class Optional

m Make this the system default printer? Check the box to make this printer the
default printer for all workstations on this segment of the network.

m Allow anyone to cancel requests Check this box if anyone should be able to
cancel requests.

m Remote printer on a BSD system? Because this printer is a Berkeley-style
remote printer, check this box.

7 Select the OK button.

A message appears asking you whether you want to add the printer to the
Printer’s subpanel.

8 Click Yes or No.

9 Click OK.

10 Choose Exit from the File menu.

11 Click the Exit SAM button.

12 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.

13 Test printing with the following command:

lp -d queue_name     filename
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If the test print doesn’t work

If the test document doesn’t print, check the configuration by following
these steps:

1 Check whether the rlp daemon is running. At the UNIX prompt, type

ps -e | grep rlp

If the process is running, you will see one or more lines of text; it it is not
running, you will see no response.

2 If rlp is running—that is, you saw one or more lines of text in step 1—kill the process
by typing

kill -15 process_number_ from_step_1

3 Make sure the following entry is in the /etc/inetd.conf file:

printer stream tcp nowait root /usr/lib/rlpdaemon

rlpdaemon -i

This line tells inetd to start the rlp daemon automatically when a print
request is made (if it’s not already running).

4 Make sure the following entry is in the /etc/services file:

printer 515/tcp spooler

5 Start inetd by typing the following command at the UNIX prompt:

/etc/inetd -c

6 Repeat the steps in “Configuring HP-UX Version 9.x.”

Configuring SCO UNIX

To configure Santa Cruz Operation (SCO) version 1.2 or later of UNIX,
follow these steps:

1 Log in to the SCO machine as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.
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4 At the UNIX prompt, type

mkdev rlp

5 When the mkdev program asks if you want to install or remove remote line printing,
choose install even if it is already installed.

6 If remote line printing is already installed, the program will ask if you want to continue
installing the system. Answer “no” and skip to step 10.

7 If remote line printing is not already installed, the program will ask if you wish to change
the /etc/printcap file. Answer “no.” 

8 The program then asks if you want to run /etc/rlpconf. Answer “no.” 

9 When asked if you want to start the remote daemon, answer “yes.”

You return to the UNIX prompt.

10 Add the following entry to the /etc/printcap file.

printer_queue_name|[description_of_printer]:\

:lp=:mx#0:rm=printer_IP_name:\

:rp=printer_queue_name:\

:sd=path_to_this_queue’s_spool_directory:\

:lf=path_to_this_queue’s_log_ file:

Fill in the parameters in italics as follows:

m Replace printer_queue_name with the name the user should use to
reference the printer.

m Replace description_of_printer with a comment describing the printer.

m Replace printer_IP_name with the IP name you assigned to the printer in
“Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Replace path_to_this_queue’s_spool_directory with the pathname of the
unique directory created for this queue.

m Optionally replace path_to_this_queue’s_log_ file with the unique pathname
of the file where error information from the lpd command will be
logged.
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11 Create the spool directory that you specified in step 10:

mkdir path_to_this_queue’s_spool_directory

12 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.

13 Test printing with the following command:

lp -d queue_name     filename

Configuring IBM AIX version 3.x

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and address are entered in the /etc/hosts file.

4 At the UNIX prompt, type the following to run the SMIT utility:

smit

5 To add a remote queue, choose the following items from the SMIT menu:

Print System Management

Add a Print Queue

Remote

Standard Processing

A form appears for you to define a remote printer.
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6 Enter information into the remote printer form, as follows:

m Name of queue to add Type the local queue name users will use as the name
for the printer.

m Host name of remote server Type the printer IP name assigned to the printer
as described in “Step 3:  Assigning an IP Address to the Printer,” earlier in
this chapter.

m Name of queue on remote printer Type raw

m Type of print spooler or remote server Select BSD.

7 Click Do.

8 Click Done.

9 Choose Exit from the Exit menu.

10 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.

11 Try printing by using this command:

lpr -Pqueue_name     filename

Note that there’s no space between -P and queue_name.
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Configuring Silicon Graphics IRIX

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter.

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 In the Printer Manager, choose Add from the Printer menu.

5 Enter the queue name that you want to use in the Printer Name field.

6 Choose Network connection type.

7 Enter the printer’s IP name in the Remote Host Name field.

8 Click Apply.

9 Exit the Printer Manager and test the installation by printing a file.

Configuring the printer

Though the printer itself has no control panel, you can configure it by using
programs on computers connected to the printer:

m On Mac OS–based computers, use the Apple Printer Utility and the
Chooser’s setup function, described in Appendix A.

m On Windows-based computers, use the Apple Printer Utility for Windows,
described in Appendix A.

95Set t ing Up the Pr in ter  for  UNIX Users



Changing the communication settings

The LaserWriter 12/640 PS default communication setting for the TCP/IP
interface is PostScript. If the printer is to be used for PostScript and PCL5
(text) files, you must change the communication setting to AutoSelect, which
turns on automatic language sensing. Automatic language sensing allows the
printer to receive information over the network and determine which page-
description language is required.

Use the printer utility (Mac OS or Windows) to change the communication
setting to AutoSelect. If there are no Mac OS–based computers or 
Windows-based computers on your network, you can download a file to the
printer that changes the communication setting to AutoSelect.

Set up your printer for UNIX users as described in this chapter before
changing the communication setting.

1 Set the communication switch on the printer to the Normal (in) position.

2 Using a text editor, create a file with the following contents:

%!PS

(%LPR_NV%) <</Interpreter /AutoSelect >> setdevparams

3 Download the file to the printer.

For example:

lpr filename

4 Turn the printer off and back on again.

5 Examine the startup page to make sure the TCP/IP port is set to AutoSelect.

To restore the TCP/IP interface to PostScript:

1 Set the communication switch on the printer to the Reset (out) position.

2 Turn the printer off and back on again.

3 Set the communication switch on the printer to the Normal (in) position.

96 Chapter  4



What to do next

The printer is now set up on your network.

You don’t need any special software to use the printer. On most UNIX
systems, you use either the lpr or lp command to print documents over a
TCP/IP network to the printer.

Your printer administrator will generally set up two print queues for the
printer—one to print text files (which must have a carriage return appended
to the end of each line) and the other to print all other files, including
PostScript and PCL files. The names of the print queues typically reflect
which sort of document they’re for.

Examples for lpr

lpr -PGarysLW_text plain.txt

lpr -PGarysLW_raw postscript.file

Examples for lp

lp -d GarysLW_text plain.txt

lp -d GarysLW_text postscript.file

The way you print and choose printing options can differ from one
application program to another. To find out more about printing from your
application programs, read the documentation that came with the programs.

IMPORTANT See the onscreen user’s manual for information on how to use
your Apple LaserWriter 12/640 PS printer. The file is in Adobe Portable
Document Format (PDF). To read or print the documentation, you use the
Acrobat Reader software on the CD-ROM disc. The PDF file is located at
MAC_OS:Monochrome LaserWriter:LW12/640UM.pdf and
WIN_OS\MONO_LSR\LW12/640U.pdf on the CD-ROM disc.
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The LaserWriter 12/640 PS has several user-installable printer options.
You can add a duplex printing unit, a 500-sheet cassette and feeder, an
envelope cassette (the envelope cassette fits into the 500-sheet feeder), and
a face-up output tray. You can also increase the printer’s random-access
memory (RAM).

This chapter provides instructions for installing your paper-handling
options and increasing RAM.

WARNING When installing any of the options described in this chapter,
except for the face-up output tray, be sure the printer is turned off.
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Many of the installation procedures describe working with the printer’s left
and right sides and front and rear, as shown in the following illustration.

Installing the duplex printing unit

With the optional duplex printing unit, you can print on both sides of the
paper (often called duplex printing or two-sided printing). You can only
duplex print from the paper cassettes. You cannot duplex print from the
multipurpose tray.

Note: The duplex printing unit requires a minimum of 12 MB memory in the
printer. For instructions on adding printer RAM, see “Increasing the Printer
RAM,” later in this chapter.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

Front side Right side

Rear side (ports)Left side (has removable cover)



Follow these instructions for installing the LaserWriter 12/640 PS duplex
printing unit.

Before you install the duplex printing unit:

m The printer must be turned off and the power cord unplugged.

m The printer must be disconnected from your computer or network.

The duplex printing unit adds approximately 2 inches to the height and
4 inches to the depth of the LaserWriter 12/640 PS. Begin by selecting a
location for the LaserWriter 12/640 PS that provides enough room to
accommodate the increased height and depth of the printer.

If you intend to keep the printer in its current location, make sure that
adequate room will be available for opening the top cover and the duplex
printing unit door, and maintaining the printer. You will also need to
temporarily move the LaserWriter 12/640 PS from its current location to
place the duplex printing unit in its place. When moving the printer, be sure
to place it on a strong, flat, and, stable surface that can support its weight.

IMPORTANT You must remove the optional 500-sheet cassette and feeder from
the LaserWriter 12/640 PS if it is already attached. The duplex printing unit
must be installed between the LaserWriter 12/640 PS and the 500-sheet
cassette and feeder. For instructions on removing the 500-sheet cassette
and feeder, see “Removing the 500-sheet Cassette and Feeder” later in
this chapter.

1 Turn off and unplug the printer, and disconnect the network cables.

2 Unpack the duplex printing unit and remove any packing materials. Set aside the small
package of items.
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3 Lift up the back end of the duplex printing unit and slide the metal brace onto the post.

The brace is located on the left side of the duplex printing unit near the back.

4 Unpack the duplex printing unit key.

5 Remove the three covers located in the back of the printer. Remove the two top covers
by inserting the key into the side of the covers and pushing gently on the key (the covers
will snap off). Remove the bottom cover by inserting the key into the bottom side of the
cover and pushing downward (you may need to use some force to remove this cover).

Insert the key
into these slots.

2 Attach this brace

1 Raise the door.

to the post.
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IMPORTANT Be careful when removing the covers so that they do not fall
inside the LaserWriter 12/640 PS.

6 Place the bottom cover and the duplex printing unit key in a safe place in case you need
them in the future.

If you decide to remove the duplex printing unit, use the cover to prevent dust
and other material from getting inside the printer.

7 Place the duplex printing unit where you want the LaserWriter 12/640 PS to be located.

Orient the duplex printing unit so that its tray and the printer’s multipurpose
tray and paper cassette will be on the same side when the printer is attached.

8 Insert the paper guide for the duplex printing unit into the opening in back of the printer.

Hint: There are two tabs on the bottom of the paper guide that fit into slots in
the back of the printer. When inserting the paper guide, slide it back and forth
to easily locate these slots.

The paper guide helps direct the paper to the duplex printing unit.
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9 Insert the locking connectors into the slots located on the bottom of the paper guide and
push the connectors until they snap into place.

The locking connectors secure the paper guide to the printer.
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10 Lift the LaserWriter 12/640 PS, position it directly over the duplex printing unit and gently
lower the printer until it sits evenly on the duplex printing unit.

As you lower the printer, align the corners of the printer directly over those of
the duplex printing unit.

Position the printer
over these three posts.



11 Remove the cassette from the printer and the tray from the duplex printing unit.

12 Insert the four locking connectors into the slots located on the front and back of the
printer and duplex printing unit.

The locking connectors secure the printer to the duplex printing unit.
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13 Insert the cassette into the printer and the tray into the duplex printing unit.

14 Gently close the duplex printing unit door until it latches into place against the printer. If
the door does not close easily, check to make sure the brace is not locked in place.

15 Reconnect the power cable to the printer and reconnect the printer to the network, then
turn on the printer.

16 Configure your printer to use the duplex printing unit.

For configuration instructions, see “Configuring Your Printer Software for
New Options,” later in this chapter.

For information about printing options,

m see Chapter 6 if you are using the Mac OS

m see Chapter 7 if you are using Windows 3.1 or DOS

m see Chapter 8 if you are using Windows 95
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Installing the 500-sheet cassette and feeder

Follow these instructions for installing the 500-sheet cassette and feeder.
For instructions on loading the feeder with paper, see “Filling the Optional
500-Sheet Cassette” in Chapter 9.

Before you install the 500-sheet feeder:

m The printer must be turned off and the power cord unplugged.

m The printer must be disconnected from your computer or network.

The cassette base adds approximately 5 inches to the height of the
LaserWriter 12/640 PS. Begin by selecting a location for the LaserWriter
12/640 PS that provides enough room to accommodate the increased height
of the printer.

If you intend to keep the printer in its current location, make sure that
adequate room will be available for opening the top cover, loading paper, and
maintaining the printer. You will also need to temporarily move the
LaserWriter 12/640 PS from its current location to place the cassette base in
its place. When moving the printer, be sure to place it on a strong, stable
surface that can support its weight.

IMPORTANT If you purchased the optional duplex printing unit, follow the
instructions outlined below. The procedure is the same, but the 500-sheet
cassette and feeder is installed under the duplex printing unit.

1 Turn off and unplug the printer, and disconnect the network cables.

2 Unpack the 500-sheet cassette and feeder and remove any packing materials within the
base and paper cassette.

500-sheet cassette
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3 Place the 500-sheet cassette and feeder where you want the LaserWriter 12/640 PS to 
be located.

Orient the 500-sheet cassette and feeder so that its paper cassette and the
printer’s multipurpose tray and paper cassette will be on the same side when
the printer is attached.

4 Lift the LaserWriter 12/640 PS, position it directly over the 500-sheet cassette and feeder,
and gently lower the printer until it sits evenly on the cassette base. 

Position the printer
over these three posts.

109Insta l l ing Opt ions



5 Remove the cassettes from the printer and the 500-sheet cassette and feeder.

6 Insert the four locking connectors into the slots located on the front and back of the
printer and base.

The locking connectors secure the printer to the feeder.
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7 Insert the cassettes into the printer and the 500-sheet cassette and feeder.

8 Turn on the printer.

9 Configure your printer software to use the 500-sheet cassette and feeder. 

Next you must configure the printer software to use the new paper option. For
configuration instructions, see “Configuring Your Printer Software for New
Options,” later in this chapter.

For instructions on loading paper into the envelope cassette, see Chapter 9.
For information about printing options,

m see Chapter 6 if you are using the Mac OS

m see Chapter 7 if you are using Windows 3.1 or DOS

m see Chapter 8 if you are using Windows 95

Removing the 500-sheet cassette and feeder

1 Remove the cassettes from the printer and the 500-sheet cassette and feeder.

2 Remove the four locking connectors by pinching the top and bottom of the connectors.
The connectors are located on the front and back sides of the printer and the 500-sheet
cassette and feeder.

3 Gently lift the printer from the 500-sheet cassette and feeder and place it on a flat and
stable surface.

4 Configure your printer software to remove the 500-sheet cassette and feeder.
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Installing the envelope cassette

IMPORTANT The LaserWriter 12/640 PS envelope cassette fits into the
500-sheet feeder. For instructions on installing the optional 500-sheet
cassette and feeder, see “Installing the 500-Sheet Cassette and Feeder,”
earlier in this chapter.

1 Unpack the envelope cassette and remove all packing materials.

2 Remove the 500-sheet cassette and insert the envelope cassette.

3 Configure your printer software to use the envelope feeder. 

For configuration instructions, see “Configuring Your Printer Software for
New Options,” later in this chapter.

For instructions for loading paper into the envelope cassette, see Chapter 9.
For information about printing options,

m see Chapter 6 if you are using the Mac OS

m see Chapter 7 if you are using Windows 3.1 or DOS

m see Chapter 8 if you are using Windows 95

Envelope cassette 500-sheet feeder
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Installing the face-up output tray

Follow these instructions to install the LaserWriter 12/640 PS face-up output
tray. You can install the face-up tray onto the back of the printer or the duplex
printing unit.

1 Unpack the face-up output tray and remove all packing materials.

2 Line up the tabs on the bottom edge of the face-up output tray with the holes in the back
of the printer.

3 Gently push down on the face-up output tray to insert the tabs into their receiving slots.

4 Slide out the tray until it locks into place.
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5 Extend the tray.

Installing the face-up output tray on the optional duplex printing unit

1 Line up the tabs on the bottom edge of the face-up output tray with the holes in the back
of the duplex printing unit.

2 Gently push down on the face-up output tray to insert the tabs into their receiving slots.
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3 Slide out the tray until it locks into place.

4 Extend the tray.
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Removing the face-up output tray

1 Slide in the tray.

2 Gently pull up on the face-up output tray (to remove the tabs from their receiving slots)
and then out.

Increasing the printer RAM

You can increase the memory size of the LaserWriter 12/640 PS. You can
install up to 64 megabytes (MB) of random-access memory (RAM) in the
printer to provide faster performance on complex documents, documents
containing many fonts, and duplex printing. You can also enable the printer’s
PhotoGrade feature, which provides enhanced printing of graphics, by
increasing the printer’s memory to 12 MB of RAM or more.

Adding RAM allows more fonts to be downloaded to the printer at one time;
provides more space to store the calculations needed for large or complex
images; increases the space available for font caching, or maintaining recently
used fonts in memory for faster access the next time they are needed; and
enables duplex printing.

IMPORTANT The instructions provided here explain how to install added
memory in your printer yourself. If you wish, you can also contact an Apple-
authorized dealer to install more memory for a service fee.

You can purchase additional RAM for the LaserWriter 12/640 PS in units 
of 4, 8, 16, and 32 MB. You can purchase 4 MB RAM expansion kits from
Apple-authorized dealers. You can also purchase RAM expansion kits from
many electronics and computer outlets. For information about the RAM
specifications required to expand your printer’s memory, see Appendix D.

IMPORTANT The RAM used in the LaserWriter 12/640 PS is not the same
type of RAM used in earlier LaserWriter II printers. The two are not
interchangeable.
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Installing RAM

Your printer comes with 4 MB of RAM installed in Bank A/B.

The table below lists RAM configurations you can use.

Amount of memory (megabytes) Bank C/D (left slot) Bank A/B (right slot)

4 MB 0 MB 4 MB

8 MB 4 MB 4 MB

8 MB 0 MB 8 MB

12 MB 4 MB 8 MB

12 MB 8 MB 4 MB

16 MB 8 MB 8 MB

16 MB 0 MB 16 MB

20 MB 4 MB 16 MB

24 MB 8 MB 16 MB

32 MB 16 MB 16 MB

32 MB 0 MB 32 MB

36 MB 4 MB 32 MB

40 MB 8 MB 32 MB

48 MB 16 MB 32 MB

48 MB 32 MB 16 MB

64 MB 32 MB 32 MB

WARNING Refrain from handling the memory until you have put on 
a grounding wrist strap. Handling the memory without wearing a
grounding strap may allow static electricity to be discharged into
the memory and damage it. If your memory kit didn’t come with a
grounding wrist strap, you can purchase one from a computer dealer.
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IMPORTANT Other possible configurations may produce diagnostic errors
when the printer starts up or may produce unexpected results.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

Removing the printer’s side cover

1 If necessary, turn the printer so that the left side is accessible.

2 Locate the two Phillips screws on the back of the printer.

3 Unscrew and remove the screws. Put them in a safe place.

Remove both
of the Phillips screws.

WARNING Make sure the printer is turned off.
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4 Open the top cover of the printer.

5 Remove the paper cassette.

6 Grasp the top and front parts of the side cover and pry gently to free the tabs from their
receiving slots.

7 Pull the side cover off.

Lift the edges of the side cover up
and out, then pull the cover off. 
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Putting on the grounding strap

IMPORTANT Be sure to put on the grounding wrist strap before handling the
SIMM or any internal printer parts. The strap grounds you to the printer,
preventing any static discharge that might harm the SIMM or printer. Wearing
the strap cannot harm you. Follow these steps:

1 Wrap the end of the strap that does not have copper foil on it around your wrist. 
The strap’s light adhesive coating keeps it attached to your wrist, while allowing for 
easy removal.

2 Remove the backing from the piece of copper foil at the other end of the strap.

3 Attach the copper-foil end of the strap to the metal lip on the inside of the printer by
pressing the adhesive backing against the metal.

Copper-foil end

Metal lip
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Installing SIMMs

The printer’s circuit board has two SIMM slots, marked BANK C/D (on the
left) and BANK A/B (on the right), for installing additional memory. RAM
is provided on SIMMs (Single Inline Memory Modules) that you insert into
the slots.

Depending on the amount of memory you’re installing, you may need to
install one or two SIMMs, and perhaps remove a SIMM from a slot in order
to insert one that has more memory. For example, when installing 20 MB of
RAM, you must remove the 4 MB SIMM from bank A/B and reinstall it in
bank C/D.

When removing SIMMs, always begin by removing the SIMM in bank A/B
first. Removing a SIMM in the C/D slot first can be difficult because of the
proximity of the slots.

When installing SIMMs, always begin by installing the SIMM in bank C/D
first. Installing a SIMM in the A/B slot first can make installing a second
SIMM in bank C/D difficult because of the proximity of the slots.

Bank C/D

Bank A/B
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1 Insert the SIMM into the connector and press the SIMM down at an angle until the
retaining clips on each end of the connector snap and fasten the SIMM in place.

Hold the SIMM vertically over the slot, aligning the connectors and notches
with the circuit board’s connector. Notice that one edge of the SIMM has a
distinctive notch that you can use to judge the orientation and alignment of
the SIMM with the connector. This notch, on the bottom edge of the SIMM,
should be down as you install the SIMM.

To remove a SIMM, carefully spread the retaining clips at both ends of the
installed SIMM, then rotate the SIMM forward until it can be pulled free of
the slot.

WARNING When installing a SIMM, avoid touching the printer’s circuit
board with hands or tools to avoid damaging or scratching the printed
circuits.

Insert the card
straight in.

Gently angle
the card back.

Snap the card
into the retain-
ing clips.

Notch
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2 Repeat step 1 to install the second SIMM if necessary.

You’ve now installed the expanded memory. You need only replace the side
cover to complete the installation.

3 Remove and discard the grounding wrist strap.

Replacing the side cover

After installing the memory, you then replace the side cover on the printer
and fasten it with the Phillips screws that you removed earlier.

To replace the cover on the printer, follow these steps.

1 Line up the front edge of the side cover with the front edge of the printer.

2 Gently press the cover into the printer until the tabs snap into their receiving slots.

Check the Phillips screw holes on the back of the printer. The holes should
be unobstructed. (You shouldn’t replace the Phillips screws until the side
cover is properly positioned.)

If the hole is obstructed, remove the side cover and try again. It may take a
few tries.

Place the cover back on the printer 
and press firmly until it snaps into place.
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3 With the back cover properly positioned, replace the Phillips screws. Do not 
overtighten the screws.

4 Next, configure the printer software to use the additional memory.

For configuration instructions, see “Configuring Your Printer Software for
New Options,” next.

If you want to check that you have properly installed the additional printer
memory, turn the printer back on and check the startup page. The amount of
printer memory should be listed there.

The printer does self-diagnostic tests each time it is turned on. During this
testing, the printer verifies the amount of memory installed. If the diagnostics
test determines that the installation is not correct, the Paper Out and the
Paper Jam lights will flash alternately. Check that you have installed the
SIMMs properly in the correct slots. If this does not resolve the problem,
contact an Apple-authorized dealer.

Configuring your printer software for new options

After installing more memory or paper options, the administrator or the user
needs to update the printer software on each computer connected to the
network. You can reconfigure the printer software using the Chooser on 
Mac OS–based computers or the Windows Setup dialog box on 
Windows-based computers.
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Configuring the printer from a Mac OS–based computer

From the desktop printer icon

1 Select the desktop printer icon for the LaserWriter 12/640 PS printer.

2 Choose Change Setup from the Printing menu.

The LaserWriter Setup dialog box appears.

3 Click Auto Setup.

4 Click OK.

From the Chooser

If no desktop printer icon exists for the LaserWriter 12/640 PS printer, you
must configure your printer using the Chooser.

1 Choose the Chooser from the Apple (K) menu.

The Chooser dialog box appears.

2 Click the LaserWriter 8 icon.

3 Click a zone name to select the zone of the LaserWriter 12/640 PS, if your network has
zones. If your network doesn’t have zones, skip to step 4.
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4 Double-click the LaserWriter 12/640 PS printer name.

The printer software automatically checks the printer’s options and selects the
correct settings.

5 Close the Chooser.

Designating the 500-sheet cassette and feeder as the preferred paper source

After installing a 500-sheet feeder, you can specify that the printer use the
500-sheet feeder as the preferred paper source. When you choose Auto Select
as the paper source in the Mac OS Print dialog box, the printer will draw
paper from the 500-sheet feeder if it holds the appropriate size paper. To
designate the 500-sheet feeder as the preferred source, you must manually
configure the printer software.

1 Select the desktop printer icon for the LaserWriter 12/640 PS printer.

2 Choose Change Setup from the Printing menu.

The LaserWriter Setup dialog box appears.

3 Click Auto Setup.

4 Select “Cassette (Optional)” from the Change pop-up menu.

5 Select “Installed and Preferred” from the To pop-up menu.

6 Click OK.
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Configuring the printer from a Windows 3.1–based computer

1 From the Program Manager, double-click the Print Manager icon to display the 
Print Manager. 

2 Select the LaserWriter12/640 PS printer from the list of Printers. 

3 Choose the Setup command from the Options menu to display the Setup dialog box for
your printer.

The Setup dialog box contains buttons that display other dialog boxes
containing additional printer settings.

4 Click the Features button.

The Features dialog box appears.

5 Set controls in this dialog box to set up the optional features that you have installed on
your LaserWriter 12/640 PS.

6 Click OK to close the Features dialog box.

7 Click OK to close the Setup dialog box.

Configuring the printer from a Windows 95–based computer

1 From the Task-Bar, click Start and then select Printers from Settings.

2 Click the printer icon for the printer on which you want to update the software.

3 Choose Properties from the File menu.

4 Click the Device Options panel.

5 Set controls in the panel for the optional features that you have installed on your
LaserWriter 12/640 PS.

6 Click OK to close the Properties dialog box.
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6 Mac OS Users

The LaserWriter 12/640 PS comes with software and fonts for use with
Mac OS–based computers. This chapter describes the standard printing and
page setup options of the LaserWriter 8 printer driver and the desktop printer
software supplied with your printer.

Printing

On a Mac OS–based computer, printing functions are controlled through the
Page Setup and Print dialog boxes, which are accessed through the File menu.

Most Mac OS application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)

The default settings the printer uses for all documents can be changed with
the Apple Printer Utility. For more information about the Apple Printer
Utility, see Appendix A.



Selecting page setup options

The Page Setup dialog box allows you to specify certain aspects of your
document, such as its page size, format, and orientation, as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document it will closely resemble its final printed form.

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.

m Select US Letter Small or US Legal Small to prevent pagination
differences when printing to different printers. These paper sizes have the
same physical size as US Letter and US Legal, but have larger margins.
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Click here to see a
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selected dimensions.
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Use this pop-up menu
to identify the printer
you want to use.

To see a dialog box that lets you select
enhancements to the printed image, choose
PostScript Options from this pop-up menu.

Use this pop-up menu
to identify the paper
size you are using.

When the selections
are set the way you
want, click OK.
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3 To print using special effects, choose PostScript Options from the Page Setup pop-up
menu. (If you don’t want to choose print options, skip to step 4.)

The PostScript Options dialog box appears.

m Select Flip Horizontal to flip the page image horizontally.

m Select Flip Vertical to flip the page image vertically.

m Select Invert Image to print a black-and-white reversed image.

m Select Substitute Fonts to substitute the fonts Helvetica, Times, and Courier
for the Mac OS screen fonts Geneva, New York, and Monaco, respectively.
The substitution occurs even if TrueType outline fonts are available for
Geneva, New York, and Monaco. Text sizes in the printed document are
scaled to compensate for size differences between the corresponding
families of screen and printer fonts.

m Select Smooth Text to smooth edges of letters when your printer is printing
fonts as bitmapped fonts.

m Select Smooth Graphics to smooth ragged edges of lines in bitmapped
graphics.

m Select Precision Bitmap Alignment to make printed bitmapped graphics
more precisely match the screen image.

m Select Unlimited Downloadable Fonts in a Document to print the
document using as many downloadable fonts as you need. The fonts will
be sent to the printer, used, and then removed from the printer’s memory.
The document will be printed more slowly.



4 Click OK to close the Page Setup dialog box.

You can make the printer’s current page setup settings the default software
settings by holding down the Option key and clicking OK. (Some programs
may not support this method of setting defaults.)

Printing documents

When you are printing from a Mac OS–based computer, most application
programs display a Print dialog box, in which you specify print options such
as the number of copies you want printed, whether to print all or part of a
document, and which paper tray or cassette will be the paper source.

Some application programs also add more choices to the Print dialog box.
For information about such options, refer to the documentation that came
with the program.

1 Choose Print from the File menu.

The Print dialog box appears.
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2 Select the options you want.

IMPORTANT The names that appear in the paper source menus vary according
to the paper sources of your printer and paper sizes you choose in the Page
Setup dialog box.

m To have the printer automatically select the paper tray that holds the size of
paper chosen for the document, choose Auto Select as the paper source.

m You can print to other printers by selecting their name from the Printer
pop-up menu. Only printers that have desktop printer icons created with
LaserWriter 8 are listed.
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3 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

m To print a cover page, choose Cover Page from the Settings pop-up menu.

m To choose settings for printing grayscale images, choose Color Matching
from the Settings pop-up menu.

m To turn on PhotoGrade or FinePrint, choose Imaging Options from the
Settings pop-up menu.

m To duplex print and set the number of pages per sheet, choose Layout from
the Settings pop-up menu.

m To print to a file, choose File from the Destination pop-up menu and
choose Save as File from the Settings pop-up menu.

m To set background printing, choose Background Printing from the Settings
pop-up menu.

m To set the output paper path, choose Printer Options from the Settings
pop-up menu.

m To set program-specific options (such as page order), choose the program’s
name from the Settings pop-up menu.

Printing a cover page automatically

The LaserWriter 8 printing software can automatically print a cover page that
provides information about the printed document, such as the document’s
name and the date and time of printing. You can set the printer to print the
cover page at the beginning or the end of the document.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Select the options you want.
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3 Select Cover Page from the pop-up menu.

The cover page options dialog box appears.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.

Printing grayscale documents

When you print a document containing shades of gray, you can choose to
maximize either image quality or speed.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Color Matching from the Settings pop-up menu.

The Color Matching dialog box appears.

To use your settings as the default
settings, click Save Settings.

For a cover page
that appears at

the front or at the
end of the

document, click
Before Document or

After Document.

To print the document
without a cover page,
click None.

To define a different paper source
for the cover page, choose one
from the pop-up menu.



3 Make the selection you want.

m For the fastest printing, choose Black and White. (The image quality won’t
be as good, especially if the original image is in color or grayscale.)

m When printing grays, you will see the best results if you choose
Color/Grayscale.

m The ColorSync Color Matching and PostScript Color Matching options are
used only when printing to a color printer. The LaserWriter 12/640 PS is
not a color printer.

4 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Printing with FinePrint or PhotoGrade

FinePrint smoothes out lines and curves and enhances text and line graphics
that would normally appear jagged. For documents that require the finest
quality text that the printer can produce, turn FinePrint on.

PhotoGrade enhances the printed look of images, such as scanned or digital
photographs, to produce added clarity, finer shading, and better contrast. For
documents that require images to be printed with the best quality that the
printer can produce, turn PhotoGrade on. For documents that contain both
text and high-quality images, turn PhotoGrade on and FinePrint off.
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Having both FinePrint and PhotoGrade on can affect how images print. For
documents that have many images and require high-quality reproduction,
you may want to turn FinePrint off. To determine the effect of printing
using FinePrint and PhotoGrade, you can print portions of a document
with FinePrint and PhotoGrade turned on or off to see the differences in
printed output.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB
duplex printing option

Turn on PhotoGrade and duplex 20 MB
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB
print on all size paper (including legal)

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Imaging Options from the Settings pop-up menu.

The Imaging Options dialog box appears.

3 Make the selection you want.
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4 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Printing on both sides of the paper

With the optional duplex printing unit, you can print on both sides of the
paper (often called duplex printing or two-sided printing). You can only duplex
print from the paper cassettes.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB
duplex printing option

Turn on PhotoGrade and duplex 20 MB
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB
print on all size paper (including legal)

Note: You cannot duplex print from the multipurpose tray. You cannot print
to the face-up output tray when duplex printing.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Layout from the Settings pop-up menu.

The Layout dialog box appears.

138 Chapter  6



3 Make the selections you want.

m Binding determines how pages are printed when you are printing on both
sides of the paper. If you want the binding orientation along the side of the
paper (like in a book or magazine), click the left binding button. If you
want the binding orientation along the bottom of the paper (such as in a
calendar), click the right binding button.

4 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Printing to a file

You can save your document as a PostScript file or an EPS file.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose File from the Destination pop-up menu.

3 Choose PostScript Printer Options from the Settings pop-up menu.

The PostScript Printer Options dialog box appears.
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4 Make the selections you want.

5 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Background printing and setting the print time

With background printing turned on, you can use your computer for other
work while you’re printing. Once background printing is turned on, it is in
effect whenever you print, until you turn it off. When you click Print in the
Print dialog box, a message appears for a moment to tell you the document is
being prepared. Once the message disappears, you can continue other work.
Your computer may pause occasionally while it processes the document
for printing.

When foreground printing is turned on, you must wait until the document has
finished printing before you can use your computer for other work. However,
your document may be sent to the printer faster when foreground printing is
turned on.

You can also specify when your document should be printed in relationship to
other documents that are also being printed.

1 Choose Print from the File menu.

The Print dialog box appears.
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2 Choose Background Printing from the Settings pop-up menu.

The Background Printing dialog box appears.

3 Make the selections you want.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.

Selecting the output tray

You can specify where the printed pages exit the printer. Use face-up output
to reduce curl and wrinkles. This is useful for envelopes, transparencies,
labels, and other heavy stock paper.

You can use face-up output with or without the optional face-up output tray.
However, the face-up output tray stacks the papers neatly in a tray instead of
on the surface where the printer is located.

Note: You cannot direct the output to face-up when duplex printing. You
cannot direct U.S. legal-size paper to the face-up output.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Printer Options from the Settings pop-up menu.

The Printer Options dialog box appears.
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3 Choose an option.

4 When the selection is as you want, choose another setting from the Settings pop-up
menu, or click Print.

Reporting errors

You can specify what happens when a PostScript error occurs or when the
paper cassette runs out of paper. For PostScript errors, you can have the
printer provide no reporting, provide a summary of the print error on your
computer screen (when using foreground printing), or print a page reporting
the error. When the printer is out of paper, you can have the printer use
another cassette with the same paper size or display an alert message.

If you select “Switch to another cassette with same paper size,” the printer
will get paper from its input trays in the following order: standard cassette,
multipurpose tray, optional 500-cassette, optional envelope cassette.

IMPORTANT If you have the same size paper in your paper cassettes and
multipurpose tray and have tray switching turned on, the printer may draw
paper from any paper source that has the correct size paper (even if you
select a specific paper source from the Print dialog box). If you want to print
from a specific paper source only, do not select “Switch to another cassette
with same paper size.”



1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Error Handling from the Settings pop-up menu.

The Error Handling dialog box appears.

3 Make the selections you want.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.
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Printing with a desktop printer

You can also print documents without leaving the Finder, using one of the two
methods described here. These methods are particularly efficient when you
have a number of documents from the same application that you want to print
at once.

m Drag the icons of the documents (from one application) to the desktop icon
of the printer you want to use.

or

m Select the icons of the documents you want to print and choose the Print
command from the File menu. The documents will be printed on the
default printer. (See “Switching Between Printers,” next.)

In either case, the computer will show you the Print dialog box so you can
choose printing options. Make your choices, then click the Print button.

After a few moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See
“Monitoring Printing,” later in this chapter.)
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Switching between printers

If you have more than one printer available, you can select which you want to
use. The printer you select is called the default printer. All your documents
will be printed on the default printer until you select a new one.

To change the default printer, use one of these four methods, as described in
the next sections.

m Drag the document you want to print to a desktop printer icon, and it will
automatically become the default printer.

m Select the desktop printer icon and use the Printing menu to set the printer
as the default.

m Select a new printer using the Chooser.

m Select a new printer using the Printer icon in the desktop menu.

Note: Switching between printers may change how much information you
can fit on a page. It’s best to choose a printer before you spend much time
formatting the document.

Drag the document you want to print to a desktop printer icon

Drag the icon of any document you want to print to the icon of the printer
you want to use. (See “Printing With a Desktop Printer,” earlier in this
chapter.)

Printing PostScript files as text

To print a PostScript file as text, hold down the Option key and drag the
document to the icon of the printer you want to use.
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Select the printer using its desktop printer icon

If you already have a desktop printer icon for the printer you want to use,
follow these steps to select the printer without immediately printing anything
on it:

1 Click the icon of the desktop printer you want to use.

A Printing menu appears on the menu bar at the top of the screen.

2 Choose the Set Default Printer command from the Printing menu.

Until you choose another printer, the Print command will send your
documents to this printer.

Shortcut: Select a desktop printer and press x-L to make that printer the
default printer.

Select a new printer using the Chooser

If you don’t have a desktop printer icon for the printer you want to use, you
must select the printer using the Chooser. The Chooser will then create a
desktop printer icon for the printer that you select.

1 Select the Chooser from the Apple (K) menu.

2 Select the printer that you want.

3 Click the Create button to set up the printer.

4 Close the Chooser by clicking the close box in the upper-left corner.

When you click Create, the Chooser creates a desktop printer icon for the
printer you selected.

Select a new printer from the Printer icon in the desktop menu

A printer icon is created next to the Help menu when you install the
LaserWriter software. Only printers that have desktop icons associated with
them are listed in the Printer menu. Selecting a printer from this menu makes
that printer the default printer.
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Working with desktop printer icons

To create a desktop printer, select the printer using the Chooser. After you
click Create, the icon will appear on your desktop. See “Select a New Printer
Using the Chooser” under “Switching Between Printers,” the previous section
in this chapter.

You may also do the following with desktop printer icons:

m Throw away the icon. Drag the icon to the Trash. You can’t throw away a
desktop printer icon while the printer is printing a document. (You can
create another desktop printer icon for that printer whenever you like.)
Note: You must always have at least one printer icon on your desktop. If 
you throw away the last icon, it will immediately be created again.

m Rename the icon. Rename the icon as you would any other Finder icon.
Click the name to highlight it, then type the new name. This changes the
name of the icon, not the name of the printer.

m Move the icon. You may drag the icon anywhere you like. The icon can
remain on the desktop or be placed in a folder.

m Create an alias for the icon. You may create an alias for the icon as you would
any Finder icon, by selecting the icon and choosing the Make Alias
command from the File menu. The alias may be moved anywhere on 
or off the desktop.

Determining the status of a printer by looking at its icon

You can tell the status of a printer by looking at its desktop icon:
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Monitoring printing

If you are using background printing, you can use the desktop printer features
to monitor and control the documents that are waiting to print.

1 Double-click the desktop printer icon you’re interested in.

A window opens listing the documents that are printing or waiting to print:

Watching the status messages can be helpful when troubleshooting printing
problems. When more than one job is waiting to be printed, a list of print
jobs appears in the waiting list, showing the order in which they will be
printed (when sorted by print time).

2 Choose what you’d like to do.

m To cancel a print request, select it by clicking its title or icon and click the
Remove button. You can only select the currently printing document by
clicking its title. (You can select more than one item at a time by holding
down the Shift key while clicking.) You can also drag the icon for the print
request to the Trash. Note that these methods delete only the print request
(also referred to as a spool file), not the document itself.
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Column titles (click to sort)

Document currently printing

Documents waiting to print

Select a document and click the Set Print
Time button to specify when the document
should be printed.

Select a
document and

click the Hold Job
button to put a

print request
on hold.

Select a document
that’s on hold 
and click the 

Resume Job button 
to resume printing.

Select a document and click the
Remove button to cancel the print
request.



m To put a print request on hold, select it and click the Hold button. The print
request will stay on hold until you select it again and click the Resume
button. You can also put the document that’s currently printing on hold by
dragging it to the list of documents waiting to print (lower part of the
window).

m To indicate that a print request is urgent, select it and click the Set Print Time
button. In the dialog box that opens, click Urgent. This moves the print
request to the top of your list.

m To indicate that a print request should not print until a future time, select it and
click the Set Print Time button. In the dialog box that opens, click At Time,
then set the time you want.

m To change the order of the items waiting to print, move their place in the list by
dragging their titles up or down in the list.

m To sort the list of documents waiting to print, click the title of the column you
want to sort by. For example, to sort by the name of the document, click
“Document Name.” (You can also sort by choosing the commands in the
View menu.) The column title you sorted by is underlined. Sorting the
items does not change the order in which they will print. To see that order,
sort by Print Time.

m To temporarily stop all documents from printing on this printer, choose Stop Print
Queue from the Printing menu in the Finder menu bar. To resume using the
printer, choose Start Print Queue from the Printing menu.

Shortcut: Pressing the Option-Shift keys changes the Hold Job and Resume
Job buttons to Stop Queue and Start Queue.

Shortcut: The Printing menu for starting and stopping the print queue is
available without opening the window for the printer, so long as the
printer’s icon is selected on the desktop.

m To move a print request from one printer to another printer of the same type (for
example, from a LaserWriter 12/640 PS to a LaserWriter 4/600 PS), drag
the icon for the print request to the icon of the printer where you want to
move it. You can only move a print request from a LaserWriter 12/640 PS
to another PostScript printer. The printing software won’t let you move a
print request to an incompatible printer. For example, you can’t move a
request from a LaserWriter printer to a StyleWriter printer.
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m To get information about the printer, choose Get Printer Info from the Printing
menu. Status, configuration, and font information is displayed.

m To change the printer setup (for example, when you add or remove printer
options, such as the duplex printing unit), choose Change Setup from the
Printing menu.

m To change the manual feed alerts, choose Show Manual Feed Alert from the
Printing menu. A checkmark by this command means that manual feed
alert message will appear.

Turning off or removing the desktop printing software

You can remove an individual desktop printer icon by dragging it into the
trash. If you have only one desktop printer, you can’t get rid of the icon by
dragging it to the Trash. (The icon will reappear if you do.)

Turning off the Desktop PrintMonitor

If you don’t want to use desktop printers, you can turn off the Desktop
PrintMonitor using the Extensions Manager (available on Mac OS versions
7.5 or later).

To turn off the Desktop PrintMonitor:

1 Open the Extensions Manager control panel in the Control Panels folder.

2 Click to deselect (uncheck) Desktop PrintMonitor, Desktop Printer Menu, Desktop Printer
Spooler, and Desktop Printer Extension in the panel.

3 Click the close box to close the control panel.

4 Restart your computer.
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Removing the desktop printing software

The desktop printing software uses both the Desktop PrintMonitor and the
PrintMonitor software. The Desktop PrintMonitor requires 200–400K bytes
more free system memory in addition to the memory required by the
PrintMonitor. If you don’t want to use the desktop printing software, you can
remove it. 

To remove desktop printing software:

1 Restart your computer with the extensions off by holding down the Shift key and
choosing Restart from the Special menu. Hold the Shift key down until the message
“Extensions off” appears or until your normal desktop appears.

2 Drag the following files from the Extensions folder to the Trash:

m Desktop PrintMonitor

m Desktop Printer Menu

m Desktop Printer Spooler

m Desktop Printer Extension

3 If you have Control Strip installed on your system, drag the Printer Selector file to the
Trash.

4 Restart your computer.

Making changes to the printer setup

If you turn off desktop printing and add or remove printer options, you must
set up the printer again using the Chooser.

1 Choose the Chooser from the Apple (K) menu.

The Chooser window appears.

2 Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.

3 Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.

4 Click the name of your LaserWriter 12/640 PS.
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5 Click Setup.

The Setup dialog box appears.

6 Select the option that you want.

m Click Auto Setup to let the Chooser identify the type of printer and
automatically set up the printer software.

m Click Select PPD to choose a PostScript Printer Description file for the
printer.

m Click Printer Info to view printer information such as its name, available
memory, and so on.

m Click Configure to setup options that you’ve added to the printer.

7 Click OK.

Using the Apple Printer Utility

The Apple Printer Utility program supplied with the printer software allows
the printer administrator to control various aspects of how the LaserWriter
12/640 PS works. For information about using the Apple Printer Utility, see
Appendix A.
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The LaserWriter 12/640 PS comes with software for IBM PC or compatible
computers using Windows 3.1 and Windows 95. This chapter describes how to
use the PostScript Printer Driver for Windows 3.1 and how to print from DOS.

If you are using Windows 95, see Chapter 8.
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Printing from Windows applications

After you have connected the printer to your computer and installed and set 
up the printer software, you’re ready to start printing. This section explains the
basic steps required to print a document, though the details can vary from one
program to another. To find out more about printing from your programs,
read the documentation that came with them. If you have Windows NT, print
using the TCP/IP protocol or using AppleTalk protocol. See your Windows
NT manual for information on configuring.

To print a document from a Windows program, the program must be open
and the document window must be active.

1 Choose Print from the File menu.

In most cases a Print dialog box appears in which you can select options,
including the number of copies and the pages to print. Depending on your
program, the Print dialog box may offer other options.

2 In the dialog box that appears, select the options you want and click Print.

Selecting page setup options

The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, input paper tray source, and orientation.
You can change these settings for every document you create. It’s
recommended that you set your page setup options when you first create a
document. Then, as you view and format the document it will closely
resemble its final printed form.

1 Choose Page Setup (sometimes called Print Setup) from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.
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Setting printer driver options

You can change the PostScript Printer Driver default options. For example,
you can change the preset paper orientation to Portrait or Landscape.

You set printer options in the printer driver Setup dialog box, which you can
open in three ways, as explained in the sections that follow:

m from the Control Panel

m from your application

m from the Print Manager

Note: When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterward. Settings you change in an application’s Print dialog box
override print options you set in the Setup dialog box.

Opening the printer Setup dialog box from the Control Panel

1 From the Program Manager, double-click the Control Panel icon to display the 
Control Panel. 

2 Double-click the Printers icon to display the Printers dialog box. 

3 Select the printer you want to set up from the Installed Printers list.

4 Choose Setup to display the Setup dialog box for the printer. 

You can also use the Printers dialog box to select a default printer, to switch
the Print Manager on and off, and to connect your printer to a different port.
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Opening the printer Setup dialog box from your application

Most applications have a Print Setup command in their File menus.

1 Choose the Print Setup command from the File menu.

This command usually displays the Print Setup dialog box.

2 If you are using more than one printer, select the printer you want to set up.

3 Click the Options (or Setup) button to display the Setup dialog box.

Note: The names of the commands and buttons used to display the printer
Setup dialog box vary from program to program. See your program’s
documentation for the precise command and button names it uses.

Opening the printer Setup dialog box from the Print Manager

1 From the Program Manager, double-click the Print Manager icon to display the 
Print Manager. 

2 Select the printer you want to set up from the list of Printers. 

3 Choose the Setup or Printer Setup command from the Options menu.

4 Select the printer you want to set up and click Setup.

Selecting printer options in the Setup dialog box

You can change the most commonly used printer settings from the Setup
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional
Printer Options,” next.) The previous sections explain how to open the
Setup dialog box.



The Paper tab dialog box is displayed first.

m Output Format Selects either PostScript or Encapsulated PostScript. Use
PostScript for normal printing. Use Encapsulated PostScript to create a file
that can be placed in a document of a program that accepts encapsulated
PostScript images.

m Paper Source Selects which paper cassette or multipurpose tray to use as the
paper source.

m Paper Size Specifies the paper size. Select the size that matches the paper in
the current paper source.

m Orientation Selects the orientation of the printed page. You can select
Portrait (tall), Landscape (wide), or Rotated Landscape (which prints text
and images in landscape orientation, but reverses the top and bottom of the
page, most useful when you’re printing with three-hole punched paper).

m Scaling Shrinks or enlarges the print image by a percentage you specify.
You can scale the image from 10 percent to 400 percent.

m Copies Specifies the number of copies of each document page to print.

m Watermarks Specifies which watermark to use.

m Layout Specifies the number of pages to print on each sheet of paper.

m Preview Screen Shows changes you make in the driver settings.
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Additional printer options

In addition to the Paper tab, other tabs display settings for:

m PostScript

m Fonts

m Features

m Job control

m Watermark

PostScript

Click the PostScript tab to display the PostScript tab dialog box, which
controls color printing, the communication protocol, and PostScript Level 2
features.

m Use PostScript Level 2 Features Tells the driver to use PostScript Level 2
features when printing documents. Use the Level 2 features to speed
printing.
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m Send Data in Binary Tells the driver to send data to the printer in a binary
format. Sending data in binary format may improve the printer’s
performance when printing images or documents containing many
downloadable fonts. The LaserWriter 12/640 PS printer can receive data in
either ASCII or binary format.

m Send Full Color Data Tells the driver to print colors on a color printer. Usually
it is best to select this option even when printing to a non-color printer.
Colors print in finer shades of gray.

m Match Colors Across Printers Tells the driver to save color-matching
information with the data for use later when the document is saved to a file
for printing on a different PostScript Level 2 printer.

m Job Timeout Sets the maximum number of seconds that the printer will
spend trying to print a document before canceling the print job. A value of
zero means that the job is never canceled.

m Wait Timeout Sets the maximum number of seconds that the printer will
wait for Windows to send data before canceling the print job. A value of
zero means that the job is never canceled.

m Margins Changes the way the printer driver reports the printable area to the
applications you use. The Default option tells the driver to report the
printable area accurately to the applications. The None option tells the
driver to report the dimensions of the paper as the printable area. 

m Protocol Options Tells the printer driver whether to begin and end print jobs
with Ctrl-D. Default means it will begin and end jobs with a Ctrl-D, and
None means it won’t. If the printer is connected to your computer or
network by its parallel port, click Default; if it’s connected by its Ethernet
port, click None.

m PostScript Performance Tells the driver to build PostScript document
descriptions that print as fast as possible when Optimize for Speed is
selected. Such document descriptions might not print successfully on
printers with limited memory. Select “Optimize for Portability” to tell the
driver to build PostScript document descriptions that print successfully on
many different printers.
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Fonts

Click the Fonts tab to display the Fonts tab dialog box. Parameters in this
dialog box control the way the driver prints TrueType fonts used in your
documents. The driver can download available TrueType fonts as TrueType
fonts (Type 42), substitute available PostScript fonts for TrueType fonts, or
automatically create PostScript versions of TrueType fonts and download
them to the printer when you print.

m Send TrueType Fonts to This Printer as Tells the driver what kind of PostScript
fonts to create for TrueType fonts. Select one of these options:

m Type 1 to synthesize outline PostScript fonts.

m Type 3 to synthesize bitmapped PostScript fonts.

m Type 42 to package TrueType fonts for the PostScript printer.

m Don’t Send to use TrueType fonts that are resident in the printer or are
supplied by print-manager software. (No TrueType fonts are resident on
the printer as it is shipped from the factory.)
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m Substitute PostScript Fonts for TrueType Fonts on This Printer When checked,
tells the driver to substitute PostScript fonts available to the printer for
TrueType fonts. The driver uses the TrueType Substitutions table to
determine which PostScript font to use for each TrueType font installed on
your system. Substituting PostScript fonts for TrueType fonts speeds
printing (especially when the PostScript fonts are resident in the printer).

m TrueType Substitutions for All Printers Lists all the TrueType fonts installed on
your system, and for each TrueType font, shows which PostScript font is
substituted for a TrueType font. This table is used only when you select the
“Substitute PostScript Fonts for TrueType Fonts on This Printer” option.

m For This TrueType Font Shows a list of all the TrueType fonts installed on
your system.

m Substitute This Font Lets you select how font substitution is done. Shows a
list of the PostScript fonts that are substituted for the TrueType fonts. Each
list box lists all the PostScript fonts available to the printer. PostScript
fonts available to the printer include all the fonts resident in the printer’s
ROM, as well as all the Type 1 fonts that you have downloaded to the
printer’s RAM. Each list box also contains a Send As Type 1 option, which
converts the TrueType font to a Type 1 font. The Use Defaults button
restores the original PostScript font substitutions.

IMPORTANT For information about using Font Downloader, see “Downloading
Fonts,” later in this chapter.
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Features

Click the Features tab to display the Features tab dialog box, which lets you
configure the printer software to use optional printing features that you install
on the LaserWriter 12/640 PS. Use this dialog box to set up any optional
features you may purchase, such as additional memory or the 500-sheet
cassette and feeder.

m PhotoGrade Turns PhotoGrade on or off. To use PhotoGrade, your printer
must be upgraded to have at least 12 MB of RAM. PhotoGrade enhances
the printed look of images, such as scanned or digital photographs, to
produce added clarity, finer shading, and better contrast. For documents
that require images to be printed with the best quality that the printer can
produce, turn PhotoGrade on.

m Sides Tells the printer to print on one side of the paper or on both.

m Memory Configuration The amount of RAM installed in the printer.

m Cassette Indicates whether you have installed the optional 500-sheet
feeder.

m Duplexer Indicates whether the optional duplex printing unit is installed.

m Output Tray Tells the printer where to direct the media.
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m FinePrint Turns FinePrint on or off. FinePrint smoothes out lines and
curves and enhances text and line graphics that would normally appear
ragged. (However, to enhance the quality of images, you may want to turn
FinePrint off.)

m Tray Switch Turns tray switching on or off.

Job Control

Click the Job Control tab to display the Job Control tab dialog box, which
controls such options as when the PostScript header and the PostScript error
handler are sent to your printer.

m Printer Mode Lets you set up the printer to receive data in ASCII or 
binary format.
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m PostScript Header The PostScript header contains instructions that a
PostScript printer needs to print documents created by the driver. If 
your printer is connected directly to your computer only, you can save
time by choosing the Download button to send the PostScript header only
once—when you switch on your printer. Download Each Job tells the
driver to send the PostScript header with every document. Already
Downloaded tells the driver not to send the PostScript header with
documents. Download tells the driver to send the header when you choose
the Download button.

m Error Handler Tells the driver to send a special PostScript error handler with
every document you print. The error handler prints a page with a
PostScript error message when a document fails to print correctly. You can
use this option as an aid in troubleshooting print job problems.

m Font Control This advanced feature tells the driver not to download fonts
when printing documents. Use this option if you know that the fonts you
use in your documents are always available to the printer.

Watermark

Click the Watermark tab to display the Watermark tab dialog box, which
contains options for defining, editing, and deleting watermarks.
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m Select a Watermark Lists available watermark definitions, which can be
selected and edited or deleted.

m Edit Displays the Edit Watermark dialog box, summarized below.

m Add Displays the Add Watermark dialog box, which has the same features
as the Edit Watermark dialog box, summarized below.

m Delete Deletes the selected watermark definition.

m Display area A bitmap area that displays a portrait image of what the page
will look like when printed.

Edit Watermark

Choose the Edit button in the Watermark tab dialog box to display the Edit
Watermark dialog box.

m Text Displays the text of the selected watermark for editing.

m Font Lists all TrueType and ATM fonts and the 13 base PostScript fonts
that either reside in the printer or can be downloaded to the printer.

m Size Lets you specify a font size between 7 and 600 points.

m Style Lets you specify a font style: Regular, Bold, Italic, and Bold Italic, as
available.
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m Print in Foreground Tells the printer to print the watermark in the foreground
rather than in the background (the default). Choose this setting if you
cannot see the watermark on the printed page.

m Print Outline Only Tells the printer to print only the outline of the watermark.
Choose this setting if the watermark is covering graphic images in the
document.

m Angle Lets you specify the angle at which the watermark will display on
the page.

m Color Lets you specify red, green, and blue values for the color in which
the watermark is printed. As an alternative, Choose Color brings up a
Color dialog box that lets you view and select a color for the watermark.

m Automatically Center Watermark/Position Relative to Center Tells the driver how
to position the watermark. Automatically Center Watermark centers the
watermark on the page. Position Relative to Center lets you specify x and y
coordinates for the watermark relative to the center.

Downloading fonts

The LaserWriter 12/640 PS uses downloadable PostScript fonts, which are a
type of soft font. The PostScript printer driver automatically downloads any
Type 1 fonts from your computer’s hard disk to the printer’s memory as
needed for each document that you print. You can also use the driver to
manually download fonts to the printer’s memory when you don’t want to
download fonts for each document. Manually downloading fonts can speed
printing.

Note: The LaserWriter 12/640 PS has a set of built-in fonts that do not need
to be downloaded. These fonts are listed in Appendix D.

Whether it is better to let Windows download fonts automatically or to
manually download fonts yourself depends on the number and frequency
with which fonts are used in a document and the size of your printer’s
memory.
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Downloading a Type 1 font to a PostScript printer usually takes from 15 to 20
seconds. When a program prints a document containing a font that is not
resident in your printer, Windows automatically downloads the font with the
document. However, after the document prints, any fonts that have been
downloaded with the document are cleared from the printer’s memory. This
means that each time you print a document that contains fonts not resident in
the printer, the fonts must be downloaded.

By contrast, when you manually download a Type 1 font with the Font
Downloader, the font remains in printer memory (RAM) until you switch off
or restart the printer or when memory limitations are exceeded. Manually
downloading frequently used fonts therefore reduces printing time because
the fonts do not have to be sent to the printer each time they are used. Keep in
mind, however, that fonts manually downloaded to RAM reduce the overall
amount of memory available for printing and so may affect the printing of
documents that do not contain the downloaded fonts.

In addition to downloading fonts, you can also use the Font Downloader
to perform various printer management tasks, such as listing and removing
downloaded fonts, manually downloading PostScript language files,
clearing the printer font cache, and resynchronizing your printer with the
Windows driver.

See your network administrator for more information about performing these
tasks on your network, or choose the Help button in the Font Downloader
dialog box to see instructions for these tasks.

Downloading fonts manually to RAM

Fonts need to be downloaded only once. Users who want to use fonts that
have already been downloaded should use the Job Control tab dialog box
(described earlier in this chapter) to turn on Do Not Download Fonts.
Otherwise, the fonts will be downloaded again, wasting time and system
resources.

1 From the Program Manager, open the Control Panel.

2 Double-click the Printers icon. 

The Printers dialog box appears.
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3 If it is not already selected, select the LaserWriter 12/640 PS from the Installed 
Printers list.

4 Click Setup. 

The Setup dialog box appears.

Note: You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.

5 Click Fonts.

6 Click Font Downloader. 

The Font Downloader dialog box appears.

7 Choose Memory from the Destination Memory list box.

8 Select the fonts you want to download from the Fonts Available list.

Fonts that are already present in the printer’s ROM do not need to be
downloaded. For a list of these fonts, see Appendix D or print a list of font
samples by choosing Print Font Samples in the Apple LaserWriter Utility
for Windows.

9 Click Download. 

The Font Downloader informs you of its progress as it downloads fonts.

Note: While downloading, you can use other programs, but you can’t print.

10 After you are finished downloading fonts, click Exit. 

You are returned to the Setup dialog box.

11 Click OK to close the Setup dialog box.

12 Click Close to close the Printers dialog box.

13 Choose Exit from the Settings menu to close the Control Panel.

You can confirm that the fonts were downloaded by printing a list of font
samples with the Apple LaserWriter Utility for Windows.
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Printing to a PostScript file

As an alternative to printing your document on the printer, you can save a
PostScript language description of your document as a disk file. PostScript
language descriptions of documents can be useful for

m creating document archives

m printing documents without using the program that created them (at a
service bureau, for example)

m diagnosing printing problems

You may also want to print an encapsulated PostScript (EPS) file. You can use
EPS files to export single pages from one program to another. EPS files can
include any combination of text, graphics, and images, but they do not
describe complete documents. For example, by saving an EPS file, you can
insert a page of a document created with one program as an illustration in a
document created by another program.

Note: PostScript files are normally ASCII text files that can be opened with
any word-processing program. However, if you select the Send Data in Binary
option in the PostScript Options dialog box, the PostScript files may include
binary characters that make them unsuitable for use with a word processor.

You can use either of two methods to create PostScript files. If your program’s
Print dialog box has a Print to File checkbox, you can use this checkbox to
create a PostScript file; this is the preferred method. Refer to your program
documentation for information. If your program’s Print dialog box does not
have a Print to File checkbox, however, you need to make temporary changes
to your printer setup to create a PostScript file, as described next.
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Using the driver to print to a PostScript file

Using the driver to print to a PostScript file is a three-step process. First,
change your printer setup, then use your program to create the file, and finally
reset your printer setup for normal printing.

Step 1: Changing your printer setup to print to a PostScript file

1 From the Program Manager, open the Control Panel and double-click the Printers icon.

The Printers dialog box appears.

2 If it is not already selected, select the name of the PostScript printer that you are using
from the Installed Printers list. 

3 Select Connect. 

The Connect dialog box appears.

4 Select FILE from the Ports list box.

You may have to scroll through the list to find this selection.

5 Choose OK to close the Connect dialog box and return to the Printers dialog box.

6 Choose Setup. 

The driver Setup dialog box appears.

7 After changing (or confirming) your printer settings, choose OK to close the dialog box. 

Note: Choose settings in the PostScript Options dialog box that will produce
a file that prints correctly on the destination printer. For example, select the
“Use PostScript Level 2 Features” option if you are sure that you will be
printing the file only on Level 2 printers, such as the LaserWriter 12/640 PS.
If you plan to use a printer that does not support binary communication,
disable the “Send Data in Binary” option. Selecting the “Optimize for
Portability” option creates PostScript files that print successfully from
different programs on a wide variety of printers and imaging devices; it is
recommended that you enable this option.

8 Choose Close to close the Printers dialog box. 

9 Choose Exit from the Settings menu to close the Control Panel.
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Your computer is now set up to create PostScript files when you choose the
Print command from a Windows program.

Step 2: Printing to a PostScript file

1 Start the program and open the document for which you want to create a PostScript file.

2 If necessary, select the Print Setup command from the File menu, change the settings as
appropriate, and select OK.

3 Choose the Print command from the File menu. 

Your program’s Print dialog box appears.

4 Choose OK. 

A dialog box appears that asks you to name the file.

5 Enter a pathname and filename for the file. 

If you don’t specify a pathname, the PostScript file is placed in your program’s
default directory.

6 Choose OK. 

The PostScript file is created, and you are returned to your program.

Step 3: Restoring your printer setup options

After creating PostScript files, you need to restore your original printer setup
options before you can use your printer again.

1 From the Program Manager, open the Control Panel. 

2 Double-click the Printers icon. 

The Printers dialog box appears.

3 If it is not already selected, select the printer model from the Installed Printers list. 

4 Choose Connect. 

The Connect dialog box appears.

5 In the Ports list box, select the port to which your PostScript printer is connected. 
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6 Choose OK. 

The Connect dialog box closes, and you are returned to the Printers
dialog box.

7 If you changed any printer settings to print a PostScript file, choose Setup to display the
Setup dialog box. Undo any changes you made and then choose OK. 

The Printers dialog box appears.

8 Select OK to close the Printers dialog box.

9 Choose Exit from the Settings menu to close the Control Panel.

DOS notes

If you are using DOS programs, refer to the manual that came with your
program and follow the instructions for using a PostScript printer. Most DOS
programs are PostScript compatible.

Capturing a print queue for DOS printing

From DOS, you can use the NetWare CAPTURE command to map the
parallel port to a print queue.

m Log in to the NetWare network and enter the CAPTURE command, using the
following syntax:

CAPTURE /q=queue_name local=lptnumber server=server_name

job=new

Unless you specify otherwise, the command assumes that you are mapping
the LPT1 port to a queue.

Using the Apple LaserWriter Utility for Windows

The Apple LaserWriter Utility for Windows program supplied with the
printer software lets you control various aspects of how the printer works. For
information about using the Apple LaserWriter Utility for Windows, see
Appendix A.
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This chapter provides information on using the LaserWriter 12/640 PS with
computers running Windows 95.

If you are using Windows 3.1 or DOS, see Chapter 7.
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Printing

On a PC, printing functions are controlled through the Page Setup and Print
dialog boxes, which are accessed through the File menu.

Most Windows application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)

You can change default settings the printer uses for all documents with the
Apple LaserWriter Utility for Windows. For more information about the
Apple LaserWriter Utility for Windows, see Appendix A.

Selecting page setup options

The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, format, and orientation as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document it will closely resemble its final printed form.

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.
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Printing documents

When you are printing from Windows, most application programs display a
Print dialog box, in which you specify print options such as the number of
copies you want printed, the layout, and which paper tray or cassette will be
the paper source.

Some application programs also add more choices to the Print dialog box.
For information about such options, refer to the documentation that came
with the program.

1 Choose Print from the File menu.

2 In the dialog box that appears, make the selections you want.

Setting printing properties

You can change the default properties of the PostScript printer driver. For
example, you can change the default paper orientation from Portrait to
Landscape.

You set printer options in the printer driver Properties dialog box, which you
can open in three ways, as explained in the sections that follow:

m from the Control Panel

m from the Printers folder

m from your application

Note: When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterwards. Settings you change in an application’s Print dialog box
override print options you set in the Properties dialog box.
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Opening the printer Properties dialog box from the Control Panel

1 Click the Start icon on the Task-Bar, select Settings, and click Control Panel.

2 Double-click the Printers icon.

3 Select the printer you want to change and choose Properties from the File menu.

Opening the printer Properties dialog box from the Printer folder

1 Click the Start icon on the Task-Bar, select Settings, and click Printers.

2 Select the printer you want to change and choose Properties from the File menu.

Note: The Printers folder that appears is the same Printer folder that you see
from the Control Panel.

Opening the printer Properties dialog box from your application

1 Choose Page Setup from the File menu.

2 Click Printer.

3 Select the printer you want to change and click Properties.

To change optional settings for a print job, click Properties, and then make the
changes you want. If you save the changes, they usually persist from one file
to the next. However, if you exit the application and reopen it later, any
properties that you changed may be reset to their original default values.

You can also open the Properties dialog box from the Print dialog box.

Note: You will see fewer options when opening the Properties dialog box
from your application. To see the complete set of print options, open the
Properties dialog box from the Printer folder.

1 Choose Print from the File menu.

2 Click Properties.
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Selecting printer options in the Properties dialog box

You can change the most commonly used printer settings from the Properties
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional Printer
Options,” next.) The previous sections explain how to open the Properties
dialog box.

The Paper tab dialog box is displayed first.

m Paper Size Specifies the paper size. Select the size that matches the paper in
the current paper source.

m Layout Specifies the number of pages to print on each sheet of paper.

m Orientation Selects the orientation of the printed page. You can select
Portrait (tall), Landscape (wide), or Rotated Landscape (which prints text
and images in landscape orientation, but reverses the top and bottom of the
page; most useful when you’re printing with three-hole punched paper).
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m Paper Source Selects which paper cassette or multipurpose tray to use as the
paper source.

m Copies Specifies the number of copies of each document page to print.

m Unprintable Area Displays the Unprintable Area dialog box, used to set the
document margins.

m More Options Displays the More Options dialog box, used to specify duplex
printing settings.

Setting document margins

Choose the Unprintable Area button in the Paper tab dialog box to display
the Unprintable Area dialog box, which lets you set the page margins.

m Units Lets you define what unit of measurement to use when setting the
document margins.

m Top/Bottom/Left/Right Defines the unprintable area between the sides of the
paper and the text or image of your document.
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Setting duplex printing options

Choose the More Options button in the Paper tab dialog box to display the
More Paper Options dialog box, used to specify duplex print settings.

If your LaserWriter has been upgraded to a minimum of 12 MB of memory,
and you’ve installed the optional duplex printing unit, you can duplex print.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

m Printing on both sides Lets you define how to duplex print. Select None to
print only on one side. Select “Flip on long edge” if you want the binding
orientation along the long edge of the paper (such as in a book or
magazine). Select “Flip on short edge” if you want the binding orientation
along the short edge of the paper (such as in a calendar).

m Output bin Selects which tray to use as the output.
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Additional printer options

In addition to the Paper tab, other tabs display settings for:

m Graphics

m Device Options

m PostScript

m Watermarks

m Fonts

m General

m Details

m Sharing

Graphics

Click the Graphics tab to display the Graphics tab dialog box, which controls
resolution and special printing features.
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m Resolution Lets you specify the printer’s resolution.

m Halftoning Lets you specify new frequency and angle values to use for
halftone screens or use the printer’s default values.

m Special Lets you define special printing features. Select Print as Negative
Image to print a black-and-white reversed image. Select Print as Mirror
Image to flip the page image vertically.

m Scaling Shrinks or enlarges the print image by a percentage you specify.
You can scale the image from 10 percent to 400 percent.

Device Options

Click the Device Options tab to display the Device Options dialog box, which
lets you configure the printer software to use optional printing features that
you install on the LaserWriter 12/640 PS. Use this dialog box to set up any
optional features you may purchase, such as additional memory or the 500-
sheet cassette and feeder.

FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting for the FinePrint feature to on or off. Users can
change this setting in the Print Options dialog box. To print high-quality
images, turn off FinePrint.

PhotoGrade enhances the look of printed images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. If your LaserWriter has been upgraded to a minimum of 12 MB of
memory, you can use PhotoGrade. You can set the printer’s default to have
PhotoGrade turned on and off.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)
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When the LaserWriter 12/640 PS runs out of paper in one tray, it can
automatically switch and use paper in another paper cassette or the
multipurpose tray. By using automatic tray switching between the 250-sheet
paper cassette and the 80-sheet multipurpose tray, you can print 330 sheets
without reloading paper. If you have the optional 500-sheet cassette and
feeder, and it contains the same size paper, automatic tray switching includes
it as a paper source. Combining all three paper sources lets you print up to
830 sheets without reloading paper.

m Available printer memory Lets you specify the amount of available printer
memory.

m PhotoGrade Turns PhotoGrade on or off. To use PhotoGrade, your printer
must be upgraded to have at least 12 MB of RAM. PhotoGrade enhances
the printed look of images, such as scanned or digital photographs, to
produce added clarity, finer shading, and better contrast. For documents
that require images to be printed with the best quality that the printer can
produce, turn PhotoGrade on.
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m FinePrint Turns FinePrint on or off. FinePrint smoothes out lines and
curves and enhances text and line graphics that would normally appear
ragged. (However, to enhance the quality of images, you may want to turn
FinePrint off.)

m Tray Switch Turns tray switching on or off.

The following options appear only if you open the Properties dialog box
through the Printer folder:

m Installable options Lists the available options and their current state. For
memory configuration, the amount of memory in the printer is displayed.
For all others, the values could be one of: Not Installed, Installed, or
Installed and Preferred.

m Change setting for Sets the value for the option. For memory configuration,
select the amount of memory that currently resides in the printer.

PostScript

Click the PostScript tab to display the PostScript tab dialog box, which
controls the output format.
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m PostScript Output format Tells the driver to build PostScript document
descriptions that print as fast as possible when “optimize for speed” is
selected. Such document descriptions might not print successfully on
printers with limited memory. Select “optimize for portability” to tell the
driver to build PostScript document descriptions that print successfully on
many different printers. Select “encapsulated PostScript” to tell the driver
to build an encapsulated PostScript document description, rather than a
PostScript description. Select “archive format” to suppress many of the
printer settings that might prevent the file from printing. Choose this
option only if the file might be printed on unknown devices.

The following options appear only when you open the Properties dialog box
from the Printer folder:

m Assume header is downloaded and retained When checked, tells the driver to
send the document to the printer without the PostScript header.

The PostScript header contains instructions that the printer needs to print
correctly. Select this option only if you are an advanced user with
experience working with PostScript headers.

m Send Header Now Sends the PostScript header to the printer and selects the
“Assume header is downloaded and retained” option.

m Print PostScript error information When checked, tells the driver to print any
PostScript errors to the printer.

m Job timeout Sets the maximum number of seconds that the printer will
spend trying to print a document before canceling the print job. A value of
zero means that the job is never canceled.

m Wait timeout Sets the maximum number of seconds that the printer will wait
for Windows to send data before canceling the print job. A value of zero
means that the job is never canceled.

m Advanced Displays the Advanced PostScript dialog box, used to set data
communication protocol and format. Only experienced PostScript users
should set options in the Advanced PostScript dialog box.
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Advanced PostScript options

Choose the Advanced button in the PostScript tab dialog box to display the
Advanced PostScript Options dialog box.

m PostScript language level Lets you specify which level of PostScript language
to use.

m Bitmap compression Lets you specify whether to compress graphics before
sending your document to the printer. If you’re using PostScript language
level, click No Bitmap Compression.

m ASCII data Sends all data in Adobe Communication Protocol. ASCII data
format allows the file to print on any printer.

m Binary communications protocol Sends all data except special control
characters in binary (8-bit) format.

m Tagged binary communications protocol Sends all data except special
characters in binary (8-bit) format over serial or parallel ports.

m Pure binary data Sends all data in pure binary format. This option works
only on AppleTalk or Ethernet networks.

m Send CTRL+D before job Sends CTRL+D to the printer before a print job to
reset the printer.
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m Send CTRL+D after job Sends CTRL+D to the printer after a print job to
notify the printer the current job is finished and to reset the printer.

m Display alert for applications incompatible with driver features When checked,
displays a message if an application might be incompatible with some
driver features.

Watermarks

Click the Watermark tab to display the Watermark tab dialog box, which
contains options for defining, editing, and deleting watermarks.

m Select a watermark Lists available watermark definitions, which can be
selected and edited or deleted.

m Edit Displays the Edit Watermark dialog box, summarized below.

m New Displays the New Watermark dialog box, which has the same features
as the Edit Watermark dialog box, summarized below.

m Delete Deletes the selected watermark definition.
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m Print watermark Tells the printer how the watermark should be printed. You
can print on the first page only rather than on all pages (the default). You
can print the watermark in the foreground rather than in the background
(the default). Choose this setting if you cannot see the watermark on the
printed page. You can print only the outline of the watermark. Choose this
setting if the watermark is covering graphic images in the document.

m Display area A bitmap area that displays a portrait image of what the page
will look like when printed.

Edit Watermark

Choose the Edit button in the Watermark tab dialog box to display the Edit
Watermark dialog box.

m Text Displays the text of the selected watermark for editing.

m Font Lists all TrueType and ATM fonts and the 13 base PostScript fonts
that either reside in the printer or can be downloaded to the printer.

m Size Lets you specify a font size between 7 and 600 points.

m Style Lets you specify a font style: Regular, Bold, Italic, and Bold Italic, as
available.

m Angle Lets you specify the angle at which the watermark will display on
the page.
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m Automatically center/Position relative to center Tells the driver how to position
the watermark. “Automatically center” centers the watermark on the page.
“Position relative to center” lets you specify x and y coordinates for the
watermark relative to the center.

m Color Lets you specify red, green, and blue values for the color in which
the watermark is printed. As an alternative, Choose Color brings up a
Color dialog box that lets you view and select a color for the watermark.

Fonts

Click the Fonts tab to display the Fonts dialog box, which controls font
substitution. The Fonts tab is available only if you open the Properties dialog
box through the Printer folder.

m Send TrueType fonts to printer according to the Font Substitution Table Tells the
driver to use the Font Substitution Table to determine which PostScript
fonts to substitute for TrueType fonts.

m Edit the Table Displays the Font Substitution Table, used to substitute
PostScript fonts for TrueType fonts in your document.

m Always use built-in printer fonts instead of TrueType fonts Tells the driver to
ignore the Font Substitution Table and to use font-matching rules to find
the best PostScript font to substitute for TrueType fonts in your document.

m Always use TrueType fonts Tells the driver to send TrueType fonts to the
printer when your document is printed.

m Update Soft Fonts Lets you update the list of installed PostScript fonts so
that the printer driver prints them correctly.

m Send Fonts As Displays the Send Fonts As dialog box, used to specify how
to send TrueType or PostScript fonts.

Specifying how to send TrueType or PostScript fonts

Click the Send Fonts As button in the Fonts tab to display the Send Fonts As
dialog box.

m Send TrueType fonts as Lets you specify the format used to send TrueType
fonts that are not substituted with their PostScript equivalent fonts. For
Type 1 (outline) fonts, select Outlines. For Type 3 (bitmap) fonts, select
Bitmaps. Select “Don’t Send” if you don’t want any fonts sent.
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m Threshold Lets you specify the size of the font at which the PostScript
driver should switch from sending TrueType fonts as Type 1 to sending
them as Type 3 (bitmap) fonts.

m Favor system TrueType fonts When checked, tells the driver to use the system
TrueType font instead of the printer font when the same font is found on
both the printer and the computer.

m Send PostScript Fonts As Lets you specify how to send PostScript fonts to
the printer. Select Native Format to send PostScript fonts before your
document. Select Don’t Send to send no PostScript fonts to the printer.

General

Click the General tab to display the General tab dialog box, which lets you
insert comments about the printer and specify whether to use a separator
page between print jobs. The General tab is available only if you open the
printer Properties dialog box through the Printer folder.

m Comment Displays any general description about the printer. Text in the
Comment option is displayed to users when they select a network printer.

m Separator page Tells the printer to place a page between print jobs. You can
select what kind of text or graphics goes on a separator page.
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Details

Click the Details tab to display the Details tab dialog box, which controls the
printer port. The Details tab is available only if you open the printer
Properties dialog box through the Printer folder.

m Print to the following port Lets you specify the port your printer is attached to
or the path to the network printer you’re using.

m Add Port Click to add a new port or to specify a new network path.

m Delete Port Click to delete a port from the “Print to the following port” list
box.

m Print using the following driver Lets you specify the type of printer you’re
using.

m New Driver Click to update your printer driver.

m Capture Printer Port Click to map a port to a network drive.

m End Capture Click to remove a port from a network drive.
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m Timeout settings/Not selected/Transmission retry “Not selected” specifies how
long Windows 95 waits for the printer to be online before reporting an
error. “Transmission retry” specifies how long Windows 95 waits for the
printer to be ready before reporting an error.

m Spool Settings Click to specify how the document is sent from the
application to the printer.

m Port Settings Click to change your port settings.

Add Port

The Add Port dialog box lets you add a new port or specify a network path.

m Network When selected, tells the driver you want a network printer. Specify
the path to the network printer in the text box.

m Other Lets you select another type of port, such as a FAX port.

Spool Settings

The Spool Settings dialog box specifies spool print jobs and data format.

m Spool print jobs so program finishes printing faster When selected, saves
printing information on your computer’s hard disk until the printer is ready
to print.

m Start printing after last page is spooled When selected, waits until all printing
information has come from the application before sending it to the printer.

m Start printer after first page is spooled When selected, starts sending printing
information from your disk to the printer after one page has been received
from the application.

m Print directly to the printer When selected, waits until your printer is ready
before sending the print job from the application to the printer.

m Spool data format Lets you specify the format in which to store printing
information on your disk while a print job is waiting to be printed.

m Enable bidirectional support for this printer/Disable bidirectional support for this
printer Specifies whether the printer should communicate with the
computer bidirectionally.
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Sharing

The Sharing tab dialog box controls network sharing of the printer. Even if
you are not using NetWare, you can still share your printer with other users
on the Microsoft Network.

The Sharing tab is available only when you open the printer Properties dialog
box from the Printer folder. If you don’t see the Sharing tab in the Printer
folder, open the Network Control Panel. Select Microsoft Networks as your
Primary Network logon. Then select File and Print sharing. Select the options
you want and restart your system. Open the printer Properties dialog box
from the Printer folder. The Sharing tab should now be available.

m Not Shared When selected, the printer is not available to other users on 
the network.

m Shared As When selected, the printer is available to other users on the
network.
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m Share Name Enter the name of the shared printer. This name appears in the
Network Neighborhood window when users search for network printers.

m Comment Enter any comments about this printer. Comments can be viewed
by users searching for network printers.

m Password Enter the optional password if you want to restrict network user
access to this printer.

Using the Apple LaserWriter Utility for Windows

The Apple LaserWriter Utility for Windows program supplied with the
printer software lets the printer administrator control various aspects of how
the printer works. For information about using the Apple LaserWriter Utility
for Windows, see Appendix A.
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This chapter describes how to load the LaserWriter 12/640 PS paper cassette
and multipurpose tray with paper. It describes how to load standard paper,
letterhead, three-hole punched paper, envelopes, labels, and transparencies
for printing.

You can purchase additional printing options for use with your LaserWriter
12/640 PS, including the LaserWriter 12/640 PS 500-Sheet Cassette and
Feeder and the LaserWriter 12/640 PS Envelope Cassette. This chapter gives
instructions for loading paper or envelopes into these options. (For
instructions on attaching options, see Chapter 5.)

For information on ordering options, see Appendix D.

The way you control the printer from your computer depends on the type of
computer and program you are using. For general information about printing
with a Mac OS–based computer, see Chapter 6. For information about
printing with an IBM PC or compatible computer using Microsoft Windows
or DOS, see Chapters 7 and 8. For specific information about printing with a
particular program, refer to the documentation that came with the program.

For best results, Apple recommends that you use paper with weight of at 
least 20 lb.
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Automatic or manual printing with the LaserWriter 12/640 PS

You can automatically print using paper from the paper cassette or using
paper stacked in the multipurpose tray. You can also manually feed paper,
envelopes, three-hole punched paper, labels, postcards, transparencies, and
labels into the printer using the multipurpose tray.

For information about selecting automatic or manual paper feeding, or
selecting the cassette or multipurpose tray to print from, see Chapter 6 if 
you have a Mac OS–based computer, or see Chapter 7 or Chapter 8 if you
have a Windows-based computer.

Using the paper cassette

The standard paper cassette holds up to 250 sheets of paper. You can fill the
cassette with U.S. letter-size paper, U.S. legal-size paper, A4 paper size, B5
paper size, executive paper size, letterhead paper, three-hole punched paper,
transparencies, or labels. To refill the paper cassette, insert paper as shown in
the following illustrations.

IMPORTANT Apple recommends you do not mix transparencies with other
types of paper in the paper cassette. (This helps avoid paper jams.)

To reduce curl and wrinkle on heavy media, such as postcards, envelopes, and
transparencies, direct the output to the face-up tray. For information about
selecting the output trays to print from, see Chapter 6 if you have a 
Mac OS–based computer, or see Chapter 7 or Chapter 8 if you have a 
Windows-based computer.
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Letter-size paper

1 Set the length guide (located on the back of the cassette) to the position that
corresponds to your paper’s length. You adjust the length guide by pushing or pulling
the guide.

2 Adjust the width guide to its maximum width by squeezing the colored lever (located on
the right side of the cassette) against the brace and sliding the guide outward.

3 Push down gently on the paper tray until it rests against the bottom of the cassette and
locks into place.

4 Slide the paper beneath the bracket at the front left of the cassette. Push the paper down
if necessary, but don’t overload the cassette, or the paper may jam when you print. 

Slide paper under
the retainers.

Make sure the paper fits
under this corner bracket.
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5 Adjust the width guide so that it fits snugly against the paper, but not so tightly that it
might cause binding. 

To avoid paper jams, always set the length and width guides to the correct
positions for your particular paper.

Legal and other size paper

1 Set the length guide (located on the back of the cassette) to the position that
corresponds to your paper’s length. You adjust the length guide by pushing or pulling
the guide.

The cassette is marked with positions for paper of U.S. letter (8-1/2 x 11), A4,
B5, Executive (7-1/4 x 10-1/2), and U.S. legal sizes (8-1/2 x 14).

2 Adjust the width guide to its maximum width by squeezing the colored lever (located on
the right side of the cassette) against the brace and sliding the guide outward.

3 Push down gently on the paper tray until it rests against the bottom of the cassette and
locks into place.

4 Slide the paper beneath the bracket at the front left of the cassette. Push the paper down
if necessary, but don’t overload the cassette, or the paper may jam when you print. 

5 Adjust the width guide so that it fits snugly against the paper, but not so tightly that it
might cause binding. 

To avoid paper jams, always set the length and width guides to the correct
positions for your particular paper.

Adjust the length and width guides
to fit the size paper you’re using.
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Letterhead paper and three-hole punched paper

Insert letterhead paper into the paper cassette face down, with the top of the
letterhead at the front of the tray (the handle end).

Note: If you want to print on both sides of the letterhead paper, place the
letterhead paper face up in the paper cassette, with the top of the page closest
to the handle.

Insert three-hole punched paper into the paper cassette so the holes are
toward the left side of the cassette.

Using the multipurpose tray

The multipurpose tray can hold up to 80 sheets of various sizes, as well as
envelopes, transparencies, and sheets of labels. The exact number of sheets
the multipurpose tray can hold depends on the weight of the paper. You can
use the multipurpose tray in several ways:

m automatic printing

m manual feed printing

m envelope printing

m postcard printing

m transparency and label printing

Note: You cannot duplex print when the paper source is the multipurpose tray.

Adjust the length and width guides
to fit the size paper you’re using.

Align letterhead and three-hole
punched paper as shown.
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Opening the multipurpose tray

To use the multipurpose tray you must first open it. 

1 Gently open the door.

2 Grasp the tab and slide out and extend the tray.
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Placing paper and envelopes in the multipurpose tray

You can use the multipurpose tray for all your printing jobs. You can keep
a small stack of paper in the tray and let the LaserWriter 12/640 PS feed the
paper automatically, or you can use the multipurpose tray for manual feed
printing.

By the way: If you use the Auto Select printing feature to automatically draw
paper from any source that holds the correct size paper, use the Apple Printer
Utility or LaserWriter Utility for Windows to define the size of paper that the
multipurpose tray holds. The printer software can then determine correctly
when to draw paper from the multipurpose tray. For more information about
defining the size of paper in the multipurpose tray, refer to Appendix A.
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Place the paper in the tray so that the left side of the stack is aligned with the
tray’s left side. Adjust the width guide so that it just touches the right edge of
the stack. Don’t adjust the guide so tightly against the stack that it causes
binding or rumpling of the paper.

For manual-feed printing, place a single sheet of paper, labels, or
transparency film or a single envelope in the multipurpose tray.

The multipurpose tray holds up to 80 sheets of paper. When there is no paper
left in the tray, the Paper Out light comes on.

By the way: You can have the LaserWriter 12/640 PS print using a first sheet
from the multipurpose tray and all following sheets from the paper cassette
(or vice versa).

For example, you can place letterhead paper in the multipurpose tray and use
it for printing the first page of a letter, and print all following pages on plain
paper from the paper cassette.

For more information about selecting paper trays for printing, see Chapter 6
if you have a Mac OS–based computer, or see Chapter 7 or Chapter 8 if you
have a Windows-based computer.

Adjust this guide to fit
the width of your paper.
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Loading three-hole punched paper in the multipurpose tray

You can load a stack of three-hole punched paper in the multipurpose tray for
automatic printing. You can also print on three-hole punched paper manually
by feeding one sheet at a time.

This illustration shows how to load a stack of three-hole punched paper in the
multipurpose tray.

Align three-hole punched
paper along the left edge of the tray.
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Loading letterhead paper in the multipurpose tray

You can load a stack of letterhead in the multipurpose tray for automatic
printing. You can also print letterhead manually by feeding one sheet at 
a time.

This illustration shows how to load a stack of letterhead in the
multipurpose tray.

Place letterhead paper face up
in the tray, with the top of the page
“in” (closest to the printer).

R
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Loading envelopes in the multipurpose tray

You can load a stack of 10 envelopes in the multipurpose tray for automatic
printing. You can also print envelopes manually by feeding them one
envelope at a time.

This illustration shows how to load a stack of envelopes in the
multipurpose tray.

Adjust the width guide on the multipurpose tray to the size of the envelope.

Hint: Direct the envelope to the face-up output to reduce curl.

If you print many envelopes: You can obtain an envelope cassette from
an Apple-authorized dealer that allows you to feed up to 50 envelopes
automatically.

WARNING Don’t use envelopes that have fasteners, snaps, or windows
when printing with the LaserWriter 12/640 PS printer. Also don’t use
envelopes that seal with peel-off strips or pressure-sensitive adhesives,
that are curled or wrinkled, or that are likely to discolor or melt at
temperatures of about 400° F (204° C). Printing on such materials can
damage the printer.

Slide the width guide
so that it rests against
the envelopes.

Stack the envelopes so that the tops
are to the right and the flaps are down.
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For best results when printing envelopes, be sure to position your address
block properly in your word-processing document. You’ll need to print in
landscape (horizontal) orientation and to adjust the top and left margins in
your word-processing program’s page formatting controls.

Once you’ve set the top and left margins, type the return address, skip a few
lines (the exact number depends on the font you’re using and the way you
like your envelopes to look, so you’ll have to experiment), and type the
address block.

Note: If the multipurpose tray and the optional envelope cassette have the
same size envelopes when automatic tray switching is on, the printer will use
the multipurpose tray first (if the multipurpose tray is set to the envelope
size). To use the envelope cassette, do one of the following:

m Pick the envelope cassette as the paper source in the Print dialog box.

m Set the multipurpose tray to a size other than the one used by the envelope
cassette. (You can do this with the Apple Printer Utility for the Mac OS or
the Apple LaserWriter Utility for Windows.)

m Change the optional envelope cassette to “Installed and Preferred” in the
Setup dialog box. (You can view the setup dialog box by selecting the
desktop printer icon and choosing Change Setup from the Printing menu.)

Printing an envelope

1 Open the multipurpose tray.

2 Adjust the width guide to fit the envelope.

3 Tuck the envelope flap inside the envelope.

This helps prevent the flap from causing a paper jam. (Some envelopes come
unglued when subjected to the heat inside the printer. High-quality envelopes
are likely to hold up better during the printing process.)

206 Chapter  9



4 Set your program to print lengthwise on the envelope.

On a Mac OS–based computer, choose Page Setup from the File menu, select
the Landscape orientation icon, and click OK.

On a Windows 3.1–based computer, open the Printer Setup dialog box and
select Landscape in the Orientation option.

On a Windows 95–based computer, open the print Properties dialog box and
select Landscape in the Paper tab.

5 Set your program to print using the multipurpose tray.

On a Mac OS–based computer, choose Print from the File menu, select
Manual Feed from the Paper Source pop-up menu, and click Print.

On a Windows 3.1–based computer, open the Printer Setup dialog box, select
the multipurpose tray from the Paper Source options, and click OK to close
the Setup dialog box. Choose the Print command from the File menu and
click OK.

On a Windows 95–based computer, open the print Properties dialog box and
select the multipurpose tray from the Paper Source option in the Paper tab.

6 When the printer’s Paper Out indicator light flashes, insert the first envelope and slide it
forward until it stops.

Insert the envelope face up (flap down) with the top edge to the right as it
enters the printer.

On a Mac OS–based computer, if Background Printing is turned on in the
Chooser, a PrintMonitor message prompts you to insert an envelope.

7 If you are printing several envelopes, insert the next envelope when the Paper Out light
flashes again. 

Do not feed the next envelope before the light prompts you to, or the
envelope may jam.
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Loading labels in the multipurpose tray

You can load one sheet of labels at a time into the multipurpose tray for
manual printing.

Insert the sheet of labels into the paper cassette face up.

IMPORTANT When you print labels, use the multipurpose tray. (This helps
avoid paper jams and curling.)

Don’t attempt to print sheets that
have labels missing. This may cause a jam. 

Use only labels recommended
for use in laser printers.
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Loading transparencies in the multipurpose tray

You can load one sheet of overhead transparency at a time into the
multipurpose tray for manual printing, or you can place a stack of about 40
transparencies in the tray for automatic feed.

To avoid leaving fingerprints (and ensure the best image quality), handle
transparencies by their edge.

IMPORTANT When you print overhead transparencies, Apple recommends you
use the multipurpose tray and use the face-up output tray for delivering
printed transparencies. (This helps avoid paper jams and curling.)

Only use transparencies recommended
for use in laser printers.
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Choosing paper

The LaserWriter 12/640 PS prints on standard laser-quality paper (16- to 28-
pound stock). For the best results, Apple recommends 20-pound stock. The
printer can accept stock of up to 32 pounds from the multipurpose tray. You
can also expect excellent results on most colored and textured papers.

The LaserWriter 12/640 PS produces high-quality transparencies for
overhead projection. Medium-weight photocopier transparencies work best. If
you experience difficulties when attempting to print transparencies with
automatic feed, use manual feed instead.

To avoid paper problems, keep the following potential trouble sources
in mind:

m Temperature Some letterheads are printed with low-temperature dyes that
vaporize and smear at the temperatures inside the printer. Some glossy,
coated letterheads may lose their coating in the printer. Similarly, some
envelopes may seal or come unglued during printing. Using high-quality
stationery and envelopes should ensure satisfactory results.

m Paper texture The LaserWriter 12/640 PS may not print well on rough or
highly textured paper. Try a few sheets to test the quality.

m Paper finish The LaserWriter 12/640 PS may not print well on some papers
with a glossy finish. Again, test a few sheets of any unusual paper stock
you wish to use.

WARNING Do not use heat-transfer (thermal) transparencies in the
LaserWriter 12/640 PS. They will not print properly and may separate
in the printer.
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Filling the optional envelope cassette

1 Slide the envelope cassette out of the 500-sheet feeder.

2 Move the postcard guide to the back of the envelope cassette, if necessary. 

To remove the postcard guide from the envelope tray, pinch the indented area
against the front of the guide. Roll the guide toward the front of the envelope
cassette and lift up.

To insert the postcard guide in the back of the envelope cassette, tilt the guide
toward the front of the envelope cassette and insert the two tabs located on
front of the guide into the slots. Roll the guide until its back is against the
back of the envelope cassette and locks into place.

3 Push down gently on the envelope tray until it rests against the bottom of the cassette
and locks into place.

4 Lift the back of the envelope cassette and move the length guide until it matches your
envelope’s length. Make sure the tab fits into the marked slots.

The cassette is marked with positions for envelopes of Comm10, C5, DL, and
Monarch sizes.

5 Pinch the color tab (located on the right side of the envelope cassette) against the post
and move the envelope width to its maximum setting.

6 Insert the envelopes into the cassette with the flap side up and the top edge to the right.

Adjust this guide to fit the
length of the envelopes.

Adjust the width guide here.

Make sure the envelopes are
under this roller.
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7 Adjust the width guide so that it fits snugly against the envelope, but not so tightly that it
might cause binding. 

To avoid envelope jams, always set the length and width guides to the correct
positions for your particular envelope.

8 Insert the envelope cassette into the 500-sheet feeder.

Note: If the multipurpose tray and the optional envelope cassette have the
same size envelopes when automatic tray switching is turned on, the printer
will use the multipurpose tray first (if the multipurpose tray is set to the
envelope size). To use the envelope cassette, do one of the following:

m Pick the envelope cassette as the paper source in the Print dialog box.

m Set the multipurpose tray to a size other than the one used by the envelope
cassette. (You can do this with the Apple Printer Utility for the Mac OS or
the Apple LaserWriter Utility for Windows.)

m Change the optional envelope cassette to “Installed and Preferred” in the
Setup dialog box. (You can view the Setup dialog box by selecting the
desktop printer icon and choosing Change Setup from the Printing menu.)

Filling with postcards

1 Remove the postcard guide from the back of the envelope cassette by pinching the
indented area against the front of the guide and rolling the guide toward the front of the
envelope cassette.

2 Insert the postcard guide in the envelope tray. To insert the guide, tilt it toward the front
of the envelope cassette and insert the two tabs located on the front of the guide into the
slots. Roll the guide until its back is against the envelope tray and locks into place.

Rotate and lift the postcard attachment. Insert the postcard attachment here.
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3 Push down gently on the envelope tray until it rests against the bottom of the cassette
and locks into place.

4 Lift the back of the envelope cassette and move the length guide until it matches your
postcard’s length. Make sure the tab fits into the marked slots.

5 Pinch the color tab (located on the right side of the envelope cassette) against the post
and move the envelope width to its maximum setting.

6 Insert the postcards into the envelope tray.

The side of the postcard to be printed should be face down with the top of the
postcard to the right.

7 Adjust the width guide so that it fits snugly against the postcard, but not so tightly that it
might cause binding. 

To avoid jams, always set the length and width guides to the correct positions
for your particular postcard.

8 Insert the envelope cassette into the 500-sheet feeder.

Note: To avoid curled postcards, direct the output to the face-up output tray.
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Filling the optional 500-sheet cassette

1 Slide the cassette out of the 500-sheet cassette and feeder.

2 Set the length guide (located on the back of the cassette) to the position that
corresponds to your paper’s length. You adjust the length guide by pulling up on one
corner of the guide and then the other.

The cassette is marked with positions for paper of U.S. letter (8-1/2 x 11), A4,
and U.S. legal sizes (8-1/2 x 14).

3 Adjust the width guide to its maximum setting by squeezing the colored lever (located on
the right side of the cassette) against the brace and sliding the guide outward.

4 Push down gently on the paper tray until it rests against the bottom of the cassette and
locks into place.

5 Slide the paper beneath the bracket at the front left of the cassette. Push the paper down
if necessary, but don’t overload the cassette, or the paper may jam when you print. 

Make sure the paper fits
under these brackets.

Adjust this guide to fit the
length of your paper.

Adjust this guide to fit the
width of your paper.
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6 Adjust the width guide so that it fits snugly against the paper, but not so tightly that it
might cause binding. 

To avoid paper jams, always set the length and width guides to the correct
positions for your particular paper.

7 Insert the paper cassette into the 500-sheet feeder.

Loading the 500-sheet cassette with letterhead and three-hole punched paper

Insert letterhead paper into the 500-sheet cassette face down, with the top of
the letterhead at the front of the tray (the handle end).

If you want to print on both sides of the letterhead paper, place the
letterhead paper face up in the paper cassette, with the top of the page
closest to the handle.

Insert three-hole punched paper into the paper cassette so the holes are
toward the left side of the 500-sheet cassette.

Make sure paper fits under this corner bracket.

Orient three-hole punched paper
and letterhead paper as shown.
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10 Maintenance

The LaserWriter 12/640 PS is designed for trouble-free service. Maintenance
involves little more than putting in a new toner cartridge every 6,000 pages
or so and performing a few minor cleaning tasks. The recommended service
interval is 120,000 pages to check and service wear on the rollers and fuser.
This service can be arranged through an Apple-authorized dealer.



Safety first

The fixing roller assembly in the LaserWriter 12/640 PS operates at very high
temperatures—around 400° F (204° C). Allow the rollers to cool before
performing maintenance and troubleshooting.

Hot area

D

Hot area
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Precautions during maintenance

To prevent damage to the printer while performing maintenance, observe the
following precautions.

m Don’t lubricate the printer.

m Don’t attempt to disassemble the printer.

m Don’t place anything on top of the printer.

Regular maintenance

The toner cartridge holds the toner powder that forms the printed images.
Each cartridge should yield about 6,000 pages. If you print many graphic
images, you may need to change cartridges more often. If your pages start to
look too light, or if you see vertical white regions in dark images, it may be
time to change the cartridge.

For ordering information, see Appendix D.

Replacing the toner cartridge

Whenever you install a new toner cartridge, you should also clean the interior
of the printer. Follow these steps to replace the cartridge and clean the
interior of the printer.

WARNING Use only cartridges designed for use with your LaserWriter
12/640 PS Printer. Other cartridges may not fit and may damage
the printer
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1 Open the printer cover.

Lift this latch to open the top cover.

220 Chapter  10



2 Remove the used cartridge.

3 Slide the yellow plastic square back and forth to remove any toner residue.

4 Take the new cartridge out of its packaging.

Slide the square back and forth.

Pull the cartridge up and out.
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5 Distribute the toner powder by gently rocking the cartridge back and forth.

6 Firmly pull the tab directly away from the cartridge to remove the sealing tape.

WARNING Be sure to pull the tab straight out of the cartridge. Don’t pull
too quickly or at an angle—either might damage the toner seals within
the cartridge.
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7 Align the arrow on the left side of the toner cartridge with the arrow on the left side of the
printer, then slide the cartridge downward into the printer. Make sure the toner cartridge
is inserted all the way and properly seated inside the printer.

Make sure the toner cartridge is
inserted all the way and properly
seated inside the printer.
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8 Close the printer and resume printing.

Cleaning the exterior

Unplug the power cord and then wipe the exterior of the printer with a clean,
soft, damp cloth. Use a mild soap or detergent if necessary, but never use
an ammonia-based cleaner. Be careful not to get any liquid in the power
cord port.

WARNING Never use ammonia-based cleaners on or around the
LaserWriter 12/640 PS. They may react chemically with the toner
and with the printer’s plastic case.

224 Chapter  10



This chapter provides solutions to problems you may encounter with paper
jams or print quality while using your LaserWriter 12/640 PS. The first
section discusses how to read the printer’s indicator lights to help you identify
and solve problems, and how to clear paper jams. The rest of the chapter
covers specific problems that can occur when you are printing a document.
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Checking the indicator lights

The lights on the front panel of the LaserWriter 12/640 PS indicate the
printer’s operating status.

Light On Off Flashing

Ready/In Use Printer is ready Printer cannot print Printer is warming up,
to use. because of an error, printing a startup 

or the cover is open, page, or processing
or the printer is data for the next 
turned off. print job.

Paper Out Paper cassette Paper supply is OK. Printer is ready for
is empty. sheet of manual-feed

paper.

Paper Jam There is a paper Paper is OK Toner cartridge is.
jam. not installed.

If the Paper Out and Paper Jam lights flash alternately, or all three lights stay
on, the printer requires service. If you have just installed additional memory
(RAM) in the printer, there may be a problem with the memory. Open the
printer and make sure the SIMMs are fully seated in the correct sockets that
match one of the supported configurations listed in Chapter 5 and in
Appendix D.
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Checking for and clearing paper jams

Occasionally a piece of paper may get stuck inside the printer during the
printing process. Follow these steps to find and clear a paper jam.

IMPORTANT If you experience paper jams after you first set up the printer,
check all areas of the printer to make sure that the packing materials have
been removed.

1 Check the paper exit area on top of the printer to see whether the paper is jammed there.
If so, gently pull the paper out.

If you cannot easily remove the paper, skip to step 2. If the paper jam is in
this location and you successfully removed the paper, go to step 5.
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2 Open the top cover of the printer and remove the toner cartridge. If the jam is around the
pressure roller area, remove the paper as shown here:

If you cannot remove the paper, pull the paper from within the printer, first
pulling into the printer, then out toward you to free it.

3 Remove the paper cassette to see whether the jam is in the paper cassette area. If so,
gently release or pull out the jammed paper.

Check that all paper edges are under the bracket at the front of the cassette.
Paper edges over the bracket are also considered paper jams.
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4 Check the multipurpose tray (if you are using it) to see whether paper has jammed there.
If so, gently pull the paper out.

5 Once you have removed the jammed paper, reinsert the toner cartridge, close the top
cover, and slide the paper cassette back into the printer. 

Note: You must open and close the top cover to reset the printer.
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Checking the optional 500-sheet cassette and feeder
m Remove the paper cassette to see whether the jam is in the paper cassette area. If so,

gently release or pull out the jammed paper.

Check that all paper edges are under the bracket at the front of the cassette.
Papers edges over the bracket are also considered paper jams.

If you have removed the jammed paper, open and close the top cover to reset
the printer.
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Checking the optional duplex printing unit

1 Remove the the duplex printing unit tray to see whether the jam is in the tray area. If so,
gently pull out the jammed paper.

Hint: It may be difficult to view paper jams in the duplex printing unit tray
area because paper jams may occur toward the back of the tray area. Look for
wrinkled or curled edges indicating a paper jam.

2 Open the duplex printing unit’s door to see whether the jam is around the paper guide
for the duplex printing unit. If so, gently pull out the jammed paper.

231Fix ing Paper  and Image Problems



3 Check around the roller area. You may have to push the roller to see if a paper is behind
the roller.

4 Once you have removed the jammed paper, slide the tray back into the duplex printing
unit and close the door.

5 Open and close the top cover to reset the printer.

Avoiding paper and envelope jams and wrinkling

Depending on the quality of paper and envelopes that you use, some papers
or envelopes may jam or wrinkle as they pass through the printer.

If you experience paper jams, loosen up the stack of paper by fanning it
before you load it into the paper cassette. Be sure not to overload the cassette.
With stiffer paper stock, try printing the paper from the multipurpose tray,
which provides a straighter feed into the printer than from the cassettes.
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Problems with printed documents

This section provides remedies for problems in the appearance of a printed
document.

The quality of grayscale art could be better.

Turn on the PhotoGrade feature, as described in Chapter 6 for Mac OS users
and Chapters 7 and 8 for Windows users. Also, try turning off the FinePrint
feature.

Note: You’ll need at least 12 MB memory to use PhotoGrade.

Paper curls when you print on it.

Use only 16- to 24-pound laser-quality or photocopy bond paper for automatic
feed and 16- to 32-pound paper for manual-feed printing. If you are using the
correct weight and the paper still curls, try using a different brand of paper.

Toner does not stay fixed on the paper.

If the toner does not stick to the paper, try using different paper. Best results
are obtained with laser-quality or photocopy bond paper.

The printer prints on only part of the paper, printing is off-center, or images are out 
of place.

Make sure that you have selected the appropriate paper source, paper size,
and orientation in your printing software. (On a Mac OS–based computer,
click the Page Image icon in the Page Setup dialog box; if you want to narrow
the margins to print on more of the page, you can select Larger Print Area in
the Options portion of the Page Setup dialog box.)

Check the paper width guide in the cassette. If the width guide is set too
wide, the paper may be fed into the printer at an angle.

Also check that the margins set in your document are correct, that you are not
using a type of paper that is causing a feeding problem, and that the paper
cassette isn’t too full.
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Nothing is printed on the paper.

If you get a blank document, try the following steps.

m If the cartridge is new, be sure to remove the plastic tape.

m Redistribute the toner powder by gently rocking the toner cartridge.

If you still get a blank document, the cartridge has run out of toner and needs
replacing.

The image prints in black and white although the original document is in color or
grayscale.

If the printed image contains only black and white areas instead of grays, try
the following step.

m Check to make sure that grayscale printing is turned on (on a Mac
OS–based computer, select the Color/Grayscale option in the Print Options
dialog box).

The image is too light.

If the printed images are too light, try the following steps.

m Change the print density to a darker level.

m Replace the toner cartridge.

If you are using a Mac OS–based computer, you can change print density
with the Apple Printer Utility. For more information, see Appendix A. If you
are using an IBM PC or compatible computer, you can change print density
with the LaserWriter Utility for Windows. For more information, see
Appendix A.

The image is too dark.

If the image is too dark, try the following steps.

m Change the print density to a lighter level (see Appendix A).

m Replace the toner cartridge; it may need to be changed.



The page prints solid black.

If your document prints black, turn your printer off and on again. If your
document still prints black your printer needs servicing.

Printer prints simplex even though duplex printing is specified.

If your document prints in simplex mode (only on one side) instead of duplex
mode, check the following:

m Is the optional duplex printing unit installed?

m Does the printer have at least 12 MB of memory?

m Is duplex printing selected in the Print dialog box?

Unwanted lines or stripes appear.

If white or dark vertical or horizontal lines or stripes appear on the page, try
the following remedies. (Each procedure is described in detail in “Replacing
the Toner Cartridge” in Chapter 10.)

m Gently rock the cartridge to redistribute the toner.

m Replace the toner cartridge.

m Clean the mirror by sliding the yellow plastic square back and forth to
remove any toner residue.

The image is wavy or distorted.

If a gray shaded area appears wavy or distorted, the toner cartridge may be
low, or the toner may need to be redistributed (see “Replacing the Toner
Cartridge” in Chapter 10).

Toner smudges appear on front or back of paper.

If stains appear on the paper, try the following steps.

m Toner smudges may occur after a paper jam. In most cases, the printer
cleans itself after printing several letter-size pages.

m You may have previously printed using paper that was too small for the
printed document, which may have caused some toner to be deposited
inside the printer instead of on the paper. This can cause smudges on the
paper that goes through later. In most cases, the printer cleans itself after
printing several letter-size pages.
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Faded areas or white voids appear on the page.

If portions of the page are faded or are missing, try the following steps:

m Use different paper or transparency material.

m Use paper that has been in a sealed wrapper; paper that has been out for a
long time may have too much moisture in it.

m Redistribute the toner in the cartridge (see “Replacing the Toner Cartridge”
in Chapter 10).

m Use the Apple Printer Utility for the Mac OS or LaserWriter Utility for
Windows to change the print density to a darker level (see Appendix A).

m Replace the toner cartridge (see “Replacing the Toner Cartridge” in
Chapter 10).

Blotchy areas or ghost images appear on the page.

If there are blotchy areas within a gray area, or if you see ghosting of images
within printed areas (particularly on the top few inches of the page), try the
following step.

m Print two or three more copies of your page; these problems often occur
only on the first rotation of the photosensitive drum inside the printer.

The printer isn’t printing from the correct paper tray.

m Check that the correct page size is selected in the Mac OS or Windows
Page Setup dialog box.
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12 Fixing Other Problems

This chapter provides solutions to problems you may have printing with the
LaserWriter 12/640 PS from Mac OS, Windows, DOS, and UNIX computers.

Troubleshooting with the indicator lights

To diagnose and fix problems by checking the indicator lights on the front of
the printer, see Chapter 11.

Mac OS–based computer troubleshooting

If you are using the LaserWriter 12/640 PS from a Mac OS–based computer,
use this section for troubleshooting tips.

The Chooser does not appear in the Apple (K) menu.

If the Chooser isn’t listed in the Apple menu, the System file on your startup
disk may be outdated, or you may have removed the Chooser from the Apple
Menu Items folder in the System Folder on your startup disk. You can obtain
the current system software from an Apple-authorized dealer.

Make sure that you have only one System Folder on your startup disk.
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No LaserWriter 8 icon appears in the Chooser.

Make sure that the LaserWriter 8 driver is properly installed. The printer
driver may be on your startup disk but may have been moved to the wrong
location. If necessary, drag the driver into the Extensions folder inside the
System Folder.

Also make sure that you have only one System Folder on your startup disk.
Refer to the information that came with your computer.

The printer is not listed in the Chooser.

If you’ve selected the LaserWriter 8 icon but your LaserWriter 12/640 PS is
not named in the list of printers, one of the following may be the cause.

m The printer has been turned off. Make sure it is plugged in and turned on,
and wait for the Ready light to turn on.

m The communications settings are not set correctly. See “Adjusting
Communication Settings” in Chapter 1 and Appendix A. See also
Appendix D for a list of acceptable values. To reset the communications
settings to their factory default values, set the communication switch to the
Reset (out) position. Turn the printer off and back on again. Set the
communication switch to the Normal (in) position.

m Someone may have renamed the printer. Check the startup page to see if
the name has changed.

m If you are using an AppleTalk network that contains zones, you may not
have selected the correct zone for the printer.

m There’s a problem in the network cable system somewhere between your
computer and the printer you want to use. Make sure that all the cables are
properly connected. If you still can’t resolve the problem, the printer’s
electronics or the network connector boxes may not be functioning
properly. Call an Apple-authorized dealer.



m The printer has the same name as other printers on the network. If that’s
the case, the printer automatically appends a number to the end of its name
when it’s turned on. The number may change each time you turn on the
printer. The printer administrator can change the name using the Apple
Printer Utility for the Mac OS or the Apple LaserWriter Utility for
Windows, as described in Appendix A. You can identify your printer by
looking for the printer with the same Ethernet address that is printed on
the startup page.

m Check the Network control panel to make sure the correct network
is selected.

The printer appears more than once in your Chooser (for example, LaserWriter 12/640 PS
and LaserWriter 12/640 PS 1).

Your printer may be connected to a LocalTalk network and an EtherTalk
network with a router that connects them as one logical zone. Apple
recommends that you disconnect the LocalTalk port.

An “out of memory” message appears on your screen when you try to print.

The printer may have insufficient memory to print if

m the document contains too many fonts that need to be downloaded from
your computer to the printer

m the document contains complex images

m you use a lot of fonts in your document but have not selected Unlimited
Downloadable Fonts in the Page Setup Printer Options dialog box

If a page contains very complex images, try to remove some of the complex
detail from that page (or spread the information over two pages) and try again
to print it. Also, find Desktop PrintMonitor in the Extensions folder in the
System Folder and use the Get Info command to increase its memory size.

If you encounter the “out of memory” message frequently, you can remedy
this by increasing the amount of memory in the printer. See Chapter 5.
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Printer-specific options don’t appear in the Print dialog box.

Make sure the hardware options are properly installed in the printer, as
described in Chapter 5.

If the desktop printer extension is turned on, select a desktop printer icon.
Choose Change Setup from the Printing menu, then click Auto Setup in the
dialog box that appears.

If the desktop printer extension is turned off, open the Chooser and click the
LaserWriter 8 icon. Click the Setup button, then click Auto Setup in the
dialog box that appears.

Nothing is printed; no paper comes out of the printer.

If you don’t get any response from the printer when you try to print a
document, try the following steps:

m Make sure you printed to the intended printer.

m Check your desktop printer for error messages. Double-click the desktop
printer icon to open the Desktop PrintMonitor.

m Try printing again, but select the Print Detailed Report option. (Choose the
Print command. Choose PostScript Error Handling, then select Print
Detailed Report.)

m Check the Chooser to be sure the printer is selected. Be sure to select the
printer’s name, as well as the LaserWriter 8 icon and, if necessary, the
AppleTalk network zone.

m Check the Paper Out light. If it is on, add paper and replace the paper
cassette.

m Check for a paper jam as described in Chapter 11.

m Check the network cables.

m Turn the printer off and back on. Check the startup page.

m Reinstall the printer software on your computer’s startup disk.

m Reset the communications settings to their factory default values by setting
the communication switch to the Reset (out) position. Turn the printer off
and back on again. Set the communication switch to the Normal (in)
position.
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A message on the screen says the printer can’t print.

If you get such a message, try these steps:

m Make sure that the printer is turned on.

m Check the network cables.

m Make sure your startup disk has the LaserWriter 8 driver in the Extensions
folder, which is inside the System Folder.

m Make sure the printer is selected in the Chooser. Be sure to select the
printer’s name as well as the LaserWriter 8 icon and, if your network has
zones, the correct AppleTalk network zone.

m Make sure that the printer has paper correctly installed.

Sometimes printing the first page takes longer than I expect.

The LaserWriter 12/640 PS automatically goes into an energy-saving mode
after it’s been idle for a while. When you print while it’s in this mode, the
printer takes about a minute to warm up before it can print the first page.

A desktop printer icon appears again as soon as you drag it to the Trash.

You must always have at least one desktop printer icon. If you drag your last
desktop printer to the Trash, the computer instantly creates another one just
like it. To remove all desktop printer icons, turn off the desktop printing
extension and then restart your computer.

The desktop printer icons appear as folders.

If you restart the computer using a startup disk that doesn’t contain up-to-date
LaserWriter printing software, your desktop printer icons will appear as
folders. Though they won’t work as usual, they will return to normal when
you restart from the correct startup disk. You may also install the software on
the new startup disk.

241Fix ing Other  Problems



The desktop printer icon has an X drawn through it.

The X indicates that the desktop printing software is turned off or the
LaserWriter 8 extension is not in the Extensions folder.

m You may have started the computer using a different startup disk or
temporarily turned off all the software extensions. When you restart the
computer as usual, the icons will return to normal.

m You may have removed the desktop printing software that created the
printer icons. If you meant to do so, you can drag the icons to the Trash or
to any folder outside the Extensions folder. If not, you can reinstall the
software as explained in Chapter 2.

The desktop printing software needs more memory on the computer.

If the Desktop PrintMonitor needs more memory, try closing open windows
and quitting open programs. Each desktop printer that you use also requires
memory, so try reducing the number of desktop printer icons on your desktop
by dragging desktop printers you no longer need to the Trash. You can also
allocate more memory to the Desktop PrintMonitor. To allocate more
memory, open the Extensions folder in your System Folder and select the
Desktop PrintMonitor icon. Choose Get Info from the File menu and enter 
a larger amount of memory in the Preferred Size box, then close the
Get Info box.

I want to turn the manual feed message on or off.

When you install the printer software, the Desktop PrintMonitor is set up to
notify you about manually feeding paper the same way your PrintMonitor
was set. For example, if you turned off notification for manual feeding in your
PrintMonitor, the Desktop PrintMonitor will also have manual feed
notification turned off.

If you want to change how the Desktop PrintMonitor notifies you about
manual feeding, follow this procedure:

1 Select the desktop printer icon.

2 Choose Show Manual Feed Alert from the Printing menu.

A checkmark by this command means that manual feed message is on.
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IBM PC or compatible troubleshooting

If you are using the LaserWriter 12/640 PS from an IBM PC or compatible
computer, use this section for troubleshooting tips.

A message on the screen says the printer can’t print.

If you get such a message, try the following steps.

m Make sure that the printer is turned on.

m Check the network or parallel cables.

m Make sure that the PostScript printer driver has been installed as described
in Chapter 3.

Nothing is printed; no paper comes out of the printer.

If you don’t get any response from the printer when you try to print a
document, try the following steps:

m Check the Installed Printers list to see that your printer is selected. See
Chapter 7 for details about installing and selecting printer driver options.

m Try printing the document again, but choose Download PostScript Error
Handling in the Printer Setup PostScript Options dialog box.

m Check the Paper Out light. If it is on, add paper and replace the paper
cassette. If it is blinking, make sure the paper cassette is securely in place.

m Check for a paper jam as described in Chapter 11.

m Check the printer cables.

m Check the position of the port communication switch as described in
“Adjusting Communication Settings” in Chapter 1. The port may have been
turned off or the Interpreter settings may not be correct.

m Reset the communications settings to their factory default values by setting
the communication switch to the Reset (out) position. Turn the printer off
and back on again. Set the communication switch to the Normal (in)
position.

m Turn the printer off and back on. Check the startup page.

m Reinstall the printer driver. See Chapter 3 for details about installing the
printer driver.
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For Windows 95 users, check the following additional item:

m Open the Printer folder, select the printer, and click Properties. click the
PostScript tab and click the Advanced button. Make sure that ASCII data
and “Send CTRL+D after job” are selected.

For Windows 3.1 users, check the following additional item:

m Open the Printer Control panel, select the printer, and choose Setup. Select
the PostScript tab in the Properties dialog box. Make sure that Protocol
Options is set to Default if using the parallel port, or None if printing
via NetWare.

Sometimes printing the first page takes longer than I expect.

The LaserWriter 12/640 PS automatically goes into an energy-saving mode
after it’s been idle for a while. When you print while it’s in this mode, the
printer takes about a minute to warm up before it can print the first page.

The printer is properly connected and configured, but printing is garbled or displays
unwanted characters.

Check the communication switch and make sure that the Interpreter is set to
the correct value. If you are printing a PostScript document, the Interpreter
mode should be PostScript or AutoSelect.

Novell NetWare troubleshooting

The printer is properly connected, but the printer’s NetWare printer name doesn’t appear
in the Apple LaserWriter Utility’s list of printers to configure.

If you don’t see the printer’s name in the Apple LaserWriter Utility, try the
following steps:

m Make sure you have the right printer model selected.

m Make sure the NetWare file server is running.

m Turn the printer off and then on again. The printer advertises itself to the
NetWare file servers on its network segment for only 5 minutes (after
power-up) to reduce network traffic.
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m Check that the NetWare file server and the printer are on the same
segment of the network. If they are on different segments, you can
configure the printer by specifying the IPX network number and the
ethernet node address. See “Connecting to a Network Printer Manually” in
Appendix A.

m Check the printer’s frame type, printed on the startup page. Make sure it
matches your computer’s frame type or your NetWare file server’s frame
type. If the frame type is different, use the Connect to the Printer Manually
command to change the frame type to the desired value. See “Connecting
to a Network Printer Manually” in Appendix A for more information.

The printer is properly connected and configured, but printing is garbled or displays
unwanted characters.

If your printer is connected to the server through a parallel port connection,
display the PostScript Options dialog box and make sure that Protocol
Options is set to Default. This dialog box is available through the Setup
command in your application’s File menu. See “Additional Printer Options” in
Chapter 7 for more information on protocol options.

My text documents print fine, but I have problems with spreadsheets and graphics.

Try removing the banner page, auto-end capping, tabs expansion, and form
feeds. Use the DOS CAPTURE command to set the following printing
options:

/nb /na /nff /nt /ti=30
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UNIX troubleshooting

If you are using the LaserWriter 12/640 PS from a UNIX workstation, use
this section for troubleshooting tips.

When I print a text file, the lines stairstep off the page.

You need to use a print queue that adds a carriage return at the end of each
line. To set up the print queue, the printer administrator follows the
instructions in “Step 4:  Configuring Users’ Workstations” in Chapter 4. To
learn the names of your local print queues, see your printer administrator, or
look in your /etc/printcap file.

The document generates PostScript errors.

Make sure the language interpreter in the printer’s TCP/IP interface is set
correctly. Sending a text-only document or a PCL5 document when the
language interpreter is set to PostScript will generate PostScript errors.

The document generates a PostScript listing.

Make sure the language interpreter in the printer’s TCP/IP interface is set
correctly. Sending a PostScript document when the language interpreter is set
to PCL5 will generate a PostScript listing.

Banner page generates PostScript errors.

If the administrator sets the TCP/IP interface to interpret everything as
PostScript, he or she must not turn on the banner pages in the
printcap entry.

Banner pages come out as a PostScript listing.

If the administrator sets the TCP/IP interface to interpret everything as PCL5,
he or she must not turn on the banner pages using the TCP/IP Printer
Configuration Utility.

The banner page prints OK but the job that follows comes out as a PostScript listing.

Turn off the banner page in the /etc/printcap file.

The banner page prints only the system name and the remote printer name.

The lpd printing protocol does not provide the user name or filename in a
way that can be included in the banner page.
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The printer administrator forgot the password for the TCP/IP Printer Configuration Utility.

See the service information that came with your printer to learn how to get in
touch with Apple.

Sometimes printing the first page takes longer than I expect.

The LaserWriter 12/640 PS automatically goes into an energy-saving mode
after it’s been idle for a while. When you print while it’s in this mode, the
printer takes about a minute to warm up before it can print the first page.

The RARP server is not responding.

If you chose to use a RARP server to assign the printer’s IP address while
setting up the printer, but the server is not responding, follow these steps 
in order:

m Verify that the rarpd daemon is running on the server. On many
UNIX systems, you can verify this by typing ps -e or ps -ax at the
UNIX prompt on the server. If the daemon isn’t running, type
/usr/etc/rarpd -a to start the daemon.

m Make sure that the server running RARP is on the same subnet as
the printer.

m Check the /etc/ethers file to verify that it contains the correct
Ethernet address and hostname.

m Check the /etc/hosts file to verify that it contains a valid IP address
and the same hostname as in the /etc/ethers file.

m Turn the printer off and then back on.

The BOOTP server is not responding.

If you chose to use a BOOTP server to assign the printer’s IP address while
setting up the printer, but the server is not responding, follow these steps 
in order:

m Make sure that the server running BOOTP is on the same subnet as the
printer or that BOOTP is properly configured to run on multiple subnets.
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m Check the /etc/bootptab file to verify

m that the ip entry is a valid IP address and that it matches the address in
the /etc/hosts file

m the ha entry is the correct Ethernet address (found on the printer’s
startup page) with no colons separating the bytes

m the ht entry is either ether or ethernet

m Turn the printer on and off and immediately verify that the bootpd is
running. On many UNIX systems, you can accomplish this by typing
ps -e or ps -ax at the UNIX prompt on the server. If the daemon is
not running, type bootpd -t15 or consult the UNIX man page on
bootpd.

m Turn the printer off and then back on.

I can’t ping the printer by IP name or IP address.

Follow these steps in order:

m ping your own system or another host. If this ping fails, your IP
software is not running, or your network is down.

m Turn the printer off and then back on. This sometimes fixes the problem
itself, and it also causes the startup page to print. Use the startup page to
verify the printer’s IP address.

m Verify that the IP address on the configuration page is identical to the IP
address in the /etc/hosts file.

m Check the printer’s network cabling to make sure that it is connected to the
network.

m Make sure the IP address is not a duplicate of one already in use on the
network.

I can ping the printer, but I can’t telnet to it.

Only one user at a time can telnet to the printer.
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Though the printer itself has no control panel, you can configure it by using
programs on computers connected to the printer:

m On Mac OS–based computers, use the Apple Printer Utility and the
desktop printer’s setup function.

m On Windows-based computers, use the Apple LaserWriter Utility for
Windows.

m On UNIX-based workstations, log in to the TCP/IP Printer Configuration
Utility using the UNIX telnet program.
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Using the Apple Printer Utility for the Mac OS

The Apple Printer Utility program allows you to set the default settings that
control how various aspects of the LaserWriter 12/640 PS work. Use it to
choose the basic printer settings that you want to use for all documents.

You can also change printer settings without changing the printer’s basic
defaults by changing the settings in the Print and Page Setup dialog boxes.
Network users should use the Print and Page Setup dialog boxes to choose the
individual settings for their documents.

IMPORTANT Changes you make with the Apple Printer Utility affect
everybody who uses the printer.

Use the Apple Printer Utility to

m view information about the printer, such as the AppleTalk printer name and
the total number of pages the LaserWriter 12/640 PS has printed

m name the printer on AppleTalk networks

m download fonts to the printer

m remove fonts

m print font samples

m turn printing of a startup page on or off

m set the print density to lighten or darken printing

m set paper-handling options

m turn the printer’s FinePrint feature on and off

m turn the printer’s PhotoGrade feature on and off

m set when the printer closes print jobs to provide faster throughput

m set the printer’s EtherTalk zone

m view the Ethernet address

m view and specify the IP address

m view and configure the printer’s communication settings

m send PostScript files to the printer

m restart the printer

m print a printer configuration page
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Opening the Apple Printer Utility

The Apple Printer Utility has two windows: the Printer Selector window,
which is similar to the Chooser, and the printer features window, which you
use to view or change the printer’s settings.

1 Double-click the Apple Printer Utility.

The Installer puts the Apple Printer Utility in the Apple LaserWriter Software
folder. You can move it wherever you like.

2 In the Printer Selector window, select and open the printer you want.

If the network has zones, click the 
zone where the printer is located.

Printers in that zone 
are listed here.

Click the name of the 
printer you want.



3 Click Open Printer.

The printer feature window appears with the Printer Information category
displayed.

4 To view or change settings under a category, click the arrow beside the category name
to open the category and display its information and options. 

Additional options may appear that you can also open and work with. When
you are finished changing options in a particular category, you can click the
arrow again to collapse the options.

5 After viewing the information and making changes, click the Send button to send your
changes to the printer.

6 Click the Close box to close the window.

The next sections describe configuration procedures that you can perform
with the Apple Printer Utility. First select and open the printer in the Printer
Selector window. The information and procedures described in each section
then present how to work with the printer features window of the utility.
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Quitting the Apple Printer Utility

To quit the Apple Printer Utility:

m Choose Quit from the File menu.

Viewing printer information

You can view information about your LaserWriter 12/640 PS by displaying
the printer information in the printer features window.

m Open the Printer Information category, if necessary.

Note: The Printer Information category is automatically opened whenever
you open a printer in the Apple Printer Utility.
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Naming the printer

To help users easily select the LaserWriter 12/640 PS printer from their
computers, give the printer a unique name based, for example, on its location
or the group of users who commonly accesses it. Use the following procedure
to name or rename any LaserWriter 12/640 PS printer on the AppleTalk
network.

IMPORTANT Be sure to tell users what the printer name is and what zone it’s
located in.

1 Open the Name category.

The name panel appears with the selected printer’s current name.

2 Type a new name.

3 Click Send to send the new name setting to the printer.
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Downloading fonts to the printer

You can download additional fonts to the printer’s RAM to speed up printing.
You do not have to download fonts to use them in printed documents, but
doing so can make printing faster than storing fonts only on your computer.
Fonts downloaded to the printer’s RAM are lost whenever the printer is
turned off.

1 Open the Fonts category.

The Fonts panel appears.

2 Click Add.

A file selection dialog box appears.

3 Select the fonts you want to download.

Double-click the font name in the list or select the name and click Add.

4 Choose a destination for downloading the fonts from the Destination pop-up menu.

5 Click Send.
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Removing fonts

You can remove fonts from the printer’s memory when you no longer need
them. You cannot remove fonts from the printer’s ROM.

1 Open the Fonts category.

The Fonts panel appears.

2 Select the fonts you want to remove.

3 Click Remove.

4 Click OK.

Printing font samples

You can print a list of the fonts currently stored in the printer’s memory.

m Choose Print Font Samples from the Utilities menu.
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Turning the startup page on or off

The LaserWriter 12/640 PS normally prints a sample page when you turn the
printer on. This page shows the printer’s name, the total number of pages
printed, the amount of memory, installed options, and communication
settings. You can turn this feature off if you wish.

1 Open the Startup Page category.

The Startup Page panel appears.

2 Click the checkbox to turn the startup page on or off.

When an X appears in the checkbox, the printer is set to print the startup page.

3 Click Send to send the startup page setting to the printer.
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Setting the print density

If your documents are printing too light or too dark, you can adjust the print
density of the printer to print lighter or darker text and images.

1 Open the Print Density category.

The Print Density panel appears.

2 Drag the slider to increase or decrease the print density.

3 Click Send to send the Print Density setting to the printer.

Setting paper-handling options

When the LaserWriter 12/640 PS runs out of paper in one tray, it can
automatically switch and use paper in another paper cassette or the
multipurpose tray. By using automatic tray switching between the 250-sheet
paper cassette and the 80-sheet multipurpose tray, you can print 330 sheets
without reloading paper. If you have the optional 500-sheet cassette and
feeder, and it contains the same size paper, automatic tray switching includes
it as a paper source. Combining all three paper sources lets you print up 
to 830 sheets without reloading paper.

Note: The Paper Handling category sets the default paper-handling options
for the LaserWriter 12/640 PS printer. You can change printer settings without
changing the printer’s basic defaults by changing the settings in the Print and
Page Setup dialog boxes. Network users should use the Print and Page Setup
dialog boxes to choose the individual settings for their documents.
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1 Open the Paper Handling category.

The Paper Handling panel appears.

2 Click the checkbox to turn Automatic Tray Switching on or off.

When an X appears in the checkbox, tray switching is turned on.

3 Choose a default paper size for the multipurpose tray from the pop-up menu.

The Print dialog box provides the Auto Select option, which allows the printer
to draw paper from any paper source that holds the correct size paper.
Similarly, the automatic tray switching feature allows the printer to select
another paper source that holds the correct size paper when a paper source
runs out. However, the printer is not able to detect the size of paper you may
have placed in the multipurpose tray, so you must tell it. If the paper size for
the multipurpose tray is the same as the paper in the standard paper cassette
(and automatic tray switching is turned on), the printer automatically uses the
multipurpose tray as a paper source.

4 Choose a default envelope size for the envelope tray from the pop-up menu, if the
envelope cassette option is installed.
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5 Choose printing on one side or both sides of the paper from the pop-up menu.

If you want the binding orientation along the side of the paper (like in a book
or magazine), choose “two-sided, no tumbling.” If you want the binding
orientation along the bottom side of the paper (like in a calendar), choose
“two-sided, with tumbling.”

Note: You must have the optional duplex printing unit to print on both sides
of the paper.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

6 Choose the output tray from the pop-up menu.

Face Down output tray is the default. This tray is located on the top of the
printer and stacks the output media face down.

The Face Up output reduces the curl of your paper by using a “straight-
through” paper path through the printer. This is useful when you print on
heavy media, such as transparencies, envelopes, and postcards.

Note: You can use Face Up output with or without the optional face-up
output tray. However, the face-up output tray stacks the papers neatly in
a tray instead of on the surface where the printer is located.

7 Click Send to send the paper-handling settings to the printer.
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Selecting imaging options

FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting for the FinePrint feature to on or off. Users can
change this setting from the Print Options dialog box. To print high-quality
images with PhotoGrade, turn off FinePrint.

PhotoGrade enhances the look of printed images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. If your LaserWriter 12/640 PS has been upgraded to a minimum of
12 MB of memory, you can use PhotoGrade. You can set the printer’s default
to have PhotoGrade turned on and off.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

You can also change the way images print by increasing or decreasing the
number of gray levels used to reproduce them. More levels of gray produce a
more natural-looking photographic quality. However, increasing the number
of grays also decreases the resolution of the image. For each level of gray, a
unique pattern of laser pulses is required to produce a printed dot. More gray
levels require more variations in such patterns, which in turn require the
printer to use larger, more noticeable dots. You can experiment with various
settings to find the balance that suits your needs.
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1 Open the Imaging Options category.

The Imaging Options panel appears.

2 Click the FinePrint On or Off button.

3 Click the PhotoGrade On or Off button.

4 Drag the slider to change the controls.

5 Click Send to send the Imaging Options setting to the printer.

IMPORTANT When you are printing from a Mac OS–based computer,
PhotoGrade works only when the Color/Grayscale option is selected in the
Print dialog box.
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Setting up job handling

You can specify how the printer handles jobs for each type of network. You
can set the printer to maintain contact with the computer until all pages of a
job are finished printing. This allows users to receive printer messages, such
as a message telling them that the printer is out of paper, while their job is
printing. You can also have the printer break contact with the computer once
the print job has been sent to the printer (but is still being processed). This
provides faster handling of print jobs by allowing the printer to begin
processing the next job before all pages of the previous job are printed.
However, users may not receive feedback about paper outages and problems
such as paper jams until after their job has been processed and the connection
has been broken.

You can set job handling for individual network protocols that you use.

1 Set the communication switch on the printer to the Normal (in) position to select the
custom settings.

The communication switch must be in the Normal (in) position, or the printer
will reset the job-handling settings to the factory defaults when it is turned
off or restarted.

Note: Changing the communication switch setting may alter some of your
network settings. For example, when the switch is in the Reset (out) position,
the default mode for the NetWare, TCP/IP, and parallel interfaces is
AutoSelect; but when the switch is in the Normal (in) position, the mode
could be PostScript, depending on how you set the communication settings.
To change the settings, see “Viewing and Changing Communication Settings,”
later in this appendix.

2 Open the Extended Job Status category.
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3 Click the checkboxes next to the network types to specify when the connection with the
computer should be broken.

4 Click Send to send the job-handling configuration settings to the printer.

Setting the printer’s network zones

You can specify the EtherTalk network zone for the printer.

1 Set the communication switch on the printer to the Normal (in) position.

2 Open the Communication Configuration category.

You see a list of communication settings options.
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3 Open the Printer’s Zone category.

A list of the EtherTalk zones appears.

4 Select the zone you want the printer to appear in.

5 Click Send to send the zone setting to the printer.

Changing TCP/IP configurations

You can specify the IP address of the printer. For information about
determining the printer’s IP address and setting up the printer on a TCP/IP
network, see Chapter 4.

1 Open the Communication Configuration category.

You see a list of communication settings options.
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2 Open the TCP/IP Configuration category.

A panel appears in which you can enter the IP address.

3 Enter the IP address.

4 Drag the slider to set the printer’s subnet mask.

5 Enter the default Gateway Address.

6 Click Send to send the TCP/IP configuration to the printer.

Viewing and changing communication settings

The standard communication settings of the LaserWriter 12/640 PS work for
most environments. To make sure the printer is set up to use the standard
settings, check that the communication switch on the left side of the printer is
in the Normal (in) position. The switch is located below the interface
connectors.

You can view and change the standard communication settings for the printer
with the Apple Printer Utility. The NetWare, TCP/IP, and Parallel interfaces
are set to AutoSelect, which turns on automatic language sensing. Automatic
language sensing allows the printer to receive information over the network
and determine which page-description language—PostScript or PCL5—is
required.
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You make changes to the communication settings with the printer’s
communication switch set in the Normal (in) position. This makes all
communication settings available for changes.

For more information about connecting the printer to LocalTalk, Ethernet,
and parallel ports, see “Connecting the Printer” in Chapter 1. For more
information about setting the communication switch on the printer, see
“Adjusting Communication Settings” in Chapter 1.

1 Set the communication switch on the printer to the Normal (in) position.

2 Open the Communication Configuration category.

You see a list of communication settings options.

3 Open the Port Configuration category.

A list of port connections and protocol choices appears.
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4 Choose the port settings you want.

m The LocalTalk interface is always set to PostScript mode.

m You can set the EtherTalk interface to PostScript mode or turn it off.

m You can set the NetWare interface to PostScript mode, PCL5 mode,
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected), or turn it off.

m You can set the TCP/IP interface to PostScript mode, PCL5 mode,
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected), or turn it off.

m You can set the Parallel interface to PostScript mode, PCL5 mode, or
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected). You can also set the Parallel protocol to normal,
raw, or TBCP.

IMPORTANT If you activate the EtherTalk, NetWare, or TCP/IP interface, the
change does not take effect until the printer is restarted.

5 Click Send to send the communication configuration settings to the printer.

Resetting communication settings

To restore the communication settings to the factory defaults:

1 Set the communication switch on the printer to the Reset (out) position.

Communication
switch
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2 Turn the printer off and back on again.

3 Set the communication switch on the printer to the Normal (in) position.

Sending PostScript files to the printer

You can download PostScript files to the printer to print a PostScript program
or to run a PostScript program to change the internal settings of the printer.
You can create a PostScript file in a variety of text-editing programs or 
by printing any document to a file (just click the File button in the Print
dialog box).

1 Choose Send PostScript File from the Utilities menu.

The Send File dialog box is displayed for the currently selected printer.

2 Select the PostScript file that you want to send to the printer.

3 Click Add.

4 Click Send.

5 In the Save As dialog box, give the PostScript log file a name and path, then click OK.

The Apple Printer Utility uses the PostScript log file to record error
information if an error occurs during printing.

Restarting the printer

You may need to restart the printer to clear its memory if you experience any
problems printing.

1 Choose Restart from the Utilities menu.

A dialog box appears asking you to confirm that you want to restart the
selected printer.
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2 To confirm that you want to restart the printer, click Restart.

When the printer Ready light stops blinking, the printer is ready to print.

The same effect can be achieved by physically turning the printer on and
off again.

IMPORTANT If the LaserWriter 12/640 PS is on a network shared by other
users, make sure that no one is attempting to use the printer when you
restart it. If someone’s printing job is canceled, they must resubmit it.
Manually downloaded fonts are removed from the printer’s RAM when you
restart the printer.

Printing a configuration page

You can print a listing of the current configuration settings and other
information about the printer. This page serves as a reference whenever you
connect a computer to the printer.

m Choose Print Configuration Page from the Utilities menu.

Using the Apple LaserWriter Utility for Windows

The Apple LaserWriter Utility for Windows program lets you change the
default settings that control how various aspects of the printer work. The
utility is placed in the Apple LaserWriter Software program group when the
printer software is installed. Use it to set optional printer parameters that you
want to use for all documents.

IMPORTANT Be sure the printer you want to configure is selected as the default
printer prior to opening the Apple LaserWriter Utility for Windows.

To change printer settings for a specific document (without changing the
printer’s basic default settings), use the Print and Print Setup dialog boxes.
Network users should use the Print and Print Setup dialog boxes to choose
the individual settings for their documents.

270 Appendix  A



Use the Apple LaserWriter Utility for Windows to

m name the printer

m turn printing of a startup page on and off

m set paper-handling options

m print a list of printer fonts

m configure the printer’s communication port settings

m configure the printer for NetWare and TCP/IP

m send PostScript files to the printer

m turn the printer’s FinePrint feature on or off

m turn the printer’s PhotoGrade feature on or off

m print a configuration page

m set the print density to lighten or darken printing

m restart the printer

m print page count

m print Ethernet address

IMPORTANT When you use the Apple LaserWriter Utility for Windows to set a
parameter, the setting is stored in the printer and will be used by all Mac OS,
Windows, and UNIX computers on the network.

Opening and quitting the Apple LaserWriter Utility for Windows

1 Start Windows, if it’s not already running.

2 Start the Apple LaserWriter Utility for Windows.

If you’re using Windows 3.1, go to the Program Manager window and open
the Apple LaserWriter Software program group. Double-click the Apple
LaserWriter Utility icon.

If you’re using Windows 95, click the Start icon on the Task-Bar, and select
Programs, Apple LaserWriter Software, Apple LaserWriter Utility.

3 In the Printer Selector window that appears, select the printer whose setup you want to
change and press OK.

4 When you’re finished using the utility, choose Exit from the File menu.
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Naming the printer on AppleTalk networks

Each LaserWriter 12/640 PS can be given an individual name for AppleTalk
networks. Use the following procedure to rename the LaserWriter 12/640 PS.

1 Choose Name Printer from the Utilities menu. 

The Name Printer dialog box appears.

2 Type the new name.

3 Click OK.

A page prints confirming the printer’s new name.

Be sure to tell users what the printer name is and its location when you install
the printer software on their computers or instruct them to do so.

Turning the startup page on or off

The LaserWriter 12/640 PS normally prints a sample page when you turn the
printer on. This page shows the default NetWare printer’s name, the total
number of pages printed, the amount of memory, and communication settings.
You can turn this feature off if you wish.

1 Choose Set Startup Page from the Utilities menu.

A dialog box appears that allows you to turn the startup page on or off.

2 Click On or Off.

3 Click OK.

A page prints confirming the choice.
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Setting paper-handling options

When the LaserWriter 12/640 PS runs out of paper in one tray, it can
automatically switch and use paper in the paper cassette or multipurpose tray.
By using automatic tray switching between the 250-sheet paper cassette and
the 80-sheet multipurpose tray, you can print 330 sheets without reloading
paper. If you have the optional 500-sheet cassette and feeder, and it contains
the same size paper, automatic tray switching includes it as a paper source.
Combining all three paper sources lets you print up to 830 sheets without
reloading paper.

You can also set the printer to use a particular size paper in the
multipurpose tray.

1 Choose Paper Handling from the Utilities menu.

The Paper Handling dialog box appears.

2 Choose a default paper size for the multipurpose tray.

The Paper Handling dialog box provides the Auto Select option, which allows
the printer to draw paper from any paper source that holds the correct size
paper. Similarly, the automatic tray switching feature allows the printer to
select another paper source that holds the correct size paper when a paper
source runs out. However, the printer is not able to detect the size of paper
you may have placed in the multipurpose tray, so you must tell it. If the paper
size for the multipurpose tray is the same as the paper in the standard paper
cassette (and automatic tray switching is turned on), the printer automatically
uses the multipurpose tray as a paper source.

3 Choose a default envelope size for the envelope tray from the list box, if the envelope
cassette option is installed.

4 Click On or Off to turn Automatic Tray Switching on or off.
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5 Choose the output tray from the list box.

The Face Down output tray is the default. This tray is located on the top of
the printer and stacks the output media face down.

Face Up output reduces the curl of your paper by using a “straight-through”
paper path through the printer. This is useful when you print on heavy media,
such as transparencies, envelopes, and postcards.

Note: You can use Face Up output with or without the optional face-up
output tray. However, the face-up output tray stacks the papers neatly in a tray
instead of on the surface where the printer is located.

6 Choose “two-sided, no tumbling” or “two-side, with tumbling” from the duplex print 
list box.

If your LaserWriter 12/640 PS has been upgraded to a minimum of 12 MB of
memory, and you’ve installed the optional duplex printing unit, you can print
on both sides of the paper.

If you want the binding orientation along the side of the paper (like in a book
or magazine), choose “two-sided, no tumbling” If you want the binding
orientation along the bottom side of the paper (like in a calendar), choose
“two-sided, with tumbling.”

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

7 Click OK.

A page prints confirming the choice.
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Printing a list or samples of printer fonts

You can print a list or samples of the PCL or PostScript fonts currently stored
in the printer’s memory or attached hard disk.

1 Choose Print PostScript Fonts or Print PCL Fonts from the File menu.

For PCL fonts, samples print automatically. For PostScript fonts, the Print
Fonts dialog box appears.

2 Click Print Font Catalog or Print Font Samples.

PostScript font samples or a list of PostScript fonts are printed.

Viewing or changing communication settings

The standard communication settings of the LaserWriter 12/640 PS work for
most environments. To make sure the printer is set up to use the standard
settings, check that the communication switch on the left side of the printer is
in the Normal (in) position. The switch is located below the interface
connectors.

You can view and change the standard communication settings for the printer
with the Apple LaserWriter Utility. The NetWare, TCP/IP, and Parallel
interfaces are set to AutoSelect, which turns on automatic language sensing.
Automatic language sensing allows the printer to receive information over
the network and determine which page-description language—PostScript or
PCL5—is required.
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You make changes to the communication settings with the printer’s
communication switch set in the Normal (in) position. This makes all
communication settings available for changes.

For more information about connecting the printer to LocalTalk, Ethernet,
and parallel ports, see “Connecting the Printer” in Chapter 1. For more
information about setting the communication switch on the printer, see
“Adjusting Communication Settings” in Chapter 1.

1 Choose Configure Port from the Utilities menu.

2 Choose the port settings you want.

m You can set the Parallel interface to PostScript mode, PCL5 mode, or
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected). You can also set the Parallel protocol to normal,
raw, or TBCP.

m The LocalTalk interface is always set to PostScript mode.

m You can set the EtherTalk interface to PostScript mode or turn it off.

m You can set the NetWare interface to PostScript mode, PCL5 mode,
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected), or turn it off.

Communication
switch
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m You can set the TCP/IP interface to PostScript mode, PCL5 mode,
AutoSelect mode (which automatically senses whether PostScript or PCL5
mode should be selected), or turn it off.

IMPORTANT If you select the On mode setting to turn on the EtherTalk,
NetWare, or TCP/IP interface, the change does not take effect until the printer
is turned off and back on again.

3 Click Set Port.

Resetting communication settings

To restore the communication settings to the factory defaults:

1 Set the communication switch on the printer to the Reset (out) position.

2 Turn the printer off and back on again.

3 Set the communication switch on the printer to the Normal (in) position.

Communication
switch

277Set t ing the Pr in ter  Defaul t  Set t ings



Configuring TCP/IP

You can specify the IP address of the printer. For information about
determining the printer’s IP address and setting up the printer on a TCP/IP
network, see Chapter 4.

1 Choose Configure TCP/IP from the Utilities menu.

2 Enter the IP address.

3 Enter the subnet mask.

You can specify a subnet mask only if the printer’s IP address is not 0.0.0.0.

4 Enter the default gateway address.

The IP address of the default gateway is used for sending packets from the
local network.

5 Click OK.

Printing the Ethernet address

To print the printer’s Ethernet address:

m Choose Print Ethernet Address from the Utilities menu.

Sending PostScript files to the printer

You can download PostScript files to the printer to print a PostScript program
or to run a PostScript program to change the internal settings of the
LaserWriter 12/640 PS. A PostScript file can be created in a variety of text-
editing programs.

For more information on setting up the printer for use with Windows and
DOS applications, see Chapter 7.

1 Choose Download PostScript File from the Utilities menu.

A dialog box appears.

2 Select the file you want to download.

3 Click OK.

The file is downloaded to the LaserWriter 12/640 PS.
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Setting imaging options

The LaserWriter Utility allows you to specify some printer imaging options,
including the control of FinePrint and Photograde options and the setting of
screen frequency and angle.

FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting for the FinePrint feature to on or off. Users can
change this setting from the print Properties dialog box. To print high-quality
images, turn off FinePrint.

PhotoGrade enhances the printed look of images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. If your LaserWriter 12/640 PS has been upgraded to a minimum of
12 MB of memory, you can use PhotoGrade. You can set the printer’s default
to have PhotoGrade turned on or off.

If you want to You need this much printer memory

Turn on PhotoGrade or use the 12 MB 
duplex printing option

Turn on PhotoGrade and duplex 20 MB 
print on all size paper (except legal)

Turn on PhotoGrade and duplex 24 MB 
print on all size paper (including legal)

You can also change the way the images print by increasing or decreasing the
number of gray levels used to reproduce them. More levels of gray produce a
more natural-looking photographic quality. However, increasing the number
of grays also decreases the resolution of the image. For each level of gray, a
unique pattern of laser pulses is required to produce a printed dot. More gray
levels require more variations in such patterns, which in turn require the
printer to use larger, more noticeable dots. You can experiment with various
settings to find the balance that suits your needs.
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1 Choose Imaging Options from the Utilities menu.

The Imaging Options dialog box appears.

2 Choose the printer resolution.

3 Click the FinePrint on or off button.

4 Click the PhotoGrade on or off button.

5 Drag the Frequency/Angle slider to set screen angle and resolution.

6 Click OK.

A page prints confirming the choice.

Printing the configuration page

You can print a listing of the current configuration settings and other
information about the printer. This page serves as a reference whenever you
connect a computer to the printer.

m Choose Print Configuration Page from the Utilities menu.

Setting the print density

If your documents are printing too light or too dark, you can adjust the print
density of the printer to print lighter or darker text and images.

1 Choose Print Density from the Utilities menu.

The Print Density dialog box appears.

2 Drag the slider to increase or decrease the print density. 

3 Click Set.

A page prints confirming the choice.
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Printing the page count

The LaserWriter 12/640 PS stores a running total of the number of pages it
has printed. This total is printed on the startup page when you start the
printer (if the startup page option is turned on). You can also print it using
the Apple LaserWriter Utility for Windows.

m Choose Print Page Count from the Utilities menu.

A page prints listing the number of pages printed to date.

Specifying a font symbol set

You can use the Apple LaserWriter Utility to specify a font symbol set for use
in HP LaserJet emulation.

1 Choose Font Symbol Set from the Utilities menu.

The “Specify a Symbol Set” dialog box appears.

2 Select a symbol set from the list box and click OK.

Restarting the printer

You may need to restart the printer to clear its memory if you have any
problems printing. For information on troubleshooting printing problems, see
Chapters 11 and 12.

1 Choose Restart Printer from the Utilities menu.

A dialog box appears, asking you to confirm that you want to restart the
selected printer.

2 Click Restart.

It takes a few minutes for the printer to restart and be ready to print.

The same effect can be achieved by turning the printer off and then on again.

IMPORTANT If the LaserWriter 12/640 PS is on a network shared by other
users, make sure that no one is attempting to use the printer before you
restart it.
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Connecting to a network printer manually

In certain situations you may need to connect to your printer manually before
you can configure it. For example,

m the printer is on a different network segment than the file server

m the printer’s Ethernet frame type is not the frame type that you want to use
(See the “Novell Netware Troubleshooting” section in Chapter 12 for more
information.)

To connect to a network printer manually, follow these steps:

1 Start Windows.

2 Start the Apple LaserWriter Utility for Windows.

3 In the Printer Selection window that appears, select the LaserWriter 12/640 PS printer.

4 Choose “Connect to Network Printer” from the Network menu.

5 Enter the eight-digit IPX Network Number and the Node Address.

The Node Address is the same address as the printer’s 12-digit Ethernet
address. The printer’s Ethernet address is printed on the startup page.

Contact your network administrator if you don’t know the IPX network
number.

6 Once connected, change the printer’s Ethernet frame type to use the frame type that 
you want.

7 Click Send to send the changes to the printer.
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Using the TCP/IP Printer Configuration Utility

You can use telnet, a standard UNIX terminal emulation program, to log
in to the printer’s configuration utility. The changes you make in the utility
affect all printer users on your TCP/IP network—you don’t need to repeat this
process for each workstation on the network. You can use the utility to

m print a configuration page

m show information about the TCP/IP interface

m turn PostScript banner pages on or off for TCP/IP print jobs

m change the printer’s IP address

m set the TCP/IP subnet mask

m identify the default gateway IP address

m enable or disable TCP/IP connection timeout checking

m change the password for this utility

m reset the printer’s TCP/IP interface

m restore all settings to the factory defaults

Logging in to the TCP/IP Printer Configuration Utility

To run the utility, follow these steps:

1 Use telnet to log in to the printer’s TCP/IP Printer Configuration Utility by typing

telnet printer_IP_name

The printer responds by displaying a message on your screen welcoming you
to the Configuration Utility.

2 Enter a password.

The first time you log in to the printer, it requires you to assign a password
to the utility. The password must be between 5 and 10 characters long. The
characters you type will not appear on the screen.

Subsequently, you will need to enter the password to use the utility. The
characters you type will not appear on the screen.

Note: You can change the password using this utility, as explained later in
this appendix.
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Quitting the Configuration Utility

1 Go to the main menu of the TCP/IP Printer Configuration Utility.

2 Press Enter.

3 If you’re asked if you want to save changes, type Y and press Enter to save the
changes, or just press Enter to discard the changes.

Printing the configuration page

The configuration page shows setup information for the printer itself and for
all of the network interfaces.

1 Go to the main menu of the TCP/IP Printer Configuration Utility.

2 Type 1 and press Enter.

Displaying information about the printer’s TCP/IP interface

To see information displayed on your screen about the printer’s TCP/IP
interface, follow these steps:

1 Go to the main menu of the TCP/IP Printer Configuration Utility.

2 Type 2 and press Enter.

Turning the banner page feature on or off

The banner page feature prints an identification page at the beginning of each
document. The banner page is printed using the PostScript page description
language, so turn it on only if the printer’s TCP/IP interface is set up to
receive PostScript language print jobs, as it is by default.

To turn the banner page feature on or off for all jobs sent through the TCP/IP
interface, follow these steps:

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 3 and Enter.

A pair of numbered choices is displayed: one to turn the feature on, the other
to turn it off.

2 Type the number of your choice and press Enter.
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Viewing or changing the printer’s IP address

You must initially set the the printer’s IP address using one of the methods
described in Chapter 4. Subsequently, you can use the TCP/IP Printer
Configuration Utility to change the address or to store it permanently in the
printer’s nonvolatile memory.

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 4 and Enter.

A pair of numbered choices is displayed. The first choice—“Use Network
Protocol”—indicates that you want no IP address stored in the printer; the
second choice indicates that you want to store an address in the printer’s
nonvolatile memory.

. 2 To change the address, press 2 and then Enter.

3 Type the IP address in the following format, then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.

To indicate that you don’t want the printer to have an IP address, type
0.0.0.0 and press Enter. (This is identical to choosing “Use Network
Protocol” in step 1.)

WARNING If your TCP/IP network contains devices with duplicate IP
addresses, you may experience unpredictable network behavior, or your
network may cease to function. Make sure you obtain a valid and
unique IP address for the printer.
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Setting the subnet mask

If your network includes subnets, you can set the subnet mask.

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 5 and Enter.

2 When requested to do so, type the IP address of the subnet mask in the following format,
then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.

To indicate that you don’t want to specify a subnet mask, type 0.0.0.0 and
press Enter.

Setting the default gateway address

If your local network is attached to other networks, you can specify the
IP address of your local gateway. Whenever the printer needs to send
messages to another network, it will use this gateway.

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 6 and Enter.

2 When requested to do so, type the IP address of the gateway in the following format,
then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.

Note: If you enter an invalid address for the gateway or if the gateway goes
down, the printer may not be able to communicate with remote networks.

Enabling or disabling connection timeout checking

The timeout feature automatically severs TCP/IP connections that are idle for
more than 5 minutes. Under most circumstances, you should leave this
function enabled.

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 7 and Enter.

2 Follow the instructions on your screen.

WARNING Use this option with care. If you enter an invalid subnet mask,
you may not be able to access the printer.
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Changing the password for this utility

1 From the main menu of the TCP/IP Printer Configuration Utility menu, press 8 and Enter.

2 When requested to do so, type a 5–10 character password.

The characters you type will not appear on the screen.

Resetting the printer’s TCP/IP interface

If you’re having problems with your TCP/IP connection to the printer and
can’t solve the problem by any other means, you may try resetting the printer’s
TCP/IP interface.

m From the main menu of the TCP/IP Printer Configuration Utility menu, press 9 
and Enter.

IMPORTANT If you reset the printer while a document is printing, it may not
finish printing.

Restoring settings to their factory defaults

To restore the settings to their factory defaults:

m From the main menu of the TCP/IP Printer Configuration Utility menu, press 10 
and Enter.

IMPORTANT If you choose this option while a document is printing, it may not
finish printing.

WARNING This option erases the utility’s password and the printer’s IP
address. You must reset the address as described in “Step 3: Assigning
an IP Address to the Printer” in Chapter 4.
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Setting up your LaserWriter 12/640 PS printer as a remote ATPS
(AppleTalk Print Spooler) printer on a NetWare network requires
minimal configuration; most of the network printing capability is built into
every Mac OS–based computer. With the proper software and physical
connections, a Mac OS–based computer on a NetWare network can print
to a NetWare-managed printing queue that can be selected from the
Mac OS Chooser.

IMPORTANT ATPS is a part of Novell’s NetWare for Macintosh NetWare
Loadable Module (NLM) which must be loaded and configured on your
NetWare server. The configurations described in this appendix can be
performed only after the Mac OS NLM has been installed.
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Configuring ATPS for the first time on a NetWare 4 server

If you are setting up the printer for access by Mac OS–based computers on a
NetWare 4 network and this is the first time you are configuring ATPS, follow
these instructions.

You can configure ATPS from the server console, or by running RCONSOLE
(remote console) from a client computer.

1 At the console prompt, type

load install

The Install utility starts and a list of Installation Options appears.

2 Choose the Maintenance/Selective Install option and press Enter.

An additional list of product options appears.

3 Select Product Options from the list and press Enter.

A list of product options appears. If the NLM is installed and operating, a
NW-MAC option will be available.

4 Select the NW-MAC option and press Enter.

A list of configuration files appears.

5 Select Configure Printer Services and press Enter.

A list of print service configuration options appears.

6 Select Quick Configuration and press Enter.

A list of lookup parameter options appears.

7 Select the Printer Model entry and press Enter.

A list of printer types appears.

8 Select the LaserWriter 12/640 PS option and press Enter.

9 In the lookup parameter list, change the zone name to the zone in which the printer is
currently located.

10 Select the Perform Lookup option and press Enter.
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11 In the list of installed printers, locate and select the newly installed printer from the list.
(It should be identified as “LaserWriter 12/640 PS.”)

12 If necessary, edit the Spooler’s AppleTalk Name field and press Esc to complete 
the setup.

Note: You can also edit information about the print server or spooler. See the
documentation provided with NetWare for more information.

13 Press Esc to exit the utility.

A prompt appears, asking if you want to create a new file.

14 Select Edit SYS:\SYSTEM\AUTOEXEC.BAT from the list of options and press Enter.

A window appears, displaying the field’s contents.

15 Insert the following line after the load afp statement.

load atps

This command instructs the NetWare server to load the ATPS service
automatically at startup time.

16 Press Esc until the Install utility quits.

17 At the service console prompt, type load atps and press Enter.

The service is loaded and immediately becomes available to network users. A
message appears confirming the load, and the console returns to the
command line prompt.

Configuring ATPS for the first time on a NetWare 3.x server

If you are setting up the printer for access by Mac OS–based computers on a
NetWare 3.x network and this is the first time you are configuring ATPS,
follow these instructions.

You can configure ATPS from the server console, or by running RCONSOLE
(remote console) from a client computer.

1 At the console prompt, type

load install

The Install utility starts and a list of Installation Options appears.



2 Select Product Options from the list and press Enter.

A list of product options appears. If the Mac OS NLM is installed and
operating properly, a NW-MAC option will be available.

3 Select the NW-MAC option and press Enter.

A list of configuration files appears.

4 From the list, select the file SYS:\SYSTEM\ATPS.CFG and press Enter.

A prompt appears, asking if you want to create a new file.

5 Type y and press Enter. 

An empty window appears, providing an area in which to enter configuration
information.

6 Enter a line of configuration information for each LaserWriter 12/640 PS printer. (Enclose
the printer name and zone in quotation marks.)

Example

"Sales Printer:Ethernet Zone" 

This example identifies the printer “Sales Printer” located in the zone
“Ethernet Zone.”

You can include a -h option at the end of the line to instruct ATPS to make
the printer unavailable for direct Mac OS printing; that is, the printer will be
accessible only through ATPS queues.

Example

"Sales Printer:Ethernet Zone" -h 

Note: Other ATPS options are available for configuring the printer. See
Novell’s NetWare for Macintosh documentation for more information on these
options.

7 Press Esc to quit editing.

A prompt appears, asking if you want to save your changes.

8 Type y and press Enter.

The list of configuration files reappears.
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9 Select the SYS:\SYSTEM\AUTOEXEC.NCF file and press Enter.

A window appears, displaying the file’s contents.

10 Insert the following line after the load afp statement:

load atps

This command instructs the NetWare server to automatically load the ATPS
service at startup time.

11 Press Esc to exit the editor, then type y and press Enter to confirm the changes.

12 Press Esc three times to exit the Install utility.

13 At the system console prompt, type load atps and press Enter.

The service is loaded and immediately becomes available to network users. A
message appears confirming the load, and the console displays its prompt.

Modifying an existing ATPS configuration on a NetWare 3.x server

The procedure for modifying an existing ATPS configuration is similar to the
procedure for creating a new configuration. The primary difference is that
you are modifying an existing AUTOEXEC.NCF file instead of creating a
new one.

1 At the console prompt, type

load install

The Install utility starts and a list of Installation Options appears.

2 Select Product Options from the list and press Enter.

A list of product options appears. If the NLM is installed and operating
properly, a NW-MAC option will be available.

3 Select the NW-MAC option and press Enter.

A list of configuration files appears.

4 From the list, select the file SYS:\SYSTEM\ATPS.CFG and press Enter.

A prompt appears, asking if you want to create a new file.



5 Type y and press Enter. 

An empty window appears, providing an area for entering configuration
information.

6 Enter a line of configuration information for each LaserWriter 12/640 PS printer. (Enclose
the printer name and zone name in quotation marks.) 

Example

"Sales Printer:Ethernet Zone" 

This example identifies the printer “Sales Printer” located in the zone
“Ethernet Zone.”

You can include a -h option at the end of the line to instruct ATPS to make
the printer unavailable for direct Mac OS printing; this makes the printer
accessible only through ATPS queues.

Example

"Sales Printer:Ethernet Zone" -h 

Note: Other ATPS options are available for configuring the printer. See the
NetWare for Macintosh documentation for more information on these options.

7 Press Esc to quit editing.

A prompt appears, asking if you want to save your changes.

8 Type y and press Enter.

The list of configuration files reappears.

9 Press Esc until the Install utility exits.

10 At the system console prompt, type unload atps and press Enter.

This command unloads the previous version of ATPS configuration. Now you
can reload ATPS using the modified configuration.

11 At the system console prompt, type load atps and press Enter.

The new configuration is immediately available.
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A font is a collection of letters, numbers, and symbols in a distinctive
typographic design. Your Mac OS–based computer and LaserWriter 12/640
PS printer come with a variety of fonts that look great both on your monitor
and on paper.

Fonts come in such a variety of formats that problems can sometimes arise.
This appendix provides the information you need to avoid such problems and
to solve them if they come up.

Kinds of fonts

The Mac OS–based computer works with three main kinds of fonts:
bitmapped, PostScript, and TrueType fonts.

Apple provides two kinds of fonts with your Mac OS–based computer and
the LaserWriter 12/640 PS printer, bitmapped and TrueType. However,
your system can use PostScript fonts as well when it has the proper
software installed.

Appendix C
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Bitmapped fonts

Bitmapped fonts consist of “pictures” of a typeface at specific sizes. For
example, you might have bitmapped fonts at 10-, 12-, and 18-point sizes
installed in your Mac OS–based computer. For best results you need a
separate font file for each size of character you want to use.

The icon of a bitmapped font (also called a fixed-size font or screen font) has
the single letter A on it. The font’s point size appears at the end of its name.

When you request a bitmapped character, your computer looks for an
installed bitmapped font in the size you specified. (See “How the Mac OS
Looks for Fonts,” later in this appendix.) If it can’t find that font, your
computer tries to construct one by scaling a size that it does find.

In most cases, scaled bitmapped fonts don’t look nearly as good as
preinstalled ones. Such scaling is one reason for the jagged edges (sometimes
called “jaggies”) you’ll see on your screen or in a printed document when you
request an uninstalled size (for example, 17-point Geneva).

Bitmapped fonts are designed on grids of 72 dots per inch (dpi)—the
standard Mac OS screen resolution. Because of their correspondence to the
standard screen resolution, bitmapped fonts in preinstalled sizes always look
great on your display.

When you print a bitmapped font, it prints at a resolution of 72 dpi. Because
most modern printers can print at resolutions far better than this (your
LaserWriter 12/640 PS prints at 600 dpi), printed bitmapped fonts almost
always have jagged edges or stairstep sides.

Fortunately, the Mac OS can use bitmapped fonts in combination with other
font formats, reserving bitmaps for the screen and other kinds of fonts for
the printer.
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PostScript fonts

PostScript is a page-description language that defines the characters, symbols,
and images that appear on each page of a document. A PostScript font comes
as a pair of fonts: an outline font for the printer and a corresponding
bitmapped font for displaying type on your screen.

No bitmapped font, no menu entry: If your system doesn’t have the bitmapped
font, the PostScript font name won’t appear in your font menu.

The LaserWriter 12/640 PS is designed specifically to work with PostScript
fonts. Even printers that are not PostScript printers can use PostScript fonts if
you have Adobe Type Manager software installed. Adobe Type Manager uses
printer fonts to generate clean-looking screen text at any size. (Adobe Type
Manager is included with your LaserWriter 12/640 PS software.)

IMPORTANT Adobe Type Manager is not an Apple product. It is made and
supported by Adobe Systems Incorporated. Only the version that comes with
Mac OS system software version 7.5 is supported by Apple.

PostScript printer fonts have no numbers associated with their names,
because a single font can be scaled to any size. Many companies make
PostScript fonts; the following illustration shows icons for Adobe, Bitstream,
and Fontek PostScript fonts, plus a generic PostScript font icon.
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TrueType fonts

A TrueType font is scalable, describing a typeface without rigidly specifying a
size. So it looks good whatever size you choose. TrueType fonts provide sharp
text at any size on screen or on paper. You can mix and match TrueType fonts
from various font vendors.

TrueType fonts store individual text characters as mathematical descriptions
of lines and curves, rather than as groups of pixels (a bitmap). When a
program asks for a character in a particular size, such as 33 points, the
Mac OS uses mathematical calculations to enlarge the character’s outline
to 33 points and fill in the dots for the monitor or printer output.

Sometimes you’ll still get jagged edges when you print a document, even
when you use a TrueType font. In nearly all cases, this is because there isn’t
enough memory available to scale the font properly for printing.

Because you don’t need a separate font for each character size in order for
your printing to look good (as you do with bitmapped fonts), TrueType font
names don’t have numbers in them.
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How does a font look? To see a TrueType or bitmapped font on your screen,
double-click the font’s icon to open it. A sample of that font appears (in three
sizes for TrueType fonts and in the size you opened for bitmapped fonts).

You can also use the Key Caps desk accessory to examine fonts. See the
documentation that came with your computer for instructions.

QuickDraw GX imaging technology

A QuickDraw GX font is a TrueType or PostScript font with an additional set
of sophisticated features. These features include extremely accurate
typographic elements such as ligatures and kerning, plus the ability to skew,
rotate, and add perspective to text in extremely flexible ways.

QuickDraw GX is more than a font format; it’s a sophisticated printing and
display technology that supports complex graphics and advanced typography.
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How TrueType fonts work with other kinds of fonts

Although TrueType fonts offer distinct advantages, your LaserWriter 12/640
PS printer can also use other kinds of fonts.

TrueType and bitmapped fonts

Mac OS–based computers running System 7 come with both bitmapped
(screen) fonts and TrueType fonts installed. This maintains consistency
with documents created on Mac OS–based computers that don’t have
TrueType fonts.

If both a TrueType and bitmapped version of the same font are available, the
Mac OS uses the bitmapped font (providing that the stipulated point size is
present). If you want the Mac OS to use the TrueType font, you need to
remove the bitmapped font from your system.
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For example, if a document uses 12-point Times, available in that size as a
bitmapped font and as a TrueType font, the system uses the bitmapped font. If
a document uses 4-point Times, the system scales the TrueType font to that
size, because a bitmapped version isn’t available.

Using only TrueType fonts produces a closer match between the appearance
of type on the screen and on paper. However, a document you’ve already
created with bitmapped fonts will be reformatted with the corresponding
TrueType fonts, and line breaks in the document may change. Similarly, if a
document is created on a system that has TrueType fonts or Adobe Type
Manager software installed, it may have different spacing, kerning, and so on,
when opened on a system that doesn’t have TrueType fonts or Adobe Type
Manager software.

Keeping two font versions available

If you have a TrueType version of a font, you don’t need a bitmapped version.
However, although keeping both versions of a font takes up more disk space,
there are several advantages to doing so.

Bitmapped fonts are hand-designed: a graphic artist planned each character
in each font to look good on a screen. TrueType fonts are scaled by the
computer to match what you request. At smaller point sizes, the bitmaps may
appear sharper.

Additionally, scaling fonts takes time—sometimes up to several seconds in
slower Mac OS–based computers—but all Mac OS–based computers can
display a bitmapped font instantly.
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TrueType and PostScript fonts

PostScript fonts were designed as fonts for PostScript printers. However, if
you have Adobe Type Manager software installed, your computer can both
display and print PostScript fonts.

Use different names: To avoid confusing the printer software, be sure that you
don’t install both TrueType and PostScript versions of the same font. For
example, do not have a PostScript font file called Times and a TrueType font
file called Times installed in your system at the same time.

How the Mac OS looks for fonts

Here’s the search order the Mac OS uses to determine which font to display
on your screen when you choose a specific size:

1. an installed bitmapped font in that size, if one exists

2. a scaled TrueType font, if no bitmapped font exists

3. an Adobe Type Manager (ATM) version of a PostScript font, if ATM is
installed and if no TrueType version exists

4. a scaled bitmap if no ATM font exists

Here’s the search order it uses to determine which font to print on your
LaserWriter 12/640 PS (or any PostScript printer):

1. the printer’s ROM

2. the printer’s RAM

3. the System Folder where it looks first for a PostScript version of the font,
then TrueType, and finally a bitmap version.
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Where fonts are stored

All fonts for your LaserWriter 12/640 PS printer reside in special places
within the System Folder. To install fonts in System 7, you drag them to the
System Folder. The Mac OS will automatically put them where they belong.

For versions 7.1 and 7.5 of the Mac OS, all the fonts are installed in the Fonts
folder within the System Folder.

The Fonts folder can contain a total of 128 font suitcases (described in the
next section), plus any number of PostScript fonts, up to the available storage
capacity of your hard disk.

IMPORTANT Fonts installed in other folders or in the top level of the System
Folder may not work correctly. Additionally, bitmapped and TrueType fonts
stored outside of suitcases may not work correctly.
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Suitcases

A font suitcase is a special folder for collections of fonts.

Suitcases provide a convenient way to organize fonts in the same font family.
For example, it’s a good idea to use a single suitcase (called Courier) for all
fonts in the Courier font family—all Courier roman fonts as well as fonts
with names like Courier Bold and Courier Oblique.

Note: PostScript fonts won’t go into suitcases; you can, however, organize
TrueType fonts in suitcases.
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Combining suitcases: To merge all the fonts from one suitcase with another,
drag one suitcase on top of the other. All the fonts from the dragged suitcase
will go into the other, and the dragged suitcase will disappear.

Note: To avoid confusion, rename a font suitcase whenever you put more
fonts into it. For example, if you decide to merge Helvetica, Helvetica Black,
and Helvetica Compressed, name the suitcase something like “Helvetica
Regular/Black/Condensed.”

A suitcase can also contain fonts from different font families, although you
should keep all fonts of the same family in the same suitcase. All the fonts
will still appear in menus with their proper names.

You treat a suitcase as you would a folder. To open a suitcase, you double-
click it. To add a font, you drag the font’s icon to the suitcase and drop it in.
To remove a font, you drag its icon out of the suitcase.

To create a font suitcase, duplicate an existing one and throw away its
contents. Then rename the suitcase as appropriate and drag whatever fonts
you want into it.

You cannot have more than 128 font suitcases in the Fonts folder.

Size limits for suitcases: No matter how many fonts you have in a single
suitcase, the Fonts folder counts the suitcase as a single unit. There’s no limit
to the number of fonts in a single suitcase, but the suitcase cannot be larger
than 16 megabytes.

IMPORTANT PostScript fonts cannot be placed in suitcases; they appear as
individual files, loose inside the Fonts folder. Other than the limit imposed by
your system’s memory (RAM), there’s no limit on the number of PostScript
fonts you can have.
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Styled fonts

Most fonts that come with your LaserWriter 12/640 PS printer have defined
styles. For example, if you open the Bookman font (contained in a suitcase in
the Fonts folder, which is inside your System Folder), you see files for bold
and italic versions of the font.

But fonts such as Chicago, Geneva, Monaco, and New York do not come with
defined styles. If you open the Chicago font suitcase, you see only one file.

You can apply a style to a font like this by making a choice from the
appropriate menu (Fonts, Style, Format, or some similar menu, depending on
the application program). A font predesigned with a given style nearly always
looks better than a font with a computer-generated “derived” style.

About style names: Predesigned styled fonts sometimes have names you may
not be familiar with. For example, roman refers to a font without styling, or
plain. Oblique is similar to italic. Light, demi, and extra are different levels
of bold.
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Common questions about fonts

Here are some questions that often come up about fonts.

What kind of fonts should I buy?

Bitmapped fonts are best for screen display but don’t look as good when you
print them. PostScript fonts look great on paper if you have a PostScript
printer or Adobe Type Manager.

TrueType fonts are the best all-purpose fonts to use for your monitor and
non-PostScript printers.

Why don’t all of my fonts appear in the Fonts menu?

You may not have all of your fonts placed correctly. In system software
versions 7.1 and 7.5, all the fonts should be installed in the Fonts folder in the
System Folder.

Additionally, some application programs let the user decide which fonts
should appear in the Fonts menu. Check the manuals that came with your
programs.

Why can’t I see my Monaco 9, Geneva 9 and 12, and Chicago 12 bitmapped fonts?

These fonts are used by your computer to display information. Because the
Mac OS needs these fonts, the Finder makes them invisible to prevent users
from removing them.
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What does the term Apple classic fonts mean?

The Apple classic fonts are the original ten bitmapped fonts that came with
the first Macintosh in 1984. These fonts, which all have city names, include
Athens, Cairo (a picture font), Chicago, Geneva, London, Los Angeles,
Monaco, New York, San Francisco, and Venice. Several of the fonts (Athens,
Cairo, London, and San Francisco) came in only one size—18 points.

Chicago, Geneva, Monaco, and New York are currently available in TrueType
versions. The other classic fonts are still only available in bitmapped versions.

Why do I sometimes get Geneva or Courier in my printed documents when I have
specified other fonts?

Geneva sometimes appears when you’re trying to use a TrueType font but
don’t have enough memory for scaling to operate properly.

Substitute fonts can also appear in a document composed on one Mac OS
computer that has a particular set of fonts but printed on another Mac OS
computer that doesn’t have those fonts.

Why does a document written entirely in Times look different on different Mac OS
computers?

Times, an extremely popular font, is manufactured and sold by more than one
company. Such fonts usually have small differences, even though they have the
same name. For example, the Times font manufactured by Adobe Systems
Incorporated has different letterspacing than does the Times font from
Apple Computer.
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What is font substitution?

Font Substitution is an option in the Page Setup dialog box for certain
PostScript printers. When font substitution is turned on, these printers will
use their built-in equivalents for three bitmapped fonts (Times for New York,
Helvetica for Geneva, and Courier for Monaco).

What’s a downloadable font?

A downloadable font is a TrueType or PostScript font sent to some kinds of
printers, such as most PostScript Laser printers, by your system software. The
printer then uses the font to print your document.

If a printer has sufficient memory, it can hold more than one downloaded
font; otherwise, it must request the fonts it needs as necessary. This can be a
time-consuming process.

Some printers have hard disks attached to them for holding downloaded fonts.
A printer can get the fonts from its hard disk more quickly than it can
download them from the computer’s hard disk.

Your LaserWriter 12/640 PS printer can receive downloaded fonts.
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Specifications

Marking engine

m Fuji Xerox P893 laser-xerographic

Laser

m Type:  Semiconductor laser GaAlAs

m Wavelength:  780 nm

m Output power:  5 mW

Controller

m AMD Am29040 30-MHz RISC microprocessor

m 4 MB of ROM (including 35 Type 1 fonts)

m 4 MB of RAM (expandable to 64 MB)

m 80C186 I/O processor

m 2 KB parameter EEPROM

m LocalTalk port

m Parallel port
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m AAUI Ethernet port with three protocols:

EtherTalk

Novell NetWare IPX (PSERVER or RPRINTER)

TCP/IP (BSD lpd)

m External Ethernet transceivers available for:

Thin Coax (10BASE-2)

Twisted Pair (10BASE-T)

Thick Coax (10BASE-5)

m Two-position communication switch

m All ports/protocols simultaneously active

m 600 dpi resolution

m 600 dpi FinePrint (edge enhancement for text and line art)

m Enhanced 600 dpi grayscale imaging:

Standard

85 lines/inch dithered halftone, 101 gray levels

106 lines/inch dithered halftone, 129 gray levels

141 lines/inch dithered halftone, 73 gray levels

PhotoGrade (with 12 MB of RAM)

85 lines/inch halftone, 201 gray levels

106 lines/inch halftone, 257 gray levels

141 lines/inch halftone, 145 gray levels

m PostScript Level 2 (2015)

m PCL5 (LaserJet IIID emulation)

m Automatic emulation switching
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Printer fonts

Sixty-four fonts are provided with the LaserWriter 12/640 PS, including such
fonts as ITC Avant Garde®, ITC Bookman®, Chicago, Courier, Delphian,
Garamond Condensed, Geneva, Helvetica®, Helvetica Black, Helvetica
Compressed, Helvetica Narrow, Lubalin Graph, Lucida Bright, Machine,
Monaco, Nadianne, New Century Schoolbook, New York, Old English Text,
Onyx, Oxford, Palatino®, Swing, Symbol, Times®, ITC Zapf Chancery®, ITC
Zapf Dingbats®, and Zeal.

The following fonts are resident in the printer ROM:

m AvantGarde Book, AvantGarde BookOblique, AvantGarde Demi,
AvantGarde DemiOblique

m Bookman Demi, Bookman DemiItalic, Bookman Light, Bookman
LightItalic

m Courier, Courier Bold, Courier BoldOblique, Courier Oblique

m Helvetica, Helvetica Bold, Helvetica Bold Oblique, Helvetica Narrow,
Helvetica Narrow Bold, Helvetica Narrow BoldOblique, Helvetica Narrow
Oblique, Helvetica Oblique

m NewCentury Schoolbook Bold, NewCentury Schoolbook BoldItalic,
NewCentury Schoolbook Italic, NewCentury Schoolbook Roman

m Palatino Bold, Palatino BoldItalic, Palatino Italic, Palatino Roman

m Symbol

m Times Bold, Times Bold Italic, Times Italic, Times Roman

m Zapf Chancery MediumItalic

m Zapf Dingbats

The following PCL fonts are resident in the printer ROM:

m Times Roman, Time Bold, Time Italic, Times Bold Italic

m Univers Medium, Univers Medium Bold, Univers Medium Italic, Univers
Medium Bold Italic

m Courier 12 pitch, 10 point Medium; Courier 12 pitch, 10 point Bold;
Courier 12 pitch, 10 point Italic; Courier 10 pitch, 12 point Medium;
Courier 10 pitch, 12 point Bold; Courier 10 pitch, 12 point Italic

m Line Printer Font 16.67 pitch, 8.5 point, Medium



Speed

m Simplex—12 pages per minute maximum using A4-size paper. Actual
speed depends on the images printed.

m Duplex—8 pages per minute maximum using U.S. letter-size paper. Actual
speed depends on the images printed.

Printer reliability (MTBF)

m Average number of prints between failure is 180,000 pages.

Toner cartridge life expectancy

m Life expectancy is 6,000 pages when printing text documents with average
page coverage (5% black). An example of a 5% black page coverage is a
page consisting of double-spaced 14-point courier type. Printing images
and other graphics may impact toner cartridge life expectancy.

Printing materials

16- to 28-pound laser-quality bond (60 to 90 g/m2); up to 50-pound (190 g/m2)
stock when fed manually through the multipurpose tray and exited through
the face-up output tray. Accepts most textured and colored stock. Accepts
medium-weight photocopier transparencies and labels. Envelopes can be
printed from the multipurpose tray or from the optional envelope feeder.

The paper used should not scorch, melt, transfer material, or release
hazardous emissions when heated to 200° C (393° F) for 0.1 seconds.

Paper sizes and capacity

Supports U.S. letter, A4, B5, executive, and legal in the standard paper
cassette. The paper cassette holds 250 sheets of 20-pound (75 g/m2) paper.
The multipurpose tray can hold up to 80 sheets of standard U.S. letter paper,
and other paper sizes from postcard up to U.S. legal. An optional 500-sheet
cassette is available that supports letter, A4, and U.S. legal-paper sizes. An
envelope feeder that can automatically feed up to 50 envelopes is also
available.
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Paper Type Size

U.S. Letter 8-1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Letter Small 8-1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Legal 8-1/2" x 14" (215.9 mm x 355.6 mm)

U.S. Legal Small 8-1/2" x 14" (215.9 mm x 355.6 mm)

A4 8.27" x 11.69" (210 mm x 297 mm)

A4 Small 8.27" x 11.69" (210 mm x 297 mm)

A5 5.84" x 8.26" (148 mm x 210 mm)

Executive 7-1/4" x 10-1/2" (184.2 mm x 266.7 mm)

B5 7.17" x 10.12" (182 mm x 257 mm)

Envelope sizes and weights

Envelope Weight Size

Comm10 24 lb 4 1/8" x 9 1/2" (104.7 mm x 241.3 mm)

Monarch 24 lb 3 7/8" x 7 1/2" (98.4 mm x 190.5 mm)

EuroPostcard 50 lb 4.13" x 5.83" (105 mm x 148 mm)

DL 80 g/m2 110 mm x 220 mm

C5 90 g/m2 162 mm x 229 mm

Dimensions

Printer only

m Height 9.5 in. (24.2 cm)

m Width 15.9 in. (40.5 cm)

m Depth 16.7 in. (42.4 cm)

Printer with optional duplex printing unit

m Height 11.89 in. (30.2 cm)

m Width 15.9 in. (40.5 cm)

m Depth 20.47 in. (52.0 cm)
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Printer with optional 500-sheet cassette and feeder

m Height 14.0 in. (35.6 cm)

m Width 15.9 in. (40.5 cm)

m Depth 16.7 in. (42.4 cm)

Printer with optional duplex printing unit and 500-sheet cassette feeder

m Height 16.2 in. (41.1cm)

m Width 15.9 in. (40.5 cm)

m Depth 20.4 in. (52.0 cm)

Space requirements

Weight

m Approximately 30 lb. (14 kg)

Environmental information

Operating

m Temperature 50° to 90° F (10° to 32° C)

m Humidity 15 to 80 percent RH non-condensing

m Maximum altitude 8,200 feet

About 6 in.
or 15 cm

About 17 in.
or 43 cm

About 7 in.
or 18 cm

Exhaust vent Note: Vertical clearance
is about 14 in. or 36 cm

About 1 in. 
or 2.5 cm



Storage (toner cartridge)

m Temperature 32° to 95° F (0° to 35° C)

m Humidity 15 to 85 percent RH non-condensing

Storage (printer)

m Temperature 32° to 122° F (0° to 40° C)

m Humidity 35 to 85 percent RH non-condensing

Voltage requirements

U.S.

m 103.5 to 126.5 VAC, 58 to 62 Hz 

or Europe/Australia

m 198 to 264 VAC, 48 to 52 Hz

IMPORTANT The LaserWriter 12/640 PS printer does not contain a universal
power supply.

Power consumption

Energy-saving mode

m 26 W

Standby average

m 100/120 V, approximately 125 W

m 220/240 V, approximately 120 W

Operating average

m 110/120 V, approximately 390 W

m 220/240 V, approximately 370 W

Maximum power consumption

m 110/120 V, approximately 790 W, 6.8 A

m 220/240 V, approximately 770 W, 3.5 A
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About PostScript Printer Description (PPD) files

Installing the Mac OS printer software also installs PPD files to support the
following Apple LaserWriter printers:

m LaserWriter

m LaserWriter Plus

m Personal LaserWriter NT

m Personal LaserWriter NTR

m Personal LaserWriter 320

m LaserWriter II NT

m LaserWriter II NTX

m LaserWriter II NTXJ

m LaserWriter IIf

m LaserWriter IIg

m LaserWriter Select 360

m LaserWriter Select 360f

m LaserWriter Select 610

m LaserWriter Pro 400

m LaserWriter Pro 405

m LaserWriter Pro 600

m LaserWriter Pro 630

m LaserWriter Pro 810

m LaserWriter Pro 810f

m LaserWriter 4/600 PS

m LaserWriter 16/600 PS

m LaserWriter 16/600 PSf

m LaserWriter Color 12/600 PS

m LaserWriter 12/640 PS
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You can optionally install the Windows PPD files for these Apple LaserWriter
printers:

m LaserWriter Select 360

m LaserWriter Pro 600

m LaserWriter Pro 630

m LaserWriter Color 12/600 PS

m LaserWriter 16/600 PS

m LaserWriter 12/640 PS

RAM upgrade specifications

To increase the printer’s RAM, purchase SIMMs with the following
specifications:

SIMM dimensions

m Length:  107.95 mm +/- 0.20 mm (4.25 in. +/- .008)

m Height:  25.53 mm (1.005 in.) maximum

SIMM sizes and speeds

Size Configuration Speed Connector type

4 MB SIMM 1 M X 32 bit (one 4 MB bank) 70 ns or less 72-pin

8 MB SIMM 2 M X 32 bit (two 4 MB banks) 70 ns or less 72-pin

16 MB SIMM* 4 M X 32 bit (one 16 MB bank) 70 ns or less 72-pin

32 MB SIMM* 8 M X 32 bit (two 16 MB banks) 70 ns or less 72-pin

* Must have a 2 KB row (11 bit x 11 bit) refresh configuration. 16 MB SIMMs with a 4 KB row (10 bit X 12 bit) refresh
configuration are not compatible with the printer.



Ozone emission

Ozone gas is emitted by almost all laser printers and photocopiers. The
LaserWriter 12/640 PS printer technology allows it to emit practically no
ozone gas (less than .01 parts of ozone per million parts of air). The current
OSHA permissible exposure limit for ozone is 0.1 parts of ozone per million
parts of air (ppm). The ozone emissions from the LaserWriter 12/640 PS
printer comply with Underwriters Laboratory (UL) safety limits.

Depending on the levels of concentration, ozone can be a mild-to-severe
irritant with known effects ranging from dry throat and nose, headache, and
sore eyes to nausea, vomiting, and pulmonary congestion. For this reason
various regulatory agencies have established limits regarding the amount of
ozone to which employees may be exposed. The employer is responsible for
providing a work environment that meets these standards.

You can usually identify ozone by its characteristic odor, even in
concentrations well below the permissible exposure limit. However, as the
concentration of ozone or the duration of exposure increases, your ability to
smell it may decrease.

To minimize ozone exposure, install the LaserWriter 12/640 PS in a well-
ventilated area and keep the equipment properly maintained. If there are
other laser printers or photocopying machines in the same area, additional air
circulation may be required. Do not place the LaserWriter 12/640 PS in a
small, enclosed space that lacks adequate ventilation. Position the printer so
that the fan exhaust does not blow directly into an individual’s face. Finally,
maintain the relative humidity between 30 and 70 percent. Extremely low
humidity can slow the natural breakdown of ozone in the air.
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Communication settings

The following table shows the default communication settings. For
information about using the communication switch to adjust communication
settings, see “Adjusting Communication Settings” in Chapter 1. To change or
view the current communication settings, use the Apple Printer Utility on
Mac OS–based computers or the Apple LaserWriter Utility for Windows on
IBM PC or compatible computers (see Appendix A).

Normal (in) switch position

These settings can be changed to the following modes:

Port Network Protocol Mode Default

LocalTalk LocalTalk PostScript PostScript

Ethernet EtherTalk PostScript, Off PostScript

Netware PostScript, PCL5, AutoSelect, Off AutoSelect

TCP/IP PostScript, PCL5, AutoSelect, Off PostScript

Parallel TBCP PostScript, PCL5, AutoSelect, Off AutoSelect

Normal PostScript, Off PostScript

Raw PostScript, PCL5, AutoSelect, Off AutoSelect

Reset (out) switch position

When the communication switch is in the Reset (out) position, the following
values are used:

Port Network Protocol Mode

LocalTalk LocalTalk PostScript

Ethernet EtherTalk PostScript

NetWare AutoSelect

TCP/IP PostScript

Parallel Parallel AutoSelect (raw protocol)

Note: When the communication switch is in the Reset (out) position, a
startup page is printed each time the printer is turned on and the Extended
Job Status settings are removed.
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Accessories

In the U.S.A., to locate your local Apple-authorized reseller, call
1-800-538-9696.

In the U.S.A., you can order LaserWriter 12/640 PS supplies direct from
Apple by calling 1-800-600-7805.

Item Part Number

Apple Ethernet Thin Coax Transceiver M0329Z/B

Apple Ethernet Twisted Pair Transceiver M0437Z/B

Apple Ethernet AUI Adapter M0432LL/A

LaserWriter 12/640 PS Toner Cartridge M4683G/A

LaserWriter 12/640 PS 500-Sheet Cassette and Feeder M4682G/A

LaserWriter 12/640 PS Envelope Cassette M4680G/A

LaserWriter 12/640 PS Face-Up Output Tray M4698G/A

LaserWriter 12/640 PS Duplex Printing Unit M4697G/A
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263–264
for the Mac OS  25, 28
naming the printer  254
opening  251–252
printing a configuration page  270
printing font samples  256
quitting  253
removing fonts  256
restarting the printer  269–270
selecting FinePrint or PhotoGrade

options  261–262
sending PostScript files to printer  269
setting

network zones and names  38,
264–266

print density  258
turning startup page on or off  257
viewing

and changing communication
settings  266–269

printer information  253
AppleTalk Print Spooler. See ATPS
AppleTalk protocol  20–21
ASCII format

saving print files as  140
selecting (Windows 95)  185
setting printer to receive 

(Windows 3.1)  163
ATPS (AppleTalk Print Spooler)

configuring for first time
on NetWare 3.x server  291–293
on NetWare 4 server  290–291

installing Mac OS NLM and  289

modifying existing configuration
(NetWare 3.x server)  293–294

setting up a printer as  63
automatic language sensing  96
automatic tray switching

setting options
in Apple LaserWriter Utility for

Windows  273–274
in Apple Printer Utility  201,

258–260
for Windows 95  182, 183
for Windows 3.1  163

Auto Select printing feature  201
A/UX workstations  84–86
avoiding paper jams  198, 232

B

background printing  140–141
Background Printing dialog box  141
banner pages

troubleshooting for UNIX
workstations  246

turning on or off  284
bidirectional printer support  191
binary format

printing to files as (Mac OS)  140
selecting (Windows 95)  185
sending PostScript files in 

(Windows 3.1)  159, 170
setting printer mode for 

(Windows 3.1)  163
binding orientation, selecting for duplex

printing  139,179
bitmap compression  185
bitmapped font icon  296
bitmapped fonts

about  296
alignment options for  131
using TrueType fonts with  300–301

blank documents  234
BOOTP (Bootstrap Protocol)

assigning IP addresses through  79–80
troubleshooting servers with  247–248
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C

cables
Apple Ethernet thin coaxial

transceiver  20, 322
Apple Ethernet twisted-pair

transceiver  20, 322
for LocalTalk kit  6, 17
obtaining network  6
safety precautions for  4

canceling printing
on Mac OS computers  148
timeouts and

Windows 95  184, 190
Windows 3.1  159

capacities of cassettes and multipurpose
tray  2, 12, 314

CAPTURE command
(Novell NetWare)  172

capturing
a port (Windows 95)  190
the queue (DOS-based printing)  172

CD-ROM disc. See Apple LaserWriter
CD-ROM disc

children, safety precautions for  4
Chooser

not on Apple menu  237
printer

appears more than once in  239
not listed in  238–239

selecting
network zones for printers  36
printer using  146

choosing a printer IP name  80–81
cleaning the printer

exterior  224
safety precautions for  4
solvents for  2, 224

closing the top cover  11
color

options for matching 
(Windows 3.1)  158, 159

specifying for watermarks
in Windows 95  188
in Windows 3.1  166

Color Matching dialog box  134, 136
communication settings

changing
for UNIX workstations  96
and viewing with Apple

LaserWriter Utility for Windows
275–277

and viewing with Apple Printer
Utility  266–269

communication switch position 
and  321

customizing  27–28
communication switch

communication settings and  321
location of  16, 27
restoring communication settings

for Apple LaserWriter Utility for
Windows  277

for Apple Printer Utility  268–269
settings

for Apple LaserWriter Utility 
for Windows  276

for Apple Printer Utility  263
configuring the printer

in Mac OS  36–37
making changes to printer setup  38
for newly installed options

for Mac OS computers  124–126
for Windows computers  127

for PSERVER mode  63–64, 68
setting defaults

with Mac OS computers  250–270
for Windows computers  25, 28,

270–282
for UNIX workstations  95

configuring workstations  82–95
for HP-UX version 8.07  86–89
for HP-UX version 9.x  89–91
IBM AIX version 3.x  93–94
for SCO UNIX  91–93



Silicon Graphics IRIX  95
for Sun OS version 4.1, Ultrix, A/UX,

or other BSD systems  84–86
for Sun Solaris  83

connecting
the power  24–26
the printer

to Ethernet network  20–22
to LocalTalk network  17–18
for Mac OS computers  16, 19–20
manually with Apple LaserWriter

Utility for Windows  282
for UNIX workstations  16
to Windows or DOS with parallel

interface cable  22–23
controller specifications  311–312
Control Panel

opening the printer Setup dialog box
from  155

setting printing options (Windows 95)
175–176

copies
specifying for Windows 95  178
specifying number per document page

(Windows 3.1)  157
Cover Page dialog box  135
cover pages, printing automatically

134–135
covers

closing  11
opening the top  6
removing

the side  118–119
top and bottom  102–103

replacing the side  123–124
creating

installation floppy disks
for Mac OS computers  32–31
for Windows 95 computers  52–53
for Windows 3.1 computers  53

a printer in PSERVER mode  66–67
a printer server in PSERVER 

mode  65
a print queue in PSERVER mode  67

Ctrl-D protocol option
for Windows 95 computers  185–186
for Windows 3.1 computers  159

curling problems  141, 196, 233
Custom Installation option (Windows)

48, 50, 57
Custom Install option (Mac OS)  31, 35

D

default desktop icon  145, 147
default gateway address, setting  286
default printer  37

icon for  147
methods for changing  145–146

De-Install option  57
desktop printer

deleting  37
printing (Mac OS computers)  144
removing software from Mac OS

computers  151
desktop printer icons

deleting  37
dragging documents to  144, 145
selecting printers using  146
solving problems with  241–242
working with  147

Desktop PrintMonitor
manual feed notification for  242
turning off for Mac OS 

computers  150
Detail tab dialog box  190–191
Device Options tab dialog box  181–182
disabled desktop icon  147
disk space requirements

for fonts and software  30
for installation

on Windows 95 computers  45
on Windows 3.1 computers  46

distorted print images  235–236
documents

blank  234
dragging to desktop printer icon

144, 145
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grayscale  135–136, 233, 234
printing

with Mac OS computers  132–134
to PostScript or EPS file  139–140,

157, 169–172
with UNIX workstations  97
from Windows 95 computers  175

problems printing  39, 233–236
DOS-based printing

capturing the queue for  172
setting up for  46
troubleshooting tips for  243–244
from Windows applications  154–166

DOS PostScript driver  46
downloading fonts

about  309
with Apple Printer Utility  255
Unlimited Downloadable Fonts 

option  131
for Windows 3.1 computers  164,

166–168
dragging

documents to desktop printer icon
144, 145

drivers. See printer drivers
duplex printing

on letterhead paper  199
multipurpose tray and  199
selecting

with Apple LaserWriter Utility 
for Windows  162, 179, 274

with Apple Printer Utility  260
duplex printing key  102
duplex printing unit

checking for paper jams  231–232
face-up output tray installation for

114–115
installing  11, 100–107
memory requirements for  100
output and  141
paper guide installation for  103–104
part number for  322
problems with  235
RAM requirements for PhotoGrade

option with  100, 118, 137, 138

E

Easy Install option (Mac OS)  31
energy-saving feature

power consumption for  317
using  26
warm-up time and  241, 244, 247

envelope cassette
capacity of  314
filling  211–212
inserting in  500-sheet feeder  212
installing  11, 112
part number for  322

envelopes
avoiding jams with  212
compatible sizes of  211
directing to face-up tray  196
loading in multipurpose tray

201–202, 205–206
printing  206–207
technical specifications for  315
unacceptable types of  205

EPS (encapsulated PostScript) files
printing

Mac OS  139–140
Windows 3.1  157, 169–172

saving  169
selecting format (Windows 3.1)  157

error desktop icon  147
errors

handling PostScript  164
reporting  142–143

/etc/printcap file, adding entries to  85, 92
Ethernet

configurations for connecting to
20–22

printing address for printer  278
transceivers and cables for  6
verifying frame types for  68

Ethernet hub  21
Ethernet port  16
Express Installation option (Windows)

48, 50, 57
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F

face-down output tray  260
face-up output

reducing curl and wrinkles 
with  141, 196

selecting
with Apple LaserWriter Utility 

for Windows  274
with Apple Printer Utility  260

face-up output tray
advantages of  260
on duplex printing unit  114–115
installing  11, 113–114
part number for  322
removing  116

FAX ports  191
Features tab dialog box  162–163
File menu (Windows 3.1)  156
files. See also ASCII format; binary

format; PostScript files
formatting options for PostScript  140

Mac OS  139–140
Windows 95  183, 184
Windows 3.1  157, 163, 170

printing
PDF documentation  xv
test files  39, 74

support for PPD  318
FinePrint option

for Mac OS computers  136–138
turning on or off

with Apple LaserWriter Utility 
for Windows  279–280

with Apple Printer Utility  261–262
for Windows 95  181, 183
for Windows 3.1  163

First page from option 
(Print dialog box)  133

500-sheet cassette and feeder. See also
automatic tray switching

capacity of  314
checking for paper jams  230
installing  108–111

loading  214–215
part number for  322
as preferred paper source  126
removing  101, 111
software indicator for  162

fixing roller assembly  218
Flip Horizontal option 

(PostScript dialog box)  131
Flip Vertical option 

(PostScript dialog box)  131
floppy disks

creating from CD-ROM disc
for Mac OS  32–31
for Windows 95  52–53
for Windows 3.1  53

for installing printer software
on Mac OS  33–35
on Windows 95  53–56
on Windows 3.1  56–58

preparing a Mac OS server using
40–41

Font Downloader  167
Font inclusion option (PostScript Printer

Options dialog box)  140
fonts  295–309. See also font

substitution; PostScript fonts;
TrueType fonts

bitmapped  296
buying  307
common questions about  307–309
disk space

increasing RAM and  116
requirements for  30

downloading
with Apple Printer Utility  255
for Windows 3.1 computers  164,

166–168
how Mac OS looks for  302
PostScript  1, 297, 302
printing samples

with Apple LaserWriter Utility 
for Windows  275

with Apple Printer Utility  256
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QuickDraw GX imaging 
technology  299

removing
with Apple Printer Utility  256
from printer RAM  116–124

selecting for watermarks
in Windows 95  187
in Windows 3.1  165

specifications for  313
specifying symbol sets  281
storing  303
styled  306
suitcases for  304–305
TrueType

about  298–299
support for  1
using with bitmapped fonts

300–301
using with PostScript fonts  302

types of
for Mac OS computer  295
for Windows 3.1  160–161

Unlimited Downloadable Fonts 
option  131

Fonts category (Apple Printer 
Utility)  255

Fonts menu, displaying fonts on  307
Fonts Substitution Table 

(Windows 95)  188
Fonts tab dialog box

for Windows 95  188–189
for Windows 3.1  160–161

font substitution
common questions about  308, 309
with Mac OS  131
with Windows 95  188–189
with Windows 3.1  160–161

foreground printing for watermarks
(Windows 3.1)  166

functions
of Apple LaserWriter Utility for

Windows  270–271
of Apple Printer Utility  250
of Installer  32

G

garbled printing  244, 245
gateway address  286
General tab dialog box 

(Windows 95)  189
Get Printer Info  150
graphics

increasing RAM and  116
selecting options on Windows 95

180–181
troubleshooting printing for  245

grayscale documents
printing with Mac OS computers

135–136
problems with  233, 234

grounding
power plugs  3
wrist straps  117, 120

H

halftones  180
Hold Job button  148
HP-UX version 8.07 workstations  86–89
HP-UX version 9.x workstations  89–91
humidity

operating ranges for  316–315
protecting printer from water and  3–4

I

IBM AIX version 3.x workstations
configuring  93–94
running the SMIT utility  93

ICMP Echo Request Packet  80
icons

for bitmapped font  296
for default printer  145
determining printer status with  147
dragging documents to desktop printer

144, 145
Installer  34
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LaserWriter Disk 1  41
LaserWriter 12/640 PS  37
for PostScript fonts  297

Imaging Options category (Apple Printer
Utility)  262

Imaging Options dialog box 
(Mac OS)  137

increasing printer RAM  116–124
installation floppy disks

creating
for Mac OS  32–31
for Windows 95 computers  52–53
for Windows 3.1 computers  53

Installer icon  34
Installer program

choosing Custom Install  35
function of  32

installing
the duplex printing unit  100–107
envelope cassette  112
the face-up output tray  113–116
the first toner cartridge  8–11
500-sheet cassette and feeder

108–111
LaserWriter 12/640 PS options  11
paper guide, for duplex printing unit

103–104
PPD file support  318–319
printer RAM  117
printer software

from a CD-ROM disc  31–32,
47–49, 50–51

creating installation floppy disks
32–31, 52–53

from floppy disks  33–35, 53–58
from a Mac OS server  42
onto a Mac OS server  40–41
SIMMs  121–123
Type 1 fonts  75
for UNIX workstations  78
onto a Windows 95 server  52
onto a Windows 3.1 server  52

on Windows NT 3.5–based server
or non-Intel computer  61–62

on Windows NT 3.5x workstations
59–60

on Windows NT 4.0–based
computers  60

Invert Image option (PostScript dialog
box)  131

IP addresses  79–83
assigning  78, 79–82

with Apple LaserWriter Utility for
Windows  278

with Apple Printer Utility  265–266
viewing or changing for printer

(TCP/IP Printer
Configuration Utility)  285

J, K

Job Control tab dialog box 
(Windows 3.1)  163–164

job handling, for network protocols
263–264

job timeouts
in Windows 95  184, 190
in Windows 3.1  159

key commands for PCONSOLE  64

L

labels  208
Landscape view

for Windows 95  177
for Windows 3.1  157

laser specifications  311
LaserWriter Disk 1 icon  41
LaserWriter 8 icon, not in Chooser  238
LaserWriter Setup dialog box

changing paper sources  126
changing software for printer 

options  125
LaserWriter 12/640 PS  1–28
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adjusting communication settings
27–28

choosing a location for  2, 101, 108
connecting  16–23

to Ethernet network  20–22
to LocalTalk network  17–18
to Novell NetWare 4.1 networks

62–74
the power and turning on the

printer  24–26
to single Mac OS–based computer

19–20
to Windows or DOS with parallel

interface cable  22–23
deleting a desktop printer  37
features of  1–2
front, rear, and sides of  100
height, width, and depth of  315
installing

the first toner cartridge  8–11
printer options for  99–127

loading paper cassettes  12–15
maintenance  217–224
naming  36
print resolution of  1, 180, 312
removing the covers  102–103
safety instructions for  3–4
speed of  1, 314
technical specifications for  311–317
unpacking  5–7

LaserWriter 12/640 PS icon  37
LaserWriter Utility for Windows

assigning IP addresses using  79, 82
defining paper size in multipurpose

tray  201
Layout dialog box  139
layout options

for Windows 95  177
for Windows 3.1  157

letterhead paper
duplex printing on  199
loading  14

in the 500-sheet cassette  213
in multipurpose tray  201, 202, 204

loading the printer  195–215
compatible paper sizes and  196
envelope cassette  211–212
envelopes (multipurpose tray)

205–206
500-sheet cassette  214–215
labels  208
letterhead  201, 202, 204
three-hole punched paper  203
transparencies  208
paper cassette  12–15

for legal and other size paper  198
for letterhead and three-hole

punched paper  14, 199
for letter-sized paper  197–198

paper quality and print quality  210
postcards  212–213

LocalTalk network
connecting  17–18
connecting kit for  6, 17

LocalTalk port  16, 19
locating the LaserWriter 12/640 PS  2

with duplex printing unit added  101
with 500-sheet cassette and feeder

installed  108
logging in, to TCP/IP Printer

Configuration Utility  283
lpd daemon, verifying operations of  84

M

Mac OS computers  29–43, 129–152
configuring the printer  39, 250–270

making changes to  151–152
new options  125–126
setting options for printing  134

connecting the printer for  16
determining printer status from its

icon  147
installing printer software  31–35

from the CD-ROM disc  31–32
creating installation floppy disks

for  32–31
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from the installation 
floppy disks  33–35

from a server  42
onto a server  40–41

kinds of fonts for  295
Mac OS NLM installation  289
PPD file support and  318
printers

choosing for  35–38
naming and setting zones for  38
setting up as ATPS remote

289–294
switching between  145–146
testing  39

printing
background  140–141
on both sides of paper  138–139
controlling functions for  129
cover pages automatically

134–135
with desktop printer  144
documents with  132–134
envelopes  207
with FinePrint or PhotoGrade

options  136–138
grayscale documents  135–136
monitoring  148–150
to a PostScript or EPS file

139–140
reporting errors in  142–143

problems with margins on  233
removing desktop printing 

software  151
searching for fonts on  302
selecting

the output tray  141–142
page setup options  130–132

system requirements for  30
troubleshooting for  237–242
using Apple Printer Utility 

program  152

maintenance  217–224
cleaning the exterior  224
precautions during  219
replacing the toner cartridge  219–224
safety tips for  218

manual, onscreen  xv
manual feed alerts

changing  150
turning message on or off  242

Manual Feed paper source  133
manual-feed printing  202
margins

designating unprintable areas
(Windows 95)  178

options for  159
problems with  233

marking engine specifications  311
memory. See also printer RAM; SIMMs

checking printer (Windows 3.1)  162
flashing status lights and  226
increasing printer RAM  116–124
“out of memory” message  239
removing fonts from printer 

RAM  256
requirements

for duplex printing  100
for Mac OS computers  30

specifying available printer 
(Windows 95)  182

when to install  11
mirror images (Windows 95)  181
monitoring printing  148–150, 242
moving print requests to 

another printer  149
multiplatform support. See also Mac OS

computers; UNIX workstations; 
Windows 95 computers;
Windows 3.1 computers

communications settings for network
protocols  321

connecting the printer and  16
network protocols supported  312

multiple paper sources  133
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multipurpose tray  199–209. See also
automatic tray switching

capacities of  2, 12, 202, 314
loading  201–202

envelopes in  205–206
labels in  208
letterhead in  201, 202, 204
three-hole punched paper in  203
transparencies in  208

opening  200
removing during paper jams  229
uses for  199

N

naming the LaserWriter 12/640 PS
36, 38

with Apple LaserWriter Utility 
for Windows  272

with Apple Printer Utility  254
choosing a printer IP name  80–81

negative images, specifying 
(Windows 95)  181

NetWare Directory Services (NDS),
incompatibility with  62

NetWare for Macintosh, installing 
Mac OS NLM  289

network client software  45
network protocols

job handling for  263–264
ports for  16

networks
connecting printers

to Ethernet  20–22
to LocalTalk  17–18
manually with Apple LaserWriter

Utility for Windows  282
obtaining cables for  6
setting up LaserWriter 12/640 PS 

for Novell NetWare  62–74
sharing printers on  192–193

network zones
choosing for printers  36
setting with Apple Printer 

Utility  38, 264–266
Novell NetWare 4.1  62–74

assigning passwords for print 
servers  72–73

CAPTURE command  172
choosing an operating mode  63–64
connecting Ethernet with  20–21
PCONSOLE key commands  64
processor requirements for  46
setting up PostScript printer driver

for Windows 95  73–74
for Windows 3.1  74

setting up the printer
as print server 

(using PCONSOLE)  65–69
as remote printer 

(RPRINTER mode)  69–72
troubleshooting for  244–245

O

opening
Apple LaserWriter Utility 

for Windows  271
the Apple Printer Utility  251–252
multipurpose tray  200
the top cover  6

operating and storing 
temperatures  316–315

“out of memory” message  239
output trays. See also face-up output tray

face-up and face-down  260
installing face-up  11, 113–114
selecting for Mac OS computers

141–142
selecting for Windows 95  179
software indicator for in 

Windows 3.1  162
ozone emission  320
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P

page count  281
Page Setup dialog box (Mac OS)

130–132
page setup options

for Mac OS  130–132
for Windows 95  174
for Windows 3.1  154

“Pages per Sheet” pop-up menu (Layout
dialog box)  139

paper
loading in multipurpose tray  201–202
loading letterhead and three-hole

punched  14
quality of  210
recommended weight of  195, 210
reducing curling when you print  141,

196, 233
technical specifications for  314
types and sizes of  12
US Letter Small or US Legal Small

options for  130
paper cassettes. See also automatic

tray switching
capacities  2, 12, 314
compatible paper sizes for  196
installing  11
loading  12–15

legal and other size paper  198
letterhead  14, 199, 201, 202, 

204, 213
letter-sized paper  197–198
three-hole punched paper  14, 199,

203, 213
removing during paper jams  228

paper guide, for duplex printing unit
103–104

Paper Handling category (Apple Printer
Utility)  258–260

paper-handling options
setting for Apple LaserWriter Utility

for Windows  273–274
setting in Apple Printer Utility

258–260

Paper Jam light  26, 226
paper jams  225–232

avoiding  198, 232
checking

for and clearing  227–229
duplex printing unit  231–232
500-sheet cassette and feeder  230
status lights  226

when printing labels  208
with envelopes  212
with transparencies  209

paper orientation
selecting options

for Mac OS  130
for Windows 95  177
for Windows 3.1  157

Paper Out light  26
operating status and  226
printing envelopes and  207

paper size
compatible  196
selecting options

for Mac OS  130
for Windows 95  177
for Windows 3.1  157

technical specifications for  314, 315
paper source

changing  126
multiple  133
selecting  157

with Apple LaserWriter Utility 
for Windows  273–274

with Apple Printer Utility  258–260
for Windows 95  178

switching  142
Paper tab dialog box

options for Windows 95  177–179
options for Windows 3.1  157

parallel interface cables  6
connecting to Windows or DOS with

22–23
parallel port

connecting printer to  23
location of  16
printing from  46
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passwords
assigning for print server  72–73
for TCP/IP Printer Configuration

Utility  247, 287
PCONSOLE utility 

(Novell NetWare)  62
assigning passwords in  72–73
setting up the printer as print server

using  65–69
using  64

PhotoGrade option
for Mac OS computers  136–138
problems with grayscale 

documents  233
RAM requirements for  100, 118, 

137, 138
selecting

with Apple LaserWriter Utility for
Windows  279–280

with Apple Printer Utility  261–262
turning on and off

in Windows 95  181, 182
in Windows 3.1  162

ping command
setting IP addresses and  79, 80–81
testing connections with  86, 88, 90
troubleshooting with  248

placing printing requests on hold  149
plain desktop icon  147
Port Configuration category (Apple

Printer Utility)  267–268
Portrait view

for Windows 95  177
for Windows 3.1 computers  157

ports
capturing  190
choosing settings for

with Apple LaserWriter Utility for
Windows  276–277

with Apple Printer Utility  268
FAX  191
mapping LPT1 to a queue  172
parallel  23
printer  19

and protocols for networks  16
specifying for printers

on Windows 95  190–191
on Windows 3.1 computers  51

positioning watermarks
in Windows 95  188
in Windows 3.1  166

postcard guide  211, 212
postcards

directing to face-up tray  196
loading  212–213

PostScript
specifying language level for

(Windows 95)  185
troubleshooting for UNIX

workstations  246
PostScript error handlers 

(Windows 3.1)  164
PostScript files

formatting options
for Mac OS  139–140
for Windows 95  183–186
for Windows 3.1  159, 169–172

printing as text (Mac OS)  145
reporting printing errors on  142–143
selecting options for  131, 158–159
sending to printer

with Apple LaserWriter Utility for
Windows  278

with Apple Printer Utility  269
PostScript font icons  297
PostScript fonts  1

about  297
organizing  304, 305
substituting for TrueType fonts

for Windows 95  188–189
for Windows 3.1  160–161

PostScript headers
in Windows 95  184
in Windows 3.1  164

PostScript Options dialog box 
(Mac OS)  131

PostScript Printer Description (PPD) files
318–319
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PostScript printer driver
for DOS  46
for Windows 95  73–74
for Windows 3.1  74

PostScript Printer Options dialog 
box  140

PostScript tab dialog box
for Windows 95  183–186
for Windows 3.1  158–159

power consumption  317
power cord

grounding the plug  3
plugging in the printer  24
unpacking  5

power switch
On and Off positions  24
turning on the printer  25

previewing screen, option for  157
print density

adjusting  234
setting

with Apple LaserWriter Utility for
Windows  280

with Apple Printer Utility  258
Print Density category (Apple Printer

Utility)  258
Print dialog box, options don’t appear 

in  240
printer configuration page

for Apple LaserWriter Utility for
Windows  280

for Apple Printer Utility  270
for TCP/IP Printer Configuration

Utility  284
Printer Driver Only option (Welcome

dialog box)  48, 50, 57
printer drivers

displaying alerts with incompatible
(Windows 95)  186

PostScript
DOS  46
Windows 95 and 3.1  73–74

setting options for DOS and 
Windows 3.1  155–157

Printer folder
opening Properties dialog box from

(Windows 95)  183, 184, 188,
189, 190–191, 192

setting printing properties with
(Windows 95)  175, 176

printer font specifications  313
Printer Information category (Apple

Printer Utility)  252, 253
printer options  99–127

configuring
printer software for  124–127
for Windows 95  127

increasing printer RAM  116–124
installing

the duplex printing unit  100–107
envelope cassette  11, 112
the face-up output tray  113–116
500-sheet cassette and feeder

108–111
selecting for Windows 3.1  156–166

Printer Options dialog box  142
printer port  19
printer RAM  116–124

advantages of increased  116
configurations for installing  117
installing SIMMs  121–123
putting on the grounding strap

117, 120
removing fonts from  256
removing the side cover  118–119
replacing the side cover  123–124
upgrade specifications for  319

printer reliability specifications  314
printers

choosing for Mac OS computers
35–37

configuring for Mac OS computers  39
determining status from its icon  147
getting information about  150
not listed in Chooser  238–239
resetting the TCP/IP interface for  287
selecting (Mac OS computers)

130, 146
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setting up as print server using
PCONSOLE  65–69

storage temperature and humidity  317
switching between  145–146

Printers control panel Setup dialog 
box  51

Printer Selector window 
(Apple Printer Utility)  251

printer setup options
changing  38, 39, 150

for Mac OS computers  151–152
for printing PostScript files  170–171

printer software
changing for new options on Mac OS

computers  125–126
configuring for printer options

124–127
installing

from a CD-ROM disc  31–32,
47–49, 50–51

creating installation floppy disks
32–31, 52–53

from floppy disks  33–35, 53–58
from a Mac OS server  42
onto a Mac OS server  40–41
for UNIX workstations  78
onto a Windows 95 server  52
onto a Windows 3.1 server  52
on Windows NT 3.5–based server

or non-Intel computer  61–62
on Windows NT 3.5x workstations

59–60
on Windows NT 4.0–based

computers  60
printer speed  1, 314
Printer’s Zone category (Apple Print

Utility)  265
printer vents  2, 4
printer zones  38, 264–266
printing. See also duplex printing

background  140–141
canceling  148
changing order of items in queue  149

controlling functions for Mac OS
computers  129

cover pages  134–135
with desktop printer on Mac OS

computers  144
documents

to ASCII or binary files  140
grayscale  135–136
with Mac OS computers  132–134
problems with  233–236
with UNIX workstations  97
from Windows 95 computers  175

envelopes from multipurpose tray
206–207

foreground  166
garbled  244, 245
handling options for  149
laser-quality paper and  12
monitoring  148–150
no paper comes out of printer while

240, 243–244
number of pages per toner cartridge  8
from parallel port  46
to PostScript or EPS file

Mac OS  139–140
Windows 3.1  169–172

selecting binding orientation for
139, 179

stopping  149
a test file from Windows 95  74
troubleshooting problems

for IBM PC-based computers
243–244

with Mac OS computers  237–242
for Novell NetWare computers

244–245
for UNIX workstations  246–248

watermarks  166, 187
printing desktop icon  147
printing errors 

(Mac OS computers)  142–143
Print Manager icon  156
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Print on Both Sides option 
(Layout dialog box)  139

print resolution  1, 180, 312
print servers

configuring NetWare  290–294
creating for RPRINTER mode  69–70
preparing Mac OS as  40–41
setting up printers as  65–69
starting in PSERVER mode  72
troubleshooting with RARP  247

print times, setting (Mac OS computers)
140–141

processor requirements
for installation

on Windows 95 computers  45
on Windows 3.1 computers  46

Properties dialog box (Windows 95)  176
protocols

connecting Ethernet to AppleTalk,
Novell NetWare, and

TCP/IP  20–21
options for  159
and ports available for computers  16
setting for ports (Apple Printer Utility)

267–268
PSERVER mode (Novell NetWare)

completing the configuration in  68
creating

a printer in  66–67
a printer server in  65
a print queue in  67

restarting the printer  69
setting up a printer in  63–64
starting on a NetWare 4.1 file 

server  72

Q

queue
capturing the  172
changing order of items in  149
creating a print  70–71
placing documents in with UNIX

workstations  97
sorting documents in  149

queue scan time  68
QuickDraw GX imaging technology  299
quitting

Apple LaserWriter Utility 
for Windows  271

the Apple Printer Utility  253
the TCP/IP Printer Configuration

Utility  284

R

RAM. See printer RAM
RAM expansion kits  116
RARP (Remote Address 

Resolution Protocol)
assigning IP addresses through  79–80
troubleshooting servers with  247

Read Me file, test printing  39
Ready/In Use light  26, 226
remote printers  289–294

configuring ATPS for first time
on NetWare 3.x server  291–293
on NetWare 4 server  290–291

modifying ATPS configuration on
NetWare 3.x server  293–294

setting up the printer as  69–72
Remove button  148
removing

desktop printing software  151
face-up output tray  116
500-sheet cassette and feeder

101, 111
fonts  256

from printer RAM  116–124
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multipurpose tray  229
packing material  7
paper cassettes  228
the printer covers  102–103

resetting the TCP/IP interface  287
restarting the printer

with Apple LaserWriter Utility 
for Windows  281

with Apple Printer Utility  269–270
configuring PSERVER mode and  69
configuring RPRINTER mode and  72

restoring factory defaults  287
Resume Job button  148
rlp daemon  88, 91
Rotated Landscape view

for Windows 95  177
for Windows 3.1  157

RPRINTER mode (Novell NetWare)
completing the configuration for

71–72
creating

a printer for  70
a print queue  70–71
a print server for  69–70

restarting the printer and  72
setting up printer in  63, 64
setting up remote printer  69–72

S

safety tips
disconnecting the power plug  3–4
grounding power plugs  3
grounding wrist straps  117, 120
for maintenance and 

troubleshooting  218
precautions during maintenance  219

Save Settings button (Print dialog 
box)  133

saving energy
power consumption and  317
using energy-saving feature  26
warm-up time and  241, 244, 247

scaling images
for Windows 95  181
for Windows 3.1  157

SCO UNIX workstations  91–93
adding entries to /etc/printcap file  92

selecting a printer
from the Printer icon  146
using its desktop printer icon  146
using the Chooser  146

Select Precision Bitmap Alignment
option (PostScript dialog 
box)  131

separator pages (Windows 95)  189
servers

assigning passwords for print  72–73
installing printer software

from Mac OS  42
onto Mac OS  40–41
onto Windows 95  52
onto Windows NT 3.5–based

server or non-Intel computer
61–62

onto Windows 3.1  52
preparing using floppy disks 

(Mac OS)  40–41
setting up in PSERVER mode  65
troubleshooting with RARP  247

service interval  217
SET BINDERY CONTEXT command

(Novell NetWare)  62
Set Print Time button  148
Settings pop-up menu (Mac OS)  134
Setup dialog box (Mac OS)  38
Setup dialog box (Windows 3.1)

Features options for  162–163
Fonts options for  160–161
Job Control options for  163–164
modifying to print PostScript file

170–171
opening  155–156
Paper options for  157
PostScript options for  158–159
Watermark options for  164–166
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Sharing tab dialog box (Windows 95)
192–193

side cover  123–124
Silicon Graphics IRIX workstations  95
SIMMs (Single Inline Memory

Modules). See also memory
flashing status lights and  226
installing  121–123
upgrade specifications for  319

SMIT utility  93
Smooth Graphics option (PostScript

dialog box)  131
Smooth Text option (PostScript dialog

box)  131
soft fonts (Windows 95)  188
software space requirements  30
sorting documents in queue  149
speed specifications  1, 314
Spool Settings dialog box 

(Windows 95)  191
spreadsheets, troubleshooting printing 

for  245
startup page  25

turning on or off
with Apple LaserWriter Utility 

for Windows  272
with Apple Printer Utility  257

Startup Page category (Apple Printer
Utility)  257

status lights
checking for paper jams  226
location and names of  26
printing envelopes and  207

stopped desktop icon  147
stopping printing  149
storing fonts  303
style names for fonts  306
subnet mask  286–287
substitute fonts. See font substitution
Substitute Fonts option (PostScript dialog

box)  131
suitcases for fonts  304–305

Sun OS version 4.1 workstations
adding entries to computer voice 

file  85
configuring  84–86

Sun Solaris workstations  83
switching between printers  145–146
switching cassettes. See tray switching
System Administration Manager (SAM)

utility  86–87, 89–90
SYSTEM.INI file (Windows 3.1)  52
system requirements

for Mac OS computers  30
for Windows 95  45
for Windows 3.1  46

T

tagged binary communications protocol
(Windows 95)  185

TCP/IP (Transmission Control
Protocol/Internet Protocol)

assigning IP addresses to printer  78
changing configurations with Apple

Printer Utility  265–266
connecting Ethernet with  20–21

TCP/IP category (Apple Print 
Utility)  266

TCP/IP Printer Configuration 
Utility  283–287

displaying information about TCP/IP
interface  284

logging in to telnet 283
printing the configuration page  284
quitting  284
setting the subnet mask  286–287
turning banner page on or off  284
viewing or changing the printer’s IP

address  285
technical specifications  311–317
telnet 283
testing the printer

with Mac OS computers  39
with Windows 95 computers  74
with Windows 3.1 computers  74
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three-hole punched paper  14
in the 500-sheet cassette  213
in multipurpose tray  203
in paper cassette  199

timeouts
enabling or disabling for TCP/IP

connections  286
specifying for Windows 95  184, 190

toner
problems with  233
smudges  235

toner cartridges
installing the first  8–11
life expectancy of  314
number of impressions per  8
part numbers for  322
replacing  219–224
storage temperature and humidity 

for  317
unpacking  5

traffic control  1
transparencies

avoiding jams with  209
choosing  210
directing to face-up tray  196
loading in multipurpose tray  208
printing  133

tray switching
setting options

in Apple LaserWriter Utility for
Windows  273–274

in Apple Printer Utility  201,
258–260

in Windows 95  182, 183
in Windows 3.1  163

troubleshooting
for IBM PC-based computers

243–244
if document does not print  39
for Mac OS computers  237–242
for Novell NetWare computers

244–245
onscreen information about  xv

printing problems with documents
233–236

safety tips for  218
unable to print startup pages  25
for UNIX workstations  246–248

TrueType fonts  1
about  298–299
with bitmapped fonts  300–301
with PostScript fonts  302
substituting PostScript fonts for

Windows 95  188
in Windows 3.1  160–161

suitcases for  304–305
turning off Desktop PrintMonitor 

(Mac OS)  150
turning on the printer  24–26
Type 1 fonts

downloading for Windows 3.1  167
installing with Adobe Type 

Manager  75

U

Ultrix workstations  84–86
UNIX workstations  77–97

changing communication settings 
for  96

configuring the printer for  95
configuring workstations  82–95

for HP-UX version 8.07  86–89
for HP-UX version 9.x  89–91
IBM AIX version 3.x  93–94
for SCO UNIX  91–93
Silicon Graphics IRIX  95
for Sun OS version 4.1, Ultrix,

A/UX, or other BSD systems
84–86

for Sun Solaris  83
connecting the printer for  16
installing printer software  78
obtaining IP addresses for printer  78,

79–82
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printing and queuing documents 
with  97

troubleshooting printing for  246–248
Unlimited Downloadable Fonts option

(PostScript dialog box)  131
unpacking the LaserWriter 12/640 PS

5–7
Unprintable Area dialog box 

(Windows 95)  178
urgent print requests  149
user documentation xv
US legal-size paper

face-up output and  141
loading  198

US Legal Small paper option  130
US Letter Small paper option  130

V

ventilation  320
verifying Ethernet frame types  68
viewing printer information, with Apple

Printer Utility  253
virus-detection programs

turning off during installation  31
turning on after installation  32

voltage requirements  317

W, X, Y, Z

wait timeouts
in Windows 95  184, 190
in Windows 3.1  159

warm-up time  241, 244, 247
water and dampness protection  3–4
watermarks

options for Windows 95 computers
186–188

options for Windows 3.1 computers
164–166

specifying which to use  157

Watermark tab dialog box
for Windows 95  186–188
for Windows 3.1  164–166

weight of printer  5
Welcome dialog box  48, 50
Windows 95 computers  174–193

configuring
PostScript printer driver for  74
the printer  25, 28, 270–282

designating unprintable areas  178
installing PPD file support  319
installing printer software  47–58

from CD-ROM disc  47–49
creating floppy disks from 

CD-ROM disc  52–53
from floppy disks  53–56
onto a server  52

options for sharing network printers
192–193

printer options for  127
printing

documents  175
envelopes  207
options for  175–176
a test file  74

selecting
fonts in  188–189
graphics options  180–181
page setup options  174
paper options for  177–179

system requirements for  45
troubleshooting tips for  243–244

Windows NT computers
installing printer software

on 3.5–based server or non-Intel
computer  61–62

on 3.5x workstations  59–60
on 4.0–based computers  60

troubleshooting tips for  243–244
Windows 3.1 computers

configuring the printer  25, 28,
270–282

downloading fonts  166–168
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installing printer software
from CD-ROM disc  50–51
creating floppy disks from 

CD-ROM disc  53
from floppy disks  56–58
onto a server  52

PostScript files and  169–172
PostScript printer drivers for  74
PPD file support and  319
printer options for  127
printing envelopes  207
printing from Windows applications

154–166
fonts options for  160–161
job control options for  163–164
opening Setup dialog box  155–156
optional features for  162–163
PostScript options for  158–159
selecting page setup options  154
selecting printer options  156–166
setting printer driver options

155–157
watermark options for  164–166

system requirements for  46
test file printing for  74
troubleshooting tips for  243–244

workstations, configuring UNIX  77–97
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The Apple Publishing System
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Illustrator; screen shots were created and modified with system software, ExposurePro, and
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PostScript, the LaserWriter page-description language, was developed by Adobe Systems
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Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected. 

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures: 
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio. 
m Move the computer farther away from the television or radio. 
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance. 
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DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.

Laser information
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous radiation exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 

Your printer is a Class 1 laser product. The Class 1 label, located in a user-accessible area,
indicates that the printer meets minimum safety requirements. A service warning label is 
located in a service-accessible area. The labels on your product may differ slightly from the
ones shown here.

Class 1 label Service warning label

viii Laser  In format ion



First use the printed manual to set up your printer. The printed manual
contains setup and installation information.

Next go to the onscreen manual to learn how to use your printer. The file
is in Adobe Portable Document Format (PDF). To read or print the
documentation, you use the Acrobat Reader software on the CD-ROM
disc. The PDF file is located at MAC_OS:Monochrome LaserWriter:
LW12/640UM.pdf and WIN_OS\MONO_LSR\LW12/640U.pdf on the
CD-ROM disc.

The onscreen manual includes additional setup information (for example,
how to name your printer) and continues (beginning with Chapter 5) with
usage information, troubleshooting, and technical information about 
your printer.

IMPORTANT If you already have Acrobat Reader installed on your computer,
you do not need to install it from the CD-ROM disc. If you do install Acrobat
Reader from the CD-ROM disc, an Adobe Acrobat folder may appear as the
active folder on your screen, blocking access to the onscreen manual. Close
the Acrobat folder (or drag it out of the way) so you can open the onscreen
manual.
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Tips for using Acrobat Reader

Adobe Acrobat Reader has features that give you fast, easy access to
information.

m For help using Acrobat Reader, choose Acrobat Reader Help from the Help
(h) menu at the top of your screen. The Adobe Acrobat Reader Online
Guide appears.

m Print only specific pages or sections of the onscreen manual that contain
information you need. Printing an entire PDF file can be a time-
consuming task and can use large amounts of ink and paper unnecessarily.

x Preface


